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About

Copyright

The information contained in this User Guide regarding the use of
LogTag® Analyzer software is intended as a guide and does not
constitute a declaration of performance. The information contained in
this document is subject to change without notice. Unless otherwise
noted, the example companies, organisations, email addresses and
people depicted herein are fictitious, and no association with any real
company, organization, email address or person is intended or should be
inferred. Complying with all applicable copyright laws is the
responsibility of the user.

No representation or warranty is given and no liability is assumed by
LogTag® Recorders with respect to the accuracy or use of such
information or infringement of patents or other intellectual property
rights arising from such use or otherwise.

Copyright © 2004-2019 LogTag Recorders LTD. All rights reserved.
http://logtagrecorders.com

Disclaimer

The LogTag Analyzer monitors temperature exposure and not the
quality of the goods it accompanies. Its purpose is to signal if product
quality evaluation/testing is required.

LogTag Analyzer User Guide

Typographical Conventions

Text in this font refers to buttons on a LogTag® product.

Text in this font refers to actions to be taken in LogTag® Analyzer,

as clicking a button, icon or menu item.
Text HpRiplSN{ly describes features of a LogTag® product.

An icon or menu in grey colour cannot be clicked and its
function is not available at this time.

An icon or menu in the theme colour can be clicked and its
function is available.
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Elapsed

to get extra information.

Text like this gives you tips on how to simplify tasks and how

Text like this highlights notes and key information that you
should be aware of.

Text like this shows important information about issues that

could cause you to inadvertently lose data.

Text in this font refers to features, tabs or dialogue boxes.

Links or references to other part in this document appear like this.
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About

Software License

To use the software you must agree to the license terms set out below.
LOGTAG RECORDERS END-USER LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS
PRODUCT. IT CONTAINS SOFTWARE, THE USE OF WHICH IS LICENSED BY LOGTAG RECORDERS, TO ITS
CUSTOMERS FOR THEIR USE ONLY AS SET FORTH BELOW. IF YOU DO NOT AGREE TO THE TERMS AND
CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. USING ANY PART OF THE SOFTWARE
INDICATES THAT YOU ACCEPT THESE TERMS.

LICENSE: LogTag Recorders grants you a personal, limited, non-exclusive license to use the accompanying
software program(s) (the "Software") subject to the terms and restrictions set forth in this License
Agreement. You are not permitted to lease or rent (except under separate mutually agreeable terms set forth
in writing), distribute or sublicense the Software or to use the Software in a time-sharing arrangement or
in any other unauthorized manner. Further, no license is granted to you in the human readable code of the
Software (source code). Except as provided below, this License Agreement does not grant you any rights to
patents, copyrights, trade secrets, trademarks, or any other rights in respect to the Software.

The Software is licensed to be used on any computing device. You may reproduce and provide one (1) copy
of such Software for each computing device on which such Software is used as permitted hereunder.
Otherwise, the Software and supporting documentation may be copied only as essential for backup or
archive purposes in support of your use of the Software as permitted hereunder. You must reproduce and
include all copyright notices and any other proprietary rights notices appearing on the Software on any
copies that you make.

NO ASSIGNMENT; NO REVERSE ENGINEERING: You may transfer the Software and this License Agreement
to another party if the other party agrees in writing to accept the terms and conditions of this License
Agreement. If you transfer the Software, you must at the same time either transfer all copies of the Software
as well as the supporting documentation to the same party or destroy any such materials not transferred.
Except as set forth above, you may not transfer or assign the Software or your rights under this License
Agreement.

Modification, reverse engineering, reverse compiling, or disassembly of the Software is expressly
prohibited. Analyzing the input to and output from the Software is expressly prohibited except when this is
done solely to evaluate the subjective quality of the Software's visual and data analysis processes. You may
not otherwise modify, alter, adapt, port, or merge the Software except as specified in this License
Agreement.

EXPORT RESTRICTIONS: You agree that you will not export or re-export the Software or accompanying
documentation (or any copies thereof) or any products utilizing the Software or such documentation in
violation of any applicable laws or regulations of the United States or the country in which you obtained
them.

TRADE SECRETS; TITLE: You acknowledge and agree that the structure, sequence and organization of the
Software are the valuable trade secrets of LogTag Recorders and its suppliers. You agree to hold such trade
secrets in confidence. You further acknowledge and agree that ownership of, and title to, the Software and
all subsequent copies thereof regardless of the form or media are held by LogTag Recorders and its
suppliers.

TRADEMARKS AND COPYRIGHTS: "LogTag®" is a registered trademark (R) of LogTag Recorders. You may
not remove, alter, deface, overprint, or otherwise obscure any LogTag Recorders trademark, service mark,
or copyright notices included with this Software.

INTELLECTUAL PROPERTY: All intellectual property rights in and to this Software are and shall remain in
LogTag Recorders.

TERM AND TERMINATION: This License Agreement is effective until terminated. You may terminate it at any

time by destroying the Software and documentation together with all copies and merged portions in any
form. It will also terminate immediately if you fail to comply with any term or condition of this License
Agreement. Upon such termination you agree to destroy the Software and documentation, together with all
copies and merged portions in any form.

GOVERNING LAW: This License Agreement shall be governed by the laws of the State of California and by
the laws of the United States, excluding their conflicts of law principles. The United Nations Convention on
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Contracts for the International Sale of Goods (1980) is hereby excluded in its entirety from application to
this License Agreement.

LIMITED WARRANTY; LIMITATION OF LIABILITY: EXCEPT AS EXPRESSLY PROVIDED OTHERWISE IN A
WRITTEN AGREEMENT BETWEEN LOGTAG RECORDERS AND YOU, THE SOFTWARE IS NOW PROVIDED "AS
IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR
THE WARRANTY OF NON-INFRINGEMENT. WITHOUT LIMITING THE FOREGOING, LOGTAG RECORDERS
MAKES NO WARRANTY THAT (i) THE SOFTWARE WILL MEET YOUR REQUIREMENTS, (ii) THE USE OF THE
SOFTWARE WILL BE UNINTERRUPTED, TIMELY, SECURE, OR ERROR-FREE, (iii) THE RESULTS THAT MAY
BE OBTAINED FROM THE USE OF THE SOFTWARE WILL BE ACCURATE OR RELIABLE, (iv) THE QUALITY
OF THE SOFTWARE WILL MEET YOUR EXPECTATIONS, (v) ANY ERRORS IN THE SOFTWARE WILL BE
CORRECTED, AND/OR (vi) YOU MAY USE, PRACTICE, EXECUTE, OR ACCESS THE SOFTWARE WITHOUT
VIOLATING THE INTELLECTUAL PROPERTY RIGHTS OF OTHERS. SOME STATES OR JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY MAY LAST, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. IF TEXAS LAW IS NOT
HELD TO APPLY TO THIS AGREEMENT FOR ANY REASON, THEN IN JURISDICTIONS WHERE WARRANTIES,
GUARANTEES, REPRESENTATIONS, AND/OR CONDITIONS OF ANY TYPE MAY NOT BE DISCLAIMED, ANY
SUCH WARRANTY, GUARANTEE, REPRESENTATION AND/OR WARRANTY IS: (1) HEREBY LIMITED TO THE
PERIOD OF EITHER (A) THIRTY (30) DAYS FROM THE DATE OF OPENING THE PACKAGE CONTAINING THE
SOFTWARE OR (B) THE SHORTEST PERIOD ALLOWED BY LAW IN THE APPLICABLE JURISDICTION IF A
THIRTY (30) DAY LIMITATION WOULD BE UNENFORCEABLE; AND (2) THE SOLE LIABILITY OF LogTag
Recorders. FOR ANY BREACH OF ANY SUCH WARRANTY, GUARANTEE, REPRESENTATION, AND/OR
CONDITION SHALL BE TO PROVIDE YOU WITH A NEW COPY OF THE SOFTWARE.

IN NO EVENT SHALL LOGTAG RECORDERS OR ITS SUPPLIERS BE LIABLE TO YOU OR ANY THIRD PARTY
FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY
DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, THOSE RESULTING FROM LOSS OF USE,
DATA OR PROFITS, WHETHER OR NOT LOGTAG RECORDERS HAD BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH
THE USE OF THE SOFTWARE. SOME JURISDICTIONS PROHIBIT THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT
APPLY TO YOU. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL
PURPOSE OF ANY LIMITED REMEDY.

SEVERABILITY: In the event any provision of this License Agreement is found to be invalid, illegal or
unenforceable, the validity, legality and enforceability of any of the remaining provisions shall not in any
way be affected or impaired and a valid, legal and enforceable provision of similar intent and economic
impact shall be substituted therefore.

ENTIRE AGREEMENT: This License Agreement sets forth the entire understanding and agreement between
you and LOGTAG RECORDERS, supersedes all prior agreements, whether written or oral, with respect to the
Software, and may be amended only in a writing signed by both parties.

The software menus and texts as well as this agreement have been created in English and any other language
versions have been translated from the English version. In the event of a dispute, reference should be made
to the English language version, which is conclusive.

For further information about licensing please email licensing@logtagrecorders.com.



Chapter 1
Introduction

LogTag® Analyzer version 3 is the latest LogTag® software, using Microsoft’s .NET technology.

It will allow easier integration into third-party developments and enables a path for supporting modern operating systems and multiple computing
platforms in the future, such as Linux or macOS.

If you are familiar with LogTag® Analyzer version 2.x, you will find it easy to make the transition to version 3.x. There are a few new concepts, which you
can find by browsing the pages in this User Guide. The main differences are listed in the introductory guide What's new in LogTag Analyzer 3, available
from http://logtagrecorders.com.

This guide will take you through the relevant steps to successfully use the LogTag® products. You will learn how to:

. install the software

«» configure LogTag® products for recording

« retrieve the recorded readings

. display and analyze the data

. configure the available options in the software so you can make best use of its features.

If you are an experienced users of a previous versions, you may skip some of the early chapters. If, however, you are about to use a newer version of a
LogTag® product or Interface Cradle we recommend you at least skim the installation chapter for any relevant changes.

This guide covers version 3.1 release 6 of the LogTag® Analyzer software. If you are unsure which version you are currently using, please read the section
about Finding your software version on page 21.

If you find a feature described in this guide that does not appear in your software, we recommend you update it as explained in the section about
Upgrading LogTag® Analyzer on page 22. You can always get the most up to date version of LogTag® Analyzer from the LogTag® Recorders website at
http://logtagrecorders.com.

This guide includes all the relevant information to install and use the product range supplied by LogTag® Recorders, however, the reader is expected to
be familiar with using a computer and the Windows® operating system.
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The LogTag® Recording System

LogTag® Recorders offer a range of logger and indicator products for temperature and humidity,
which are complemented by software and interface products. Some of these products can be
used on their own, most often, however, you will use a combination of products to get the best
results.

LogTag® Recorders offer a variety of different models. The product range is constantly being
updated and new models added, so visit the LogTag® Website at http://logtagrecorders.com
frequently to get the latest information and news about upcoming product releases.

Typically LogTag® products are configured, put with goods that require monitoring and are
downloaded once the goods reach their intended destination.
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Figure 1: Typical distribution process with loggers and indicators
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Other applications may involve stationary loggers placed in warehouses or fridges, such as the
Vaxtag®) as can be seen here.

TEMPER

Figure 2: Example of a stationary loggers application


http://www.youtube.com/watch?v=M2PgEuFkFDs
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Logge rs

LogTag® temperature and humidity logger products are small, battery powered, credit card size
devices with built-in sensors and data logging memory. They record between 4,000 and 16,000
samples from anywhere between -80°C and +100°C, depending on the model. For detailed
information about each product visit the LogTag® Recorders website at
http://logtagrecorders.com/products

Indicators

LogTag® temperature indicators are even smaller devices, also battery powered, and contain a
statistics memory which can contain minimum and maximum values from anywhere between
20 days and three years. They feature a display for a quick assessment if goods have been
exposed to temperatures outside pre-configured temperature limits.

Software

Loggers and Indicators are downloaded using the LogTag® Analyzer software, which is also used
to configure loggers. This User Guide explains in detail how to configure and download loggers
and indicators, how to customise the settings and how to analyse and share the data.

starr [
sTOP

©

Figure 4: Some of LogTag®s indicator products
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Interfaces

Unless your product is one of the USB Loggers you will need an interface to communicate
between the logger or indicator and the computer.

Loggers and indicators use two different types of interface cradle.

Most products use the standard interface cradle, where the LogTag® is inserted into the slot
from the top as shown to enable communication. You will be able to see the contact pins inside
the slot that meet with the matching contact pads on the LogTag®. When inserting a LogTag®
into the slot you feel a slight resistance as the contacts engage. Removing the LogTag® will
cause a slight clicking noise as the contacts snap back into their unloaded position.

The indicator products TIC20 and TICT use a special cradle in which the contact pins are exposed
at the top. To enable communication locate the indicator's lug on the interface's boss and
firmly press it down, so the contact pins pierce through the rear label. When using the TICT,
please remove the adapter from the bottom of the interface and place it as shown; this helps
correctly locating the contact pins.

New in 2018, the LTI-HID is the next generation USB interface that can be installed without
requiring a proprietary driver. It also features two indicators at the top (red & green), which
identify what actions the interface is currently performing.

page 13

Figure 6: TICT in LTI/USB-TICT interface cradle

Figure 7: New USB Interface LTI-HID
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Installing the software

To use your LogTag® products you need to install LogTag® Analyzer on your computer. This will allow preparing your LogTag® for recording,
downloading, analysing and sharing the data.
Experienced users may choose to skip this chapter. You should read it, however, if you are new to using a computer or installing software.

System requirements
To ensure that the software will work on your computer following minimum specifications are required:
« PC capable of running Windows® 7 or later, or Windows® 2008 Server or later

« 60MB free disk space (plus 30MB if .NET is not yet installed)

. Internet Explorer 8.0 or later

« 1available serial port or 1 available USB port, depending on purchased interface
« 1024 x 768, or higher, screen resolution.

o 256 screen colours

If you wish to use LogTag® Online with LogTag® Analyzer you will also need a supported browser and an internet connection, please refer to the
LogTag® Online help file available from http://www.help logtagrecorders.com/LTOnline/.

The recommended specifications are:

« Processor equivalent to Pentium IV or later
« 512MB of available RAM

. Internet Explorer 9.0 or later

« 65535 (16bit), or more, screen colours.

If you are unsure of your computer's specifications, please refer to your operating system's documentation or help function.
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.NET Framework

LogTag® Analyzer version 3 is designed around Microsoft’s .NET 4.0 framework. To install and
run LogTag® Analyzer you need a PC with at least a Windows 7 operating system.

The NET framework 4.0 will likely be installed on most PCs, which had regular updates applied
via Windows Update. On some PC's with Windows 7 Microsoft’s .NET 4.0 Framework will need
to be installed. The LogTag® Analyzer Installer can determine the presence of the framework
and will automatically download the framework directly from Microsoft, if it is not already
present on the PC. In this case your PC will need to be connected to the internet to successfully
complete the installation. This installation method will be suitable for single PC installations.

If you wish to install this version on more than one computer without .NET 4.0, you can
download a standalone installer directly from Microsoft from this link: .NET Framework Installer

(external link)

Getting a copy of the software

The software can be download from the from the LogTag® Recorders website; navigate to
http://logtagrecorders.com/software/L.TA3 and click the LogTag® Analyzer 3 link. . Complete the
registration details and click (Download ]

LogTag® Analyzer is available for download in a number of different formats:

. ltanalyzer_ 3ir6.exe

This is a single executable installer file and the most popular option; no other files are
required for installation of LogTag® Analyzer software on your computer.

« ltanalyzer_31r6.msi

This file is used by Network Administrators - it requires additional files and is best suited
when distributing the software remotely to a number of PC's.

« ltanalyzer_31r6.zip

You can download a zipped version of the file, which has a smaller download size. You will
need an unzipping tool such as Winzip® to extract the single executable installer.

. ltanalyzer 31r6.iso
The ISO file can be used to generate a CD, if you need to distribute the software to PC's
without a network connection.

Click on the desired download link. Depending on the type of browser and its version you may
get different windows to start and process the download. Modern browsers like Edge, Internet

& Wi Direnicnd - Wanckows betermes Explcrer Tl el e
and tra ormioads P
Iltanalyzer_31rG.ene_3.1 Gee D yome mamli b rum o1 pave b “ oo
pregmm? x

= EgrEcraeron

Cleae Close

Figure 9: Downloading using Internet Explorer

Opening Itanalyzer_31r6.exe fr==t [
You have chosen to open
[57 Hanalyzer_31r6.exe

which is a: Binary File (21.3 MB)
from: http://logtagrecorders.com

Would you like to save this file?

Save File | [ Cancel ]

Figure 10: Download Window - Mozilla Firefox
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Explorer, Google Chrome or Mozilla Firefox typically have a special directory into which all
downloads are copied, but you can also select your own.

LogTag® Recorders does not charge for the download and use of this software, or for updates.
You are welcome to distribute copies of the LogTag® Analyzer software provided it is distributed
unaltered, in the packaged format as originally downloaded from the LogTag® Analyzer website.
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Figure 11: Download progress using IE
@) 14% of 1 file - Downloads == e

Itanalyzer_31rb.exe
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Clear List Search.. ye

Figure 12: Download progress using Firefox
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Figure 13: Download progress using Chrome
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The installation process Rl

Welcome to the Prerequisites

You will require local administrator permissions for the PC on Setup Wizard

which you are installing LogTag® Analyzer.

The setup has determined that some of the prerequisiies

needad 1o run LogTag Analyzer are missing. This wizard will

assist youin getting and installing those prerequisites. Clic
MNext™ to continue or "Cancel” to exit the Setup Wizard.

To install the LogTag® Analyzer software, locate the installation file
downloaded in the previous step and execute it (typically by double
clicking or selecting the file in Windows® Explorer and pressing Enter).
To proceed through each step of the installation process, click. If
you want to change a previous step you can click. At any stage
during the process, if you want to stop installing the software, click
dCanceI

Bk Cancel
1. Select the installer language
Please select a lanquage: Prerequisites E
L& T — = Select which prerequisites will be installed
E Cancel Name Required Found  Action
[ visual C++ 2010 5P1 %86 (MFC Seaurity Update) 40219.325 ... Install
2. The software now checks that all prerequisite software packages
are present. These include the .NET framework and the Visual C++
runtime libraries redistributable package.
The .NET framework is included in all supported operating
systems which are up to date with the latest updates. If not, you
will be asked to download and install the framework, as it is not
included in the installer package. : 2
The Visual C++ runtime libraries may already be installed, as they =
are used for many other commercial software. They are included

in the installer package, and you will be asked to permit their
installation, otherwise the installer will abort.
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—prsree 4. Accept the End-User License Agreement and click

Installing prerecudtes for LogTag Anslyzer
k et x & LogTag Analyzer Setup x
P e Finige e Y e o End-User License Agreement
may take seversl mrutes.
ke Feko e Ty - Please read the following license agreement carefully
S IR [ ARSI N TWARE LICENSE TERMS

MICROSOFT VISUAL C++ 2010 RUNTIME LIBRARIES WITH

SIRVICT PACK 1 -
These licengs berme are an agreement between Mcrosaft . 0
Corparation (or brsed on whete you Ive, one of its affisates) and Last updal:ed.. 1 Decexber 2014
[rou. Please read them. They spaly o the software named above, o
5k 3 it o i 3 | Control Solutions VIMC License
CONTROL SOLUTIONS, INC, END-USER LICENSE
[ tés, and ink sbot mop AGREEMENT
Per more nformaton, resd ¥ Uats Colecton Pobey. b
e ] | caenl (®) 1 accept the terms in the License Agreement

() 1 go not accept the terms in the License Agreement

Once the installation is complete, click and continue with

the installation of LogTag® Analyzer. S e e

3. Accept the Welcome screen by clicking .
5. Select the installation folder. You can type a folder name or
i LogTag Ansiyzer Setup % browse to an existing folder. If the folder does not exist, it will be

created for you.
Welcome to the LogTag

Analyzer Setup Wizard B LogTag Analyzer Setup - b
Select Installation Folder
” , This is the folder where LogTag Analyzer will be installed.
The Setup Wizard will install LogTag Analyzer version

3.1.6 onyour computer. Click “Next™ to continue or
“Cancel” to exit the Setup Wizard,

To install in this folder, dick Text™. To install to a different folder, enter it below or dick
owsee”,
Folder:
}c:\Proqmm Files (x86)\\Log Tag Recorders\logTag Arahoers Brovise. ..

< Badk Next > Cancel

< Back Next > Cancel
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Note: You can change the document storage location in
LogTag® Analyzer 's option settings once you have
started the program, but you cannot change the program
location. We recommend you leave all options at their
default setting, especially if you are unsure of what
option to select or what effects changing the option
would have.

-

6. Select, which files you wish to associate with LogTag® Analyzer
(these files will, for example, automatically open in LogTag®
Analyzer when you double-click them in Windows Explorer).

. If you are installing LogTag® Analyzer for the first time we
suggest you select all file types.

« If you are upgrading from version 2, and you do not wish to
use version 2 any longer, you should also select all file types.

« If you are upgrading from version 2, and you are planning on
operating both versions, you can decide if you wish to
associate the files in the right column with the new version
(select those file types) or leave them associated with the
older version (clear those file types).

You can change this later by right-clicking a file, and clicking
Open with.

Click once you have made your selection.
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B LogTag Analyzer Setup x

Select File Associations
Select the extensions you want assodated with LogTag Analyzer

Please select the file types you want to automatically open with LogTag Analyzer:

A1 i O .sitd

B .muttix O .aswml
.
O .mult

< Back Next > Cancel

The installer now has all the information and is ready to proceed.

Click to start the installation.

Ready to Install
The Setup Wizard is ready to begin the LogTag Analyzerinstallation

Click "Instal™ to begin the installation, If you want to review or change any of your
installation settings, dick "Back”. Click "Cancel” to exit the wizard.

< Back [ mstal | | Cancel
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8. The installer is copying the required files to your PC. through the Microsoft Windows® Update feature, as an optional
hardware update, or as part of an upgraded installer file (see Upgrading

Loglag® Analyzer on page 22).

Instaliing LogTag Analyzer H Once the installation process has completed the installer file is no
longer required and can safely be deleted.

Please wait while the Setup Wizard installs LogTag Analyzer. This may take several
minutes.

Status: Extracting files from archive
|

9. When the installation is complete, click to exit the installer
program.

B LogTag Analyzer Setup X

Completing the LogTag
Analyzer Setup Wizard

Chck the "Finish” button to exit the Setup Wizard.

The drivers required to operate your USB interface are installed as part
of the main installation process. From time to time updated drivers
may be released by LogTag® Recorders. These drivers will be available
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Finding your software version

Click the About LogTag® Analyzer... command in the Help Menu to display the About window.

This window displays the full version number of the software being used. You can use this to
check if the same software version is installed on multiple computers or to find out which user

guide to use.
When the software is updated, the version number of the software is increased.

You can also find major and minor version of LogTag® Analyzer in the title bar:

page 21

. LogTag Analyzer

Version 3.1.6

LogTag Analyzer software provides and easy to use,
powerful platform for configuring, downloading and
displaving data from LogTag products.

LogTag Analyzer
LogTag Recorders LTD
Copyright © 2004-2019, LogTag Recorders LTD

Close ‘ ‘0 Help |

Figure 14: About LogTag® Analyzer
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Upgrading LogTag® Analyzer

LogTag® Recorders will publish updates to LogTag® Analyzer to introduce new or enhanced
features, or to support new LogTag® models. LogTag® Recorders recommend that you always
use the latest version of the software.

When you first install LogTag® Analyzer, the Automatic Updates function is enabled, which
means you will automatically be notified when an update is available. When the notification is
displayed, you can choose whether or not you wish to download and update the software at this
stage.

If you have disabled the automatic update function you can still get updates via the Help menu
by clicking Check Internet for updates. Neither of these two options will transmit any
information about you or your system to LogTag® Recorders, so you can rest assured your
privacy is maintained.

To download the update click on . The download progress will be displayed and you
will be notified when it is complete.
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A

LogTag'Analyzer
Version 3.1.6

Dovnlaading information from Intenvet about the latest version. Mo personal ifarmatian i3 being sent.

A newer version of Analyzer is available for download. Ciick the “Downlicad® bution if you want
1o download the software now.

If in fulur you s8@ this message you know theie & an vpgiade available!

Figure 15: Checking for a software update

LogTag'Analyzer

Version 3.1.6
Cowrloading Fils 13%
I}nwnlnadmg idarmatian from Internet about the latest version. No pw:nnal anfarmation is an‘\g sent.

A

-

A newer version of Analyzer is available for download. Ciick the “Downlicad® bution if you want
1o download the software now.

If in fulur you s8@ this message you know theie & an vpgiade available!

—

Vigwrelesse notes | e Oonriusd |§ Cancel

Figure 16: Downloading the Update
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Clickwhen the file has finished downloading and follow the on-screen instructions.

Installing a newer version will update all the relevant program files. It will not affect any of
your LogTag® data files or your custom settings of the software. You may however need to
check any shortcuts to the program you made, as the location of the program files can change.

If you are unable to use either update option on the previous page you can download an
upgrade installer file from the LogTag® Recorders website. We recommend you register your
email address on the Software download page so you can be notified by email when an update
is available. If a newer version is available, you can download the updated version of the
installer file to your PC and then proceed with the installation process. The older version of the
software will be replaced with the new version.

You cannot cross-upgrade from LogTag® Analyzer version 2 to LogTag® Analyzer version 3
using an automated upgrade function. If you are currently using version 2 and you wish to
upgrade to version 3 please download the software and use the installation process as described
in Installing the software (on page 14).
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%, Updstes [E=SE=0

LogTag'Analyzer

Version 3.1.6

Pew version of Analyzer is avaidakle for download. Click the “Downizad*® button if you want to
download the software now.

ITin fulue you see this message you know theis is an upgiade available!

View ralease notes I@ Instal ||€:§ Cancel

Figure 17: Ready to install



Chapter 2
Using LogTag® Analyzer

This chapter explain in detail how to use the software to configure and download loggers and indicators, how to analyse the results and how to share
them with other users.

The User Interface .. o 25
InItial SO tUD oo il 43
AAVANCEd SO U ...t 43
Connecting the Interface ... .. . .. YA
Configuring a LogTag® for recording . ... .. ... 45
Results from LogTag® LogEers ... ..o o 80
Analyzing the results ... . L 88
Sharing recorded data with Others ... .. L 122

Integrating LogTag® Analyzer with LogTag® Online ... . 127
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The User Interface

Once you have started LogTag® Analyzer, the

main window will open. From here you have

access to menu commands, toolbar

commands, option settings and many other

controls.

You can find more information about the

different areas here:

o Information about Menu commands on
page 28

« Information about Toolbar commands on
page 37

« Information about The Status Bar on
page 40

File Edit LogTag

B & B

Wizard Open  Saw Menu e Signatures  Send Mail  Upload

LogTag Analyzer User Guide

pdow  User Server LogTag Online  Help

Fan 8 »

JEeem vt Rl T

£L,00E08 0
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Aute-download is

Toolbar

Docking Canvas

For Help, press F1. To use a LogTag, press Fi.

Select Theme = (7] Select Display TimeZone = ! LogTag Configured Time (Display Clock Adjusted) Pending Exmails: 1 Uploads: 0

Figure 18: The workspace
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When you open a file, it completely fills the
docking canvas.

You can now zoom in and out, show and hide
various elements of the chart, view the
information in different forms and save or
export the file to different formats

When you open additional files, they each
open in a new file window tab.

Clicking a tab displays the corresponding file
window. The window's title bar shows the full
file title, while the tab may only show
abbreviated information, depending on how
many files are open.

File windows are initially docked, which
means they are attached to the canvas. When
they are docked, they move with the main
program window. File windows can also be
floating, which means you can move them
anywhere on your PC's screen, even outside
the program window and on to a second
screen. To float a docked window, simply click

and hold the file's tab, and drag it downwards.

You can now independently move and resize
the window.

LogTag Analyzer User Guide
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This allows you to have multiple windows on
your screen.

To re-dock a floating window, click and hold
the file's title bar and drag it on top of any
docking icon:

. E Docks the window to the top of the
canvas

-
o L= IDocks the window to the bottom of
the canvas

4
. @ Docks the window to the left of the
canvas

. Docks the window to the right of the

canvas

. Docks the window to the existing

window tabs

You can also dock a file window to another
floating window, and use the Tile function to
display windows side by side, separated by a
movable divider.
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Menus and Toolbars

At the top of the screen below the title bar is LogTag® Analyzer's menu system and toolbar. The toolbar provides quick access to some of the more
commonly used functions. The menu system contains lists of all the operations and commands that are available while using the software.

Menu System

File Edit LogTag Window  User Server LogTag Online  Help Auto-download is

& B P 8 P EIL,P00BEBENM © & &

: = / / ram o ©

Wizard Open  Save  Print Properties Signatures Send Mail Upload Copy Zoom Out Real Time Elapsed Zoom [Previous Next Average Multi  Single Options  Logen  Logoff
Toolbar

Figure 21: Menu and toolbar

Menu commands

The menu system has been separated into groups of related commands. Each of these menu groups is explained in more depth in the subsequent
sections. The software will only display the menu groups and commands within each menu group that are appropriate depending on what you are
currently doing with the software.

You may also see that some of the menu commands have a reference after the command name, for example F2 or Ctrl+O. These represent key strokes
on the keyboard that instruct the software to perform the appropriate command, without the need to select the menu or toolbar command. When only
one key reference is mentioned, for example F2, then pressing that single key on the keyboard will cause the appropriate command to be performed.
If there is more than one key reference mentioned, for example Ctrl+O, then to cause the command to be performed you must press and hold down
the first key mentioned while pressing the other key once. When letters are used in the key reference, for example Ctrl+Q, it does not matter whether
or not the caps lock is on or off.
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File Menu

LogTag Analyzer User Guide

The File menu contains commands that relate to a LogTag® file. When clicking on File (or pressing ALT-F on the
keyboard), a menu similar to the one on the right appears.

The following table outlines the commands you can select along with a brief explanation. Some commands do not
appear if no file is open.

Command

&

Open...

B

Save

&3]

Save As...

Print All. ..

Table 1: File menu - available commands
Explanation

This will display the Open file dialogue, which will allow you to open files that were
previously saved with any version of LogTag® Analyzer, such as *.1td, *.1tdx or

* sltd files and multichart files such as * . multi or * multix.

Initially, the folder defined in Edit - Options - File and Folder Settings will be
displayed. When you open a file after you browsed to a different location, LogTag®
Analyzer will remember this location for the next time you wish to open a file.

If a Multi Chart file is selected, the LogTag® Analyzer software will automatically
show the opened file as a new Multi-Chart (see Multi-Charts (Combining Charts into
a Single View) on page 98).

This will save any changes you have made to the LogTag® file (or Multi Chart
configuration) to your disk drive.

This will display the Save As file dialog, which will allow you to save a copy of the
file currently being displayed in the same or a different folder with the same or a
different file name.

This will close the currently active file. You may be asked to confirm if you wish to
save any changes, such as annotations or zoom settings. If no files are currently open
this command will not be visible.

This will send an email with the currently active file attached to a list of recipients
or upload the file to a pre-determined FTP site, as detailed in Sharing recorded data
with others on page 122.

This will open a window allowing you to print the currently active window to a
printer. This command is further explained in the section Printing the results on
page 117.

This will open a window allowing you to print all currently open windows to a
printer. This command is further explained in the section Printing the results on
page 117.

Open
Save
Save As

Close

Print All

Print Preview

Page Setup

Send

Upload

Properties

WM ED @ PE B EBER

Digital Signatures
Select Recent File

Exit

©

Ctrl+O

Ciri+S

Print Cri+P

Figure 22: File menu
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Command

i
Print Preview

‘!'h
I page Setup...

R

Send...

E|

Properties...

>
Digital
Signature...

Select Recent File

%)

Exit

LogTag Analyzer User Guide

Explanation

This will change the display mode of the software to show you a copy of how a
printout of the currently selected file and window would look like. In "Print
Preview" mode you will not be able to zoom in or out of a chart. Click to exit the
"Print Preview" mode and return to normal display mode.

This will open a window allowing you to view and adjust one or more of your page
settings, like printer margins and page orientation.

This will help you send, by email, the currently open and selected LogTag® file to
another user without the need to exit to your email software or to deal with file
attachments. This command is explained in further detail in the sectionSending a
file by email directly from LogTag® Analyzer on page 122.

This will open a window that will display the information about the file that is being
displayed and currently selected. This same window and information will be
displayed if you view the properties of the file from Microsoft Windows Explorer.

This will open a window to display a list of digital signatures that have been
included with the file. It also allows you to add and print this list of digital
signatures. Further explanations can be found in the section about "Digital
signatures on page 83.

This sub-menu, when clicked, shows a list of the most recent files you have viewed.
To re-open one of these files, simply click on the entry (name of the file). The
number of files included in this list can be adjusted in Edit - Options - File and
Folder Settings.

This command will exit the LogTag® Analyzer software. Any files currently open will
be closed automatically. If a user is currently logged on to the User Server, the user
will be automatically logged off.
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Edit Menu

The following table outlines the commands you can select along with a brief explanation. Some commands do not

appear if no file is open.

Command
H
Copy
i’.—')\
Zoom Out

Real Time

&

Elapsed Time

)

Y
Zoom to Marks

O

Previous group of
Marks

©

Next group of
Marks

o

Options...

Table 2: Edit menu - available commands

Explanation

Places a copy of the contents of the currently displayed window onto the clipboard,

LogTag Analyzer User Guide

which can then be pasted into any Windows® application. The Copy command
behaves slightly differently for different tabs, please refer to the descriptions

covering individual tabs for further details.

This will undo the last zoom operation. If the chart is displaying all the readings
recorded by the LogTag®, this command will not be available.

Clicking this menu item will make the time axis represent date and time the data
were recorded. This is useful when you want to inspected at what date and time a
certain event occurred.

Clicking this menu item will make the time axis represents the elapsed time since
the recording began. This is useful when you want to inspected how long into a trip
a certain event occurred.

When this command is enabled, the chart is automatically zoomed to show readings
recorded between inspection marks. The section "Starting and using the LogTag®"
explains in further detail how inspection marks are recorded.

This command will show the readings recorded between the first inspection mark

shown and the previous inspection mark recorded. This command will only be

available if the "Zoom to Marks" command is enabled and the first reading recorded
is not currently visible.

This command will show the readings recorded between the last inspection mark

shown and the next inspection mark recorded. This command will only be available
if the "Zoom to Marks" command is enabled and the last reading recorded is not

currently visible.

This will open a window allowing you to customize the software. This command is

further explained in the chapter "Customizing the software".

A

[

2000/ PQE

Zoom Out

Real Time

Elapsed Time

Zoom to Marks

Previous group of Marks

Next group of Marks

Options
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LogTag® Menu

LogTag Analyzer User Guide

The LogTag® menu contains commands for interaction with LogTag® products.

When you click LogTag (or press ALT-L on the keyboard), a menu similar to the one on the right appears.

The following table outlines the commands you can select along with a brief explanation.

Command
[
Configure
()
Download

&

Hibernate

Quick Re-
configure

e

Profiles

A

Wizard. ..

Table 3: LogTag menu - available commands
Explanation

This will display a wizard to help you through the necessary steps to configure
LogTag®s for their next use. This command is explained in more detail in the
chapter Configuring a LogTag® for recording (on page 45).

This will display a wizard to help you through the necessary steps to retrieve a copy
of the recorded readings stored inside the LogTag®(s). This command is explained in
further detail in the chapter Results from LogTag® Loggers (on page 80).

This will display a wizard to help you through the necessary steps to set LogTag®s to
"Hibernation" mode. This command is explained further in the chapter Hibernation
- Prolonging battery life (on page 72).

With this command you can re-configure a logger with the same settings as for the
previous trip. This command is explained in further detail in the section Quickly re-
configuring a LogTag® (on page 68)

With this command you can configure a logger with a configuration profile
previously created. This command is explained in further detail in the section about
Configuration Profiles (on page 74).

This will display a wizard to help you through the necessary steps to retrieve a copy
of the recorded readings stored inside the LogTag®(s) and then prepare the LogTag®s
for their next use. This command is explained in further detail in the chapter
Configuring a LogTag® for recording (on page 45).

m‘:@ Configure
‘F@ Download

[ﬂ Hibernate

‘(’;‘*ﬁ Quick Re-configure
L

D’ Profiles
@ Wizard

F3

F4

F5

F6

F2
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LogTag® Online Menu

The LogTag® Online menu contains commands for interaction with LogTag®s web based storage and analysis
portal, LogTag® Online. You can find details about connecting LogTag® Analyzer and LogTag® Online in the
section about Integrating LogTag® Analyzer with LogTag® Online on page 127. If you want to know more about
LogTag® Online and its features please go to http://www.help. logtagrecorders.com/LTOnline/.

When you click LogTag® Online (or press ALT-O on the keyboard), a menu similar to the one on the right appears.

The following table outlines the commands you can select along with a brief explanation.

Table 4: LogTag Online menu - available commands

Command Explanation
[ 3 This will display a dialogue where you can enter your user name and password for
': LogTag® Online.
Sign In
® If you are signed into your LogTag® Online account, you can sign out if you click this
e menu entry.
Sign Out
@ This will open your default browser and display a web page where you can create a

new a LogTag® Online account. For this, you will require internet access and an
Create an Account  email address.

s This will open the LogTag® Online Connection Wizard, which is used to configure
U. the settings for WiFi enabled devices such as interfaces (LTI-WIFI and LTI-WM-WIFI)
Connection Wizard and real-time loggers (UTRED30-Wifi).

The wizard is a stand-alone Windows app that will be installed together with
LogTag® Analyzer.

You can find more information about the functionality of the LogTag® Online
Connection Wizard in the wizard's online help.

LogTag® Online allows you to be a member of multiple teams, however, LogTag®

Current Team Analyzer can only be connected to one of the teams at any one time. You can choose
which of your teams is connected by selecting its name in this menu entry. LogTag®
Analyzer will remember your team setting for the next time it is opened.

a Connecticn Wizard

Current Team 3

Figure 25: LogTag Online Menu
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Window Menu

The Window menu contains commands that relate to the management of windows open in LogTag® Analyzer,
which display the contents of a LogTag® file. [ niew window

Commands available in the Window menu:

L]
@i Clgse Window

Table 5: Window menu - available commands @‘ Close All

Command Explanation P |scein

M Opens a new window that contains a copy of the information of the currently selected window. This command is [T ligest o

useful when you need to closely inspect and analyze different sections of the same file. =1
New Current Windows »
Window
Figure 26: Window menu

@ Closes the currently selected window.

=

Close

r Closes all open windows.

Close All

= Maximises all windows inside LogTag® Analyzer's docking canvas, with a tab for each window.

Dock All

r‘_'| Un-docks all windows, so they can be positioned freely around the computer monitor.

Float All

Current This sub-menu, when clicked, shows a list of the currently open windows. Click on an entry to bring the window
Windows  to the front. If you want to change the currently selected window to one of the windows listed, just click/select the
appropriate entry on this list.
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User Server Menu

The User Server menu contains commands that allow you to log on and off. When clicking on User Server (or
pressing ALT-U on the keyboard), a menu similar to the one one on the right appears.

The following table outlines the commands you can select along with a brief explanation. Some commands do not
appear if no file is open.

Command

[ ]
O

User logon

[ ]

| &
User logoff
i

Tam

Change
Password...

©

Settings...

Table 6: User Server menu - available commands
Explanation

This allows a user to log on to and use the Analyzer software. When the software is connected to the User Server
software, users must log on to the software prior to being permitted to use the software. Therefore, this
command will only be available if the Analyzer software is connected to the User Server software. If a user is
already logged on to the software, then this command is not visible. The section User Server explains in more
detail how to get the Analyzersoftware to connect to the User Server software.

This allows the currently logged on user to log off the Analyzer software. The username portion of this
command will represent the name of the user currently logged on. If there is no currently logged on user, this
command is not visible.

This allows the currently logged on user to modify their password that they use to logon to the
Analyzersoftware. This command will only be available if the Analyzersoftware is connected to the User Server
software and the User Server administrator has granted the appropriate user permissions.

This will open a window allowing you to enter the settings required to connect to or disconnect from LogTag®
User Server.
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Help Menu

The Help menu contains commands that provide you with help and assistance when using the LogTag® Analyzer

software.

When clicking on Help (or pressing ALT-H on the keyboard), a help menu appears.
The following table outlines the commands you can select along with a brief explanation.

Table 7: Help menu - available commands

Command Explanation

s

Help
Topics

) »
User
Guide

a
LogTag®
Home
Page

Q

Request
help

S

Check
Internet
for
update

i

About
Analyzer

Opens a window that contains the online help.

Opens the online user guide for viewing. Requires PDF viewing software (such as Acrobat Reader) that can read
version 1.6 compliant PDF files to be installed on the computer.

This will open your default Internet browser software and display the LogTag® Recorders Internet site,
http://logtagrecorders.com. This command requires that your computer be currently connected to the Internet to
successfully display the LogTag® Recorders Internet site.

This will gather non personal information from your system to include in the email to be sent to software
support at LogTag® Recorders, so that the support team will be informed of the relevant information about your
system in order to provide you with quality and useful assistance. This command is explained in further detail in
the section about Getting more help on page 187.

This is a simple way of checking to see if there is a newer version of this software available for download. This
command is explained in further detail in the section about Upgrading LogTag® Analyzer on page 22.

Display the version information for LogTag® Analyzer.

mﬂeip Topics
JL. User Guide

ﬁ Analyzer Home Page

0 Request Help

@ Check Internet for updates

o About Analyzer
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Toolbar commands

The icons on the toolbar give you access to some of the most frequently used commands.

A@BE=s = QM

Properties Signatures Send Mail Upload Copy Zoom Qut Real Time Elapsed

Wizard

Print

Figure 29: LogTag® Analyzer toolbar

Ll

Wizard

B P s

Print

Properties

Signatures

=

Send Mail

1]

Uplaad

Table 8: Toolbar icons and their function

Wizard

Invokes the LogTag® Wizard. For more details please
refer to Using the LogTag® Access Wizard on page 68.

Open
Displays the file open window. This allows you to open
previously saved LogTag® data files.

Save

Save a copy of the LogTag® data to a file on your disk
drive.

Print

Opens the WIndows Print dialogue so you can print the
LogTag® data to a printer. Please see Printing the results
on page 117 for further details.

File properties
Displays file properties about the currently selected file.

File digital signatures

Displays information about any digital signatures
included in the currently selected file. Here you can also
add new digital signatures to files or print copies of the
digital signatures.

Send mail

Creates a new draft email and attaches a copy of the
currently selected fileso it can be sent to a recipient of
your choice. Please see Sending a file by email directly
from LogTag® Analyzer on page 122

Upload

Uploads the file in the currently active window to an FTP
server, or sends it by email. Please see Automatic

Zoom

LogTag Analyzer User Guide

Real Time

&

Elapsed

/G)

Zoom Out

/®

Zoom
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emailing and uploading to FIP sites on page 123

Copy

Places a copy of the currently displayed information to
the Windows™ clipboard, so you can paste it into another
Windows™ application.

Real Time

When this icon is active, the time axis represents the
elapsed time since the recording began. This is useful
when you want to inspected how long into a trip a certain
event occurred.the data were recorded.

Clicking the icon switches to date and time display.

Elapsed Time

When this icon is active, the time axis represents the
date and time. This is useful when you want to inspected
at what date and time a certain event occurred.

Clicking the icon switches to elapsed time display.

Z0oom out

Zooms out one level of the chart in the currently active
window. If you are displaying a chart and this function is
not available, then all available data are already being
displayed and you cannot zoom out any further.

Zoom to inspection marks

This zooms the chart so readings are shown between the
oldest reading recorded and the first inspection mark
that exists in the data. If this function is not available
then there are no inspection marks in the data currently
being displayed.

The next two commands will not be available until this
command is activated.
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o

Previous

MNext

Average

Multi

=

Single

©

Options

@ ]
«© W

Logon Logoff

Previous inspection mark group

This zooms the chart so readings are shown which were
recorded between the first inspection mark currently
being displayed and the previous inspection mark.

This function is disabled when either the oldest reading
is already being displayed, or the "Zoom to inspection
marks" function has not been activated.

Next inspection mark group

This zooms the chart so readings are shown which were
recorded between the last inspection mark currently
being displayed and the next inspection mark.

This function is disabled when either the newest reading
is already being displayed, or the "Zoom to inspection
marks" function has not been activated.

Average

Combines all open file windows into a single Multi Chart
window and activates the average tab, or, if already in
multichart, activates or disables the average tabs. It is
recommended to deactivate this feature when processing
large data sets, as Minimum, Maximum and Average
Charts can require considerable computer resources when
activated.

Multi Chart

Switches into Multi Chart mode, which displays all
currently open charts together in one window using the
same time axis.

Single Chart

Opens all charts displayed in a multi chart in their own
individual tabs (the original multi chart remains open).

Options

This will open a window allowing you to customize the
software. You can find a detailed overview over all
settings in the chapter Customising the Software on
page 131.

Log on/Log off

These icons are only displayed if LogTag® Analyzer
requires a connection to LogTag® User Server software in
order to operate and are used to log on or off. Please see
Connecting to LogTag® User Server on page 181 and User
Server on page 169.

LogTag Analyzer User Guide
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If you are working with a small computer monitor, not all icons may be visible.
In that case click the down arrow next to the group where the icons are missing,

and you will get an expanded view of the toolbar.
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Print preview toolbar

The print preview feature -available through the File menu- will
display a view of the data as it would appear printed out. When the
software is displaying a file in print preview mode, an additional
toolbar will appear, similar to the picture one on the right:

Table 9: Commands available in the print preview toolbar

Command
[
Refresh

H 4 5 of134 b bl
Page Navigation

= |
Print...

View Zoom

=B

Acrobat (PDF) file

CSV (comma delimited)
Exccel 97-2003

Rich Text Format

TIFF file

Web Archive

Export (Save As)

Explanation
This will refresh the displayed data.

This allows you to navigate between pages. These
controls are disabled if there is only one page to
be displayed.

This will open the operating system's print
dialogue, allowing you to print a copy of what
yhou see in the preview. This command is further
explained in the section about Printing the results
on page 117.

Here you can select the zoom level with which the
preview window displays the data. This works
much the same as in other windows applications.
It does not influence the printed data, just how
you view them in the preview window.

This function allows you to export the currently
previewed data to one of the listed formats. These
formats are additional to the export formats listed
in Exports and Reports on page 162

Close the preview window with the Close button .

LogTag Analyzer User Guide
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The Status Bar

The status bar is located at the bottom of the LogTag® Analyzer
program window.

Display Time Zone

I Far Help, press F1. To use a LegTag, pressF2, (9] Seleet Bisplq;TmIaM = LegTag Cenfigured Time (Display Clock Adjusted) Pending E-‘mw;; T Uplaads: 0 :;"

Time Zone Selection Upload Status

The status bar shows information about some of the software's active
tasks and settings, and what you can do. You can also select the Time
Zone for the data display.
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Dates and Times

Every LogTag® product contains a real time clock, which it uses to
determine the recording start time, when to take a reading and when to
stop recording.

Often, the loggers are used for transit monitoring applications, where
goods are transported between different countries, and frequently
different time zones.

Time zone information is included in the loggers' memory, allowing you
to relate shipments from different time zones to each other.

During configuration with a PC, the clock of each logger is set to the
computer's time, and the local time zone of that computer is also
stored in the logger's memory. When the logger is downloaded by the
recipient, LogTag® Analyzer is able to use the time zone information
from the logger and the information from the PC used for downloading
to display the data in a variety of different time zones.

Table 10: Time zones for data display

Time zone What is displayed
Local PC Time All times are displayed in the time zone of the computer
Zone used for viewing the data. This is the most commonly

used option, as it displays the dates and times on screen
in your local time zone.

Note, that this is not the same as the download
time zone, if you were sent a file from a logger
downloaded in a different time zone.

Download Time All reading times are displayed relative in the time zone
Zone of the computer used for downloading the data.

Configuration
Time Zone

All reading times are displayed in the time zone of the
computer used for configuring the LogTag®.

You would use this option if you wanted to view the data
in the same way the sender of the logger would see it.

UTC/GMT Time All times are displayed in Greenwich Mean Time
Zone (Universal Time Coordinated).

This is the best option when comparing different loggers
from different senders in different time zones.

LogTag Analyzer User Guide

The currently used time zone is shown on the status bar:
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F. N
| For Help, press F1. To use a LogTag, press F2. (7] Select Display TimeZone = Ill:gl'm; Configured Time {Display Clock Adjusu:dll Pending E-mails: 1 Uploads: 0
- 7

The default time zone used when first opening a file is set in the
options settings. If you quickly want to switch to another time zone,
without affecting all other charts, you can click on Select Display Time
Zone and choose the desired the time zone from the list.

e,
| For Help, press F1. To use a LogTag, press F2. IB- Select Display TimeZone = | LogTag Configured Time (Display Clock Adjusted)  Pending E-mails: 1 Uploads: 0
e

For additional time zone settings please see Time zones on page 166

Upload Status

When either automatic or manual uploading or emailing of files is
enabled, the upload status is displayed at the bottom of the LogTag®
Analyzer window in the status bar.

l Far Help, press F1. To use a LogTag, press F2. |:"- Select Display TimeZone -~ LogTag Configured Timse (Display Clock Adjusted) 1 Pending E-mash: 1 Uploads: 0 I

Figure 31: Status bar showing one pending email.

The email counter will decrease as emails are sent. Similarly, the
upload counter will decrease as files have finished uploading.
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Colour Picker

In a number of different places throughout the software you can set a colour for lines, text or
shade areas. This is done with the help of a colour picker, which works similar to selecting a
colour in other windows applications such as Microsoft Word.

To change a colour for an item, click on its colour selection box.

Basic Colour Selection

The basic colour selection window will appear. If it doesn't, the colour for this item cannot be
changed.

The colour currently selected for the item is displayed on the right. Click on any of the colours
in the honeycomb to select it. The New colour is now shown on the right above the old colour,
SO you can compare the two.

You can click the colour picker # and then click on any part of the screen to select that colour.

You can enter a hexadecimal RGB colour code directly into the field labelled #. This can be
helpful if you have a corporate colour scheme you are trying to match.

Advanced Colour Selection

You can click on the Advanced tab in the colour selection window to bring up a more refined
selection mechanism. Here you have more detailed control over the colour, and can also apply
transparency.

Move the slider up or down to select the basic colour hue. Then set luminosity (horizontal
movement) and saturation (vertical movement) in the colour square and click on the desired
colour. Change the alpha value to change transparency (0 = fully transparent, 255 is fully
opaque). The corresponding hexadecimal RGBA colour code is displayed in the field labelled #,
where you can also enter a hexadecimal RGBA colour code directly. As with the basic window
the colour picker is also available.

Basic | Advanced

Cuarent
® FFD2D2

Cancel

Figure 32: Basic Colour Selection

Bagic | Advanced

¥}

IR TR I TR TIRET)

Current
# FFD202

4

Cancel

Figure 33: Advanced Colour Selection
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Initial Set-up

Before you start configuring and downloading loggers we recommend

you customize some of the settings by clicking Options from the Edit

menu.

« Define the display language and temperature units used (General
Settings on page 134)

« Choose how time and date are displayed (Date and Time Format on
page 165)

« Select how LogTag® Analyzer names downloaded files and where
these are stored (File and Folder Settings on page 154)

« Decide which communication ports LogTag® Analyzer uses
(Communication Ports on page 168)

Sometimes your network administrator will ask you to import settings
from a configuration file. You can read how to do this in the section
about Importing and Exporting Option Settings on page 173.

Advanced Set-up

Once you are familiar with the basic settings, you can refine your
work-flow.

» Share data with colleagues and project stakeholders by exporting
and emailing them (see Sharing recorded data with others on
page 122)

. Enable the report logs, so you can track which loggers you have
configured, and what settings were applied

« Automate your work-flow with auto-downloading and auto-
reconfiguration (see Automation on page 143)

page 43



Using LogTag® Analyzer LogTag Analyzer User Guide page 44

Connecting the Interface

L Tip: You can skip this step if you only use USB Loggers. J

The standard interface cradles available from LogTag® Recorders
connect to a USB (Universal Serial Bus) port.

These ports are typically located at the rear of workstations, but you
can also find ports at the front, or at the sides if your computer is a

laptop. If you are using a USB hub we recommend it has its own power

supply. e

LogTag® Analyzer can communicate with multiple interface cradles at @ o, @ ,ﬂ

the same time; you may connect as many USB interface cradles as the = H !

computer supports, although we find that connecting more than 4 '

interfaces becomes impractical. 2xUSH Rer ZxUBE Fort

If you install LogTag® Analyzer on a computer with no internet
connection you must ensure USB interface cradles are not connected
until the software installation is completed, since the required drivers
are installed as part of LogTag® Analyzer.

If the software cannot identify a connected USB interface cradle there
may have been a problem during the installation of the driver
software. Please refer to the FAQ on the LogTag® Recorders website for
further information.

LogTag®'s range of USB loggers do not require an interface to
communicate with LogTag® Analyzer.

Figure 34: Rear of PC with 4 USB ports

LogTag® Recorders also offer a serial (RS232) port interface. This can
be useful for heavily visualized environments such as Citrix or
VMWare. Please contact LogTag® for more information.
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Configuring a LogTag® for recording

Some of the LogTag® products are delivered to you ready to start, but
most of the time a logger will need to be configured before it can
record temperature or humidity data. During the configuration process
of a logger you define the settings that affect how the LogTag® records
data during its next trip, such as:

« how and when to start recording, how many readings to record and
at which interval

« whether to stop recording after a defined number of readings or to
record continuously

« what alerts to process and at which temperature limits

. if password protection is required for configuring or downloading
« What information to show on the logger's display

To start the configuration process, insert the logger to be configured

into the interface (or a USB socket if you have a USB logger) and click
Configure from the LogTag menu or press F3.

Note: By default the Auto Download feature is enabled, which
means LogTag® Analyzer will download any previously
recorded readings. Please see Enable automatic download of
readings from LogTag® on page 143 for an overview of this
feature.

The LogTag Configure window will be shown, and LogTag® Analyzer
will check all connected interface cradles and USB ports for attached
loggers. Every LogTag® found will be listed in the Progress Pane on the
left side, showing the progress of retrieving its configuration settings.

When all loggers have been found, the configuration settings currently
stored in the logger in the first interface found are shown in the
Parameter Pane on the right. These are either the factory pre-set data,
or the parameters used when this logger was last configured. Model
number and serial number of this logger are shown in the Parameter
Pane.

( Locate cradled LogTag(s)
The software will locate the LogTag products for you so you can update their
e Lead LogTag(s) current _ _ _ N
. .: N . configuration settings for next use. Note, NO logged data will be downloaded
** configuration
and/or saved to disk.
Prepare LogTagl(s) for next use
Note: Single use LogTags, limited use LogTags, LogTags with locked
configurations, and LogTags with low battery may display a lock symbol and
not allow configuration.
USE: 03101006
TRIX-16 SN:1001016928 @ Click on an interface to the left to load that LogTags current configuration.
Interfaces with compatible LogTag that can be configured at the same time will
SERIAL: COM7 be automatically included.
HAXO-8 SN:1010080254 @
I The process of configuration allows you to define a number of parameters,
including:
+ How long it should record dara for,
+ The frequency used to sample the data,
- The limits, which -if exceeded- cause an alert 1o be displayed,
- Whether to record continuously or take a set number of readings.
G Rescar o Configure B Save Profile e Cancel 0 Help

Figure 35: Locating loggers and loading initial parameters

R F3
[E. Configure h‘

|@ Downioad F4

m Hibernate L

@ Quick Reconfigure F&
E;l' Profiles F7
|N Wizarg F2

Figure 36: LogTag Menu Configure
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Note: You can attach different logger models at the same
time, however, you can only configure loggers of the same
model at the same time.

g In the example shown the first detected logger was a HAXO-8
in the RS232 serial interface. Therefore the configuration
parameters for this HAXO-8 are shown.

If you wish to configure any of the other loggers found, you
can click on that logger's progress bar, and the parameter
pane will now show the corresponding configuration data for
that logger.

(.

You can now adjust the configuration parameters for the next trip.

Command Buttons

When you have entered or adjusted the settings as desired, click
Configure] to upload these new configuration data to the LogTag®. In
addition to the (Configure) button following other actions are available
in this screen:

.

Scans all connected interfaces and USB ports again. Click this button
if you have inserted additional USB loggers you wish to configure, or

not all connected USB loggers appear in the Progress Pane.

« (Save Profile

You can save the parameters as entered to a Configuration Profile.
Please see Configuration Profiles on page 74

.

You can abort the configuration process by clicking this button.

.

Clicking this button brings up a browser window, showing help for
this topic.

. [Repeat Confiqure]
This button is available only after one or more loggers have been
configured. Clicking this button will scan all interfaces and USB

LogTag Analyzer User Guide

Serial Number

Action Pane

Configure LogTagis) HAXO Settingsfrom SN:1010080254

" Locate cracied LbgTag(s)

,/ Load LogTag(s) current Certificote of Calibration
configuration )
User Information
Prepare LogTagls) for next use Description: LogTag Battery: OK

u Configure reguires a password D Upgrade logger
Click en LagTag below 1o select
modells) to be configuredshow

LogTag's current Lonfiguration Logging Parameters

SERIAL COMT — 1| [Penoutonstan w| [+#] Enabie pre.start iogging
HAXD-8 Sh1D1008054 )
() Record readings continuously, ovenwrite oldest when memory full |

USE: 03101C06 (®) Record readings 5o that |

HAXO-B Sh:101 0080258 a] Readings recorded will span at fsast |2 < | Days
— Humber o readings to record 8000 = | masimup s 5703
USE: D3101C06 -
q Record areading every 00:00:30 2 | 30 Saronds.
HAXO-8 SN:1010080258 ’] 45
I Begin recording after a delsy of  00:00:00 % | Moné.

LogTag USB-HID
UTRID-16 SN:5 040000038

,jm [+4] Eratie the Ok (Greer) indicator
- rJ Erable the Alert [Red) indicator, whene

LogTag USE-HID Readings below 0.0 3 oraboge §00.0 % | %RH

UTRIX-16 SM:5040000030 Afer D 2 ¥ | tonseoutive alert readings (1 Minjste)
iz =
LogTag USS-HID lm;t:| alert readings have occurmed (1 Minute]
USRIC-4 SN:5599000002 e IZ Leave alert indicator enabled even (f 'mlng: neturn ta non-alert range

[7] lear and reset stert when START MARK button pressed
LagTag USE-HID
USRIC- SN:4D25017749 a .
——————.
»

i Temperature Alarm Settings = Humi Alarm Settings

G Rescan o Configure Save Profile Q Cancel 9 Help
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Command Buttons

Figure 37: Configuration screen for a HAXO-8

[] Retain DescriptionPassward B
Progress Pane
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ports for loggers again, and upload the entered configuration data to
each eligible logger.

:

Click to start the configuration process from the beginning.

. [Certificate of Calibration]
Click to view the logger's factory Calibration Certificate.
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Progress Pane
Each logger found will be listed in the Progress pane.

When you see this icon displayed in the progress bar, the parameters entered for configuration
will be applied to this logger when clicking

When you see this icon, the logger will not be configured when you click since the
model is different from the one for which you have entered configuration parameters.

A logger showing this icon cannot be configured, as there are no trips remaining. This applies to
single use loggers or loggers that have a locked configuration. You will see this on SRIC-4, SRIL-
8, USRIC-4 and USRIC-8 loggers when you attempt to configure them for a second trip.

This logger has a low battery. Some models cannot be configured when they have a low battery.

This icon is displayed after the logger has been successfully configured. This logger can now be
started, or will start automatically, depending on the chosen start options.

The progress bar will also show the word Configured

This icon is displayed after an unsuccessful attempt to configure the logger. Further error
messages will be displayed to indicate why the logger was not configured.

This icon is displayed after the logger has been successfully configured, but the logger has some
advanced features that the software could not set. This typically happens if you try to configure
older and newer loggers together. When you hover the mouse over this icon you can see which
features were not set.

While the software is sending the new configuration data to each LogTag®, progress bars in the
Progress Pane will identify the loggers that are being configured.

Once finished the progress bar shows Configured.

If you use (Repeat Configure] to configure a different LogTag®, you may update its configuration
without having first saved previously recorded data.

As soon as a logger is configured, previous data can no longer be downloaded. Please ensure

you have downloaded the readings before configuring to avoid data loss.

If additional loggers of the same model have been located, these loggers will also be configured
with the new data.

Interface Serlal Number
3 T USE:03101C06 ]
ogger Mo | - ; !
no-sswooosezss (3 —(EEEEED)

Progress Bar Logger Serial Number

Figure 38: Progress Pane Indicator

USB: 03101C06

HAXO-8 SN:1010080258  I) m

Configuration Complete
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If you select Retain Description/Password, existing descriptions and passwords for each logger
will be retained, instead of using the details from the configuration parameters entered. Note
that you will still need to provide a password for loggers that have an active configuration
password protection.

The next sections describe each configurable option; please note, however, that not every
option is present for each of the LogTag® models.

To configure loggers you can also use pre-configured profiles, or quickly re-configure a LogTag®
with the same settings as used for the previous recording. For more details on these options
please Configuration Profiles on page 74 and Quickly re-configuring a LogTag® on page 68

Working with more than one LogTag®

At some stage you may need to perform a similar task on multiple LogTag®s, whether it is
retrieving readings or preparing them for a new trip. LogTag® Analyzer has been designed to
make working with multiple LogTag®s easy.

1. You can connect multiple interfaces to your PC, so more than one logger can be
configured or downloaded at the same time.

2. Use the Auto-download feature. To retrieve a copy of the recorded readings from multiple
LogTag®s, simply insert each LogTag® into the Interface cradle. The software will
automatically retrieve the recorded data from the LogTag®, save it to disk and then
display the information for you (Automation on page 143). You can repeat this for each
LogTag® without needing to interact with the software.

3. Use the Repeat feature in the configuration window without having to re-enter the same
parameters more than once, even with different descriptions or passwords.

4. Use a pre-configured Profile (Configuration Profiles on page 74) or the Quick Reconfigure
feature (Quickly re-configuring a LogTag® on page 68)
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User Related Configuration Parameters

User related configuration parameters are entered at the top of the
Parameter Pane:

User Informiation
Deseription: LogTag Battery: OK

Password: ' 'Connqme reguires & password

[IDowrload requires a password

Description

(optional)

This can be used for identification of the load in transit to be monitored,
or simply an identifier that describes the purpose of the monitoring.
Bill of Loading information, Shipper, commodity, contact name and
other relevant information can be placed here.

The Description can be up to 38 characters long (36 for recorders with a
display) and can contain a mix of letters, numbers and special
characters. The selected input language of the computer's operating
system determines which special characters can be selected.

If a user decides to make use of special characters, extra information
about the language used is stored inside the recorder. Users will then
need LogTag® Analyzer 2.3 Release 7 or later so the User ID is correctly
displayed.

If you use the special character sets for languages such as Greek or
Chinese the maximum number of characters that can be used will be
reduced due to the increased memory required to store the characters.

Please Appendix on page 177 for a more detailed explanation.

s D
To view the PDF file generated by a USB logger, the fonts used
must be present on the receiver's computer. PDF Reader
software typically only installs a small number of fonts, none
of which support an extended character set. Therefore, you can
only use ASCII characters in the User ID field when configuring
a USB logger.

& J

Configure requires a password
If you select this option, any user wishing to configure the logger in the
future must provide this password. A new entry field appears, where

LogTag Analyzer User Guide

you can specify which password you wish to use.

Passwords are case sensitive ("Bob" and "bob" for example are
different passwords).

If you enter a new password, or change an existing password, you will
need to verify the password when you click‘

If you use special character sets for languages such as Greek or
Chinese, the maximum number of characters that can be used will be
reduced due to the increased memory required to store the characters.
Please Appendix on page 177 for a more detailed explanation.

Due to the restrictions in the Description field you can only use ASCII
characters in the password field when configuring a USB logger.

Download requires a password

If you select this option, the LogTag®'s recorded data can only be
downloaded after entering the correct password.

Only one password can be provided for each LogTag®. The same
password applies to the Configure and Download actions.

Battery condition

If the battery in the LogTag® reports 'low' the logger is should no
longer be used. The software will display a warning in the top right
corner.

LogTag Battery: Low

Some LogTag® models display the remaining percentage in this screen
once it falls below half capacity. Some models cannot be configured any
longer once their battery capacity falls below a pre-determined
threshold.

Remaining Starts
If the logger you are configuring has a limited number of starts, this
will be indicated here.

Starts remaining: 1

Upgrade logger

Some loggers can be upgraded, for example to allow a download
password, not possible up to now. This upgrade can be applied, if you
select Upgrade logger. Please note that older software will then most
likely no longer be able to communicate with this logger.
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Logging Related Configuration Parameters

Logging related configuration parameters are entered in the middle
section of the Parameter Pane:

Logging Parameters

Push button start v D Enable pre-start logging

(_J) Record readings continuously, overwrite oldest when memory full

(®) Record readings so that:

Readings recorded will span at least |0 Days

Number of readings to record 10 maximum is 8003

Record a reading every | 00:00:30 ~  30Seconds.

Begin recording after a delay of  00:00:00 + | Mone.

Start method

(mandatory)
This is used to determine how and when the LogTag® will start
recording its next trip.

« Push button start

LogTag Analyzer User Guide
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Note: When using the Date/Time start option, the start time
must be at least two minutes into the future. This delay
allows you to complete the remaining configuration options
and gives the software enough time to upload the
configuration to the LogTag® before it starts.

« Push button start from hibernation

When the 'Push button start from hibernation' option is selected,
the LogTag® will start as if programmed for 'Push button start'. The
difference is that once the configuration is successfully uploaded to
the LogTag® it will be placed into hibernation. When the

START/Mark button is pressed and held, the LogTag® will wake from

hibernation and start recording with the parameters as configured.

Note: When using this start option, the real time clock
inside the logger is suspended until logging starts. When
downloading at the end of the trip, the reading times are

When the 'Push button start' option is selected, the LogTag® will
start recording when the START button has been pressed and held
until both the OK and Alert lights alternately flash on and off.

Date/Time start

When the 'Date/Time start' option is selected, the LogTag® will
automatically start recording at a specified date and time. Two
additional entry fields will appear, one for selecting the date, the
other for the time. Enable pre-start logging and Begin recording
after... (delayed start) options are not available with a date/time
start.

Pressing the START button prior to the start date/time will have no
effect.

back-calculated based on the time of the computer on which
the unit is downloaded. It is therefore necessary that
computer is set to the correct time, so the downloaded data
have the correct date/time.

8 J

Please see Hibernation - Prolonging battery life on page 72 for more
information.

Not every LogTag® model can support every start mechanism. If a start
option is not listed when configuring a particular LogTag®, this option
is not available for this model.

Enable pre-start logging

(optional)

When you enable Pre-start logging, the logger starts taking readings as
soon as the configuration data have been uploaded. If you forget to
press the START button, the data for the trip will still be available. This
insures no critical data are lost. This option is further explained in the
section Pre-start data collection on page 70.
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Pre-start readings will not be recorded if the start method is
'Date/time' or 'Push button start from hibernation'.

Record readings continuously, overwrite oldest when memory
full

(mandatory L

When you select this option, the logger initially fills the complete
memory with readings, then overwrites the oldest data when the
memory is full. For a more detailed explanation see Continuous
operation on page 69

Record readings so that:

(mandatory)

If this is selected, the logger stops logging taking after a pre-
determined number of readings. The following two fields determine the
time these recordings will cover.

Please note that some LogTag®logger models can be stopped manually,
so there may be fewer than expected readings.

Readings recorded will span at least X days
(mandatory 2

If you know how many days of data you want to record, enter this
number here. The shortest possible recording interval that covers this
period will be automatically calculated, based on how frequently the

logger takes a reading.

Number of readings to record (maximum is Y)
(mandatory)

This field will display the calculated number of readings if you select a

time period and an interval. Alternatively, you can select the number of

1 You must select either continuous recording, or recording for a defined time span

2 The entries are interdependent, changing log interval may change the number of days the logger can

take readings for
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readings desired, and the time period will be calculated based on the

interval. Y represents the maximum number of readings the LogTag®
can store, however with a selected interval and a selected time span,
you may not need to use all of the available memory.

Record a reading every X

(mandatory)

This determines how frequently the LogTag® records and stores
humidity or temperature values. To change the number, use the up
down and arrows. Highlight the seconds, minutes or hours value to
change only those values. You can then also enter a value manually.

Begin recording after a delay of X

(optional)

Enter the time that passes after a user has pressed the START button
on the LogTag® until the start of the recording. This feature is useful
for example, when the LogTag® could falsely trigger an alert because
the environmental conditions to be monitored are quite different to the
environment in which it is started.

0 If pre-start logging is enabled, the LogTag® will still continue
to record pre-start readings during this delay period.
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Prioritising Communication over File Download

When this feature is enabled, a USB logger
will try to establish communication with
LogTag® Analyzer before starting to generate
the on-board files, such as *.pdf, *.1td and

* csv. This is particularly beneficial for re-
usable USB loggers such as the UTRIX-16,
where you do not need to see the PDF file
again when re-configuring the unit. The time
between inserting the logger and being able to
communicate with LogTag® Analyzer no
longer needs to account for the extra step of
generating any files on the unit itself and
providing them via a new drive letter.

Some existing models already
support this feature. If it is disabled,
you can enable it, but please keep in
mind that the recorder will then
become incompatible with LogTag®
Analyzer 2.6 and earlier. Subsequent
disabling of the feature will NOT
make the logger compatible with
earlier version again.

8

New models may already have this feature
enabled ex factory.

On the UHADO-16, UTRED30-16 and
UTRED30-Wifi models this feature is always
enabled and cannot be disabled.
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Recorder User can access data User can access PDF
plugged in in LogTag Analyzer from drive letter only
once Analyzer is closed

Prioritise download . . . Communication with LogTag Analyzer
over file generation enabled Driver Installation Ul ey
LogTag Analyzer is running Device Enumeration ~ Analyzer File generation background activity

Recorder User can access PDF

plugged in from drive letter

User can start LogTag
v Analzyer and access data

Prioritise download ] )
over file generation enabled Driver Installation Wait for il e e
LogTag Analyzer not running Device Enumeration Analyzer

User can access data

Recorder User can access PDF
plugged in from drive letter
in LogTag Analyzer

Driver Installation
Device Enumeration

Prioritise download

over file generation disabled File generation active

Figure 39: Timing comparison when inserting USB loggers
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Configuring Alarms

The LogTag® can display a visual alert if one or more of the configured
alarm trigger conditions have been met. Each alarm trigger condition
consists of a threshold value, an activation type (which can be instant,
consecutive or accumulative 3) and a delay time, if it is not an instant
alarm.

If an alarm trigger condition requires readings to exceed an upper
threshold temperature it is called an upper alarm. If an alarm trigger
condition requires readings to go below lower thresholds it is called a
lower alarm.

The threshold parameters are shown in LogTag® Analyzer when the
LogTag®'s readings are downloaded and displayed.

Alarm related configuration parameters are entered in the bottom
section of the Parameter Pane:

@

[

Enable the OK (Green) indicator
Enable the Alert (Red) indicator, when:

Readings below |-20.0 & oraboye 500 7 |°C
Afer[ ]2 < | consecutive alert readings (None)

Afer[ ]2 % | alert readings have occurred (Mone)

[ Leave alert indicator enabled even if readings return to non-alert range

[ |lear and reset alert when START MARK button pressed

Temperature Alarm Settings | Humidity Alarm Settings

== D

« Instant = one temperature reading is above (below) the threshold
Consecutive = temperature readings are above (below) the threshold for the time defined in the
activation delay without interruption

« Accumulative = temperature readings are above (below) the threshold for the total time defined in

the activation delay time, but may not necessarily be sequential.

LogTag Analyzer User Guide

You will find one or more tabs, depending on the logger model you wish
to configure. Click the tab's label to show the parameters for that tab.

HAXO-8 and UHADO-16 loggers show two tabs, one for temperature
alert conditions, one for humidity. Note that some values apply to both
tabs simultaneously, such as the OK indicator field.

Standard Alert Related Configuration Parameters
Enable the OK (Green) indicator

This determines whether or not the green LED should blink while the
LogTag® is recording. This is not available for display products.

Enable the Alert (Red) indicator when...

This defines whether or not the red light should activate when an alert
condition has been detected. An alert occurs when one or more of the
conditions described below have been met. When an alert condition has
occurred, this indicator will flash at a regular interval.

Readings below X or above Y (inclusive)

You can set the upper and lower threshold limits by typing the
appropriate information directly in the boxes, or by moving the value
slider, or a combination of both. If readings stay inside the range
specified by X and Y the alert indicator will not activate. If a reading of
X and below, or Y and above is recorded, the alert indicator may light
up, depending on the alert conditions. Charts will display alert readings
according the settings made in the Charts section of the Options Screen.

The values entered in these boxes are included in the alert range. In the
example later in this section 7 consecutive readings of 45°C will trigger
an alert, whereas 7 consecutive readings of 44.9°C will not trigger an
alert. Please set your alert values with this in mind.

Some loggers models allow you to enable upper and lower alerts
independent of each other; this is useful in situations where one of the
alert thresholds is irrelevant to your recordings and, if left activated,
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may falsely activate the alert LED. In this case there will be one check
box for each alert, similar to this image:

After X consecutive alert readings (W minutes)

Tick this box, and enter a number into the adjacent field if you want to
trigger an alert condition once X number of consecutive alert readings
are recorded. Note that the number of minutes shown will depend on
the number of alert readings you enter into the box AND the recording
interval already specified. For example, if X is 3 and two readings are
above the upper threshold limit but the subsequent reading is below
the upper threshold limit and still above the lower threshold limit then
the alert indicator will not activate. Maximum value is 256, minimum is
2.

After X alert readings have occurred (W minutes)

Tick this box, and enter a number into the adjacent field if you want to
trigger an alert condition once a total number of alert readings have
been recorded, regardless of whether they are consecutive or not.
Maximum value is 256, minimum is 2.

You can increase or decrease the values with the arrows next to the
fields. Please note these are linked and certain combinations may not
be allowed.

Leave alert indicator enabled even if readings return within alert range

If this option is enabled, the alert indicator will remain active, even if
the current reading does not meet the alert conditions specified by the
previous controls.

If this option is disabled then the alert indicator will remain active only
if the current reading meets the alert conditions specified by the
previous controls.

Please note, however, that this setting is only applicable if an
immediate alert is configured; if consecutive or accumulative alert
settings are configured this box has no effect, and the alert indicator
will always remain visible once an alert has occurred.
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Clear and reset alert when START MARK button pressed

If this feature is enabled, any user can turn off an active alert by
pressing the LogTag®'s START MARK button. It will also reset the
internal alert counters as if no alert condition had occurred at all while
the LogTag® was recording.

Should the LogTag® subsequently detect a further alert condition, the
alert will activate again.

Once theLogTag® has finished recording, pressing the START MARK
button will not clear and reset any active alert.

If the LogTag® being configured does not support this feature, it will be
disabled and its setting cannot be changed.

Display Temperature In

If the logger features a display, you can select here if you wish to show
the temperatures on the display in Fahrenheit or in Celsius. This
setting does not influence how temperatures are displayed on screen
when viewing data in LogTag® Analyzer. For USB Display Loggers this is
located in the File Settings tab, as it not only sets the display units, but
also the units used for the PDF reports and the CSV file generated
directly on the device.

Example:

You wish to configure a LogTag® so alert conditions are indicated if 5
continuous readings are out-of-range or 7 total readings are out-of-
range. Alert parameters should be set as follows:

—

Enable the OK (Green) indicator
Enable the Alert (Red) indicator, when:

Readings below (0.0 % oraboye (450 % °C

After[v]| 7
After [] /10

= | consecutive alert readings (35 Minutes)
= | alert readings have occurred (50 Minutes)
/| Leave alert indicator enabled even if readings return to non-alert range

[] Clear and reset alert when START MARK button pressed

This table shows how different conditions would result in the Alert
Indicator flashing or not:
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Table 11: Alert examples
What the LogTag® recorded | What the LogTag® indicated

2 readings out-of-range, return  Neither alert condition is met.

to normal, 2 readings out-of- The maximum number of consecutive out-

range, return to normal, 2 of-spec readings is only 2 (5 required.)

readings out-of-range, return to = The total out-of-range events equals 2 + 2

normal + 2 = 6. The alert condition is 7 total, so
the alert does not go off.

No Flashing Red Alert Indicator

4 readings out-of-range, return  The first alert condition is not met, as the

to normal, 4 readings out-of- the maximum number of consecutive alert

range condition readings is only 4 (5 required.)
The second alert condition however IS met
since the total alert condition readings
equals 4 + 4 = 8. The alert condition is 7
total. so the alert DOES go off.

Flashing Red Alert Indicator

4 readings out-of-range, return = Neither alert condition is met.

to normal, 2 readings out-of- The maximum number of consecutive alert

range condition readings is only 4 (5 required.)
The total number of alert condition
readings equals 4 + 2 = 6. The alert
condition is 7 total, so the alert does not go
off.

No Flashing Red Alert Indicator

6 readings out-of-range, return = The second alert condition is not met, as
to normal the total out-of-range events equals 6 (7
required.)
The maximum number of consecutive alert
condition readings however is 6, the alert
condition is 5 consecutive readings, so the
alert DOES go off.

Flashing Red Alert Indicator
Please note following special conditions:

1. If you wish an alert to be indicated on the first reading that is
recorded out-of-spec, place a tick in the box next to "Enable the
Alert (Red) indicator when" and remove the ticks in both boxes
next to the "After X consecutive alert readings" and "After X alert
readings have occurred".
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2. You can not enter a number into the "After X consecutive alert
readings" field which is larger than the number in "After X alert
readings have occurred", since the latter alert condition would
always be met first.

3. Similarly, you can not enter a number into the "After X alert
readings have occurred" field which is smaller than the number in
"After X consecutive alert readings". The software will adjust field
values as appropriate.

Advanced Alert Settings

Some loggers support more detailed alert settings than described
before. If LogTag® Analyzer encounters one of these loggers, additional
tabs are visible in the Parameter Pane:

Temperature Alarm Settings | Advanced Alarm Settings
You can access the extra tab by clicking on the tab's label.

In the advanced settings the red alert indicator can now be configured
independently for upper and lower alert values.

Readings above X
Readings below Y

(inclusive)

In addition to entering the threshold levels, tick the boxes next to
"Readings above" or "Readings below" to enable the alert conditions for
only the upper or only the lower threshold settings, or for both. If both
boxes are ticked, the behaviour is the same as for the standard alert
settings. The charts will display alert readings according to the settings
made in the Charts section of the 'Options' Screen.

After X consecutive alert readings (W minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings below" to
establish whether only readings above and including the upper
threshold or only readings below and including the lower threshold
should count towards the consecutive alert readings. If both boxes are
ticked, the behaviour is the same as for the standard alert settings. If
the Alert Indicator is disabled for either the upper or the lower alert,
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the respective box for the consecutive alert is grayed out and cannot be
ticked.

After X alert readings have occurred (W minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings below" to
establish whether only readings above and including the upper
threshold or only readings below and including the lower threshold
should count towards the total number of alert readings. If both boxes
are ticked, the behaviour is the same as for the standard alert settings.
If the Alert Indicator is disabled for either the upper or the lower alert,
the respective box for the alert total is grayed out and cannot be ticked.

The advanced settings tab is displayed automatically if an advanced
configuration is already found in the logger to be configured. If you do
not wish to use the advanced settings, click the Temperature Alarm
Settings tab.

Example:

You wish to configure a LogTag® so an alert is displayed if 5 continuous
readings are out-of-range or 7 total readings are out-of-range, but only
if the temperature goes to 20°C and above. You wish to see in LogTag®
Analyzer if the product has gone to 0°C and below, but you do not wish
to trigger an alert for this condition. Alert parameters should be set as
follows:

Enable the OK (Green) indicator
Enable the Alert (Red) indicator, when:

Readings above [v/] | 20.0
Readings below [v/] 0.0

Tl

*]ec

After |2 = [[JReadings above After |2 =] [v/] Readings above
[ readings below [ readings below

consecutive alert readings (None) alert readings have occurred (10 Minutes)
/| Leavealertindicator enabled even if readings returnto non-alert range
[] Clear and reset alert when START MARK button pressed

Figure 40: Advanced Alert Settings - Sample settings

The following table shows how different conditions would result in the
Alert Indicator flashing or not:
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Table 12: Advanced alert examples
What the LogTag® recorded  What the LogTag® indicated

2 readings of 20°C or above, Neither alert condition is met.
return to normal, 8 readings at  The maximum number of consecutive out-
0°C or below, return to normal, of-spec readings is only 2 (5 required, the 8
4 readings of 20°C or above, readings below 0°C do not count towards
return to normal alert readings).
The total out-of-range events equals 2 + 4
= 6. The alert condition is 7 total, so the
alert does not go off, as again the 8
readings below 0°C do not count towards
alert readings.

No Flashing Red Alert Indicator

4 readings of 20°C or above, The first alert condition is not met, as the

return to normal, 4 readings of  the maximum number of consecutive out-

20°C or above of-spec readings is only 4 (5 required.)
The second alert condition however IS met
since the total out-of-range events equals 4
+ ¢4 = 8. The alert condition is 7 total. so
the alert DOES go off.

Flashing Red Alert Indicator

Separate alert conditions are useful if you expect the monitored product
to encounter temperatures lower than the lowest possible alert
temperature. In this case a flashing alert indicator may not necessarily
indicate an unfavourable condition was encountered. In programs where
such conditions are monitored the lower alert should be turned off.

Audible Alarm

This option is available in TRED30-16R, UHADO-16, UTRED30-16 and
UTRED30-Wifi loggers and can be found in the Advanced Settings or the
Alarm Settings tab. When you enable this option, the logger will sound
an audible alarm when an alarm is triggered. Please refer to the Product
User Guide or Data Sheet of your specific model to establish if it has a
beeper fitted.
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Please note, that continual activation of the audible alarm will
reduce the working life of the battery. When an alarm event is
triggered, the alarm should be cleared as soon as possible.
Please refer to the respective Product User Guides for more
information.

Display Logger Advanced Settings

The Alarm settings in loggers with a display (TRID30-7, TRED30-7,
TRED30-16R, TREL30-16, UHADO-16, UTRID-16, UTRED30-Wifi and
UTRED30-16 loggers) are similar to the Advanced Alert Settings on
page 56 or the Advanced USB Logger Settings on page 60, hence they
are not explained again here.

The loggers do, however, have an additional configuration tab.

Alarm Settings | Advanced Settings

When you select this tab you can access the settings specific to the
display:

Agvanced alanm options
[[] Alarm remains on even if readings return to non-viglationrange
[ Ciear and reset ail alarms when START/AMARK button pressed
[[] Pause alarm,statistics processing far 0 I readings when button pressed (None]
[ Shaw alarm screens during review

Advanced logger options
[[] switch off display after 30 seconds (Power save)
[ show totsl summary days collected
[ Show user resettable MinMax (if supported)

[J attow logging stop with STOR button
[ Atlow reset of logger with START button
[] Enable Quick startstop mode (if supported]

Figure 41: Advanced alert options for display loggers

Clear and reset alarm when STOP/CLEAR button pressed

If this option is enabled, any user can turn off an active alarm directly
on the LogTag® by pressing the STOP/CLEAR button. This will turn off
the alarm symbol and reset the internal counters as if no alarm had
occurred while the LogTag® was recording. When the LogTag®

subsequently registers a further alarm condition, the alarm will activate

again. Once the LogTag® has finished recording, pressing the
STOP/Clear button will not clear and reset any active alarm.

An alarm will always be registered in the day summary and
cannot be cleared, regardless of whether the alarm symbol was
cleared or not.

Alarm remains on even if readings return to non-violation range
If this option is enabled then the alarm symbol will stay on, even if the

current reading does not meet the alarm conditions specified by the
previous controls.

If this option is disabled then the alarm symbol will stay on only if the

current reading meets the alarm conditions specified by the previous
controls.

p
Please note: Unlike for units without a display these settings
also apply if consecutive or accumulative alert settings are
configured. If the Alarm conditions are no longer met, all
counters are re-set and an alarm is triggered when the alarm
condition is met again. In any case, an alarm will be registered
in the day summary, regardless whether conditions re-set or
not.

&

Pause alarm/statistics processing for X readings
If this option is enabled, pressing either button on the LogTag® while
recording excludes the next reading from the alarm and statistics

calculations; PAUSED will now be shown on the display. This allows the

user to review the statistics or clear an alarm without causing an
invalid reading, alarm or statistic.

Switch off display after 30 seconds
If this option is enabled, the display will turn off after 30 seconds to
save battery power.

Allow logging stop with STOP button

If this option is enabled, the LogTag® can be stopped by pressing the

STOP button. The recorder will no longer take any readings, however

you can still review the day statistics and download the logged results
to a PC with LogTag® Analyzer.
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Allow reset of logger with START button

If this option is enabled, TRID30-7, TRED30-7 and TRED30-16R loggers
can be reset to the same conditions as if they had been freshly
configured by LogTag® Analyzer. You can then start another trip by
simply pressing the START button.

When this option is enabled, anyone with access to the
logger can erase all recorded readings and statistics without

saving the data to a PC first. Please use this option with
caution!

A warning box will be displayed to remind you this is enabled and can
result in loss of data.

Warning: Enabling the ‘reset with START button' option allows
the user to erase all recorded readings and statistics. Are you
sure you want to continue?

Show total summary days collected
If this option is enabled, the LogTag® shows the number of days for
which statistics have already been collected on the display.

Please refer to the LogTag® Product Specification & User Guide
documents for TRID30-7,TRED30-7 and TRED30-16R loggers on the
LogTag® Recorders website at http://logtagrecorders.com/products for a
detailed description of the functionality of these products.
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Note: When referring to TRID30-7 and TRED30-7 products,
versions with both the fixed (F-suffix) and replaceable (R-
suffix) battery are included, unless a suffix is specifically
mentioned.

Show alarm screens during review
This option only applies to the UTRID-16. If selected, up to 6 additional
screens are shown when reviewing the data on the display. These

screens show the temperature alarm threshold, and the time above or
below that threshold. If the box is cleared, only the minimum and
maximum screens are shown.

For more information please refer to the UTRID-16 PDF Recorder User
Guide, available from the LogTag® Recorders website.

Enable Quick start/stop if available

This option only applies to TRED30-16R models. If enabled, starting and
stopping a TRED30-16R is faster than that of TRID30-7 and TRED30-7.
Instead of holding the start button for 6 seconds (TRID30-7 and
TRED30-7), you will only need to press the button for approx. 1 second
until the unit starts or stops. For more detailed information please refer
to the TRED30-16R User Guide, available on the LogTag® Recorders
website at http://logtagrecorders.com.

If disabled, the standard start/stop method (6-second button press) is
used.

Show user resettable Min/Max (if supported)

This option only applies to newer TREL30-16 and TRED30-16R models.
These devices can display trip min/max settings in addition to the daily
min/max settings. If you enable this setting, these min/max settings
will be displayed when you review the day statistics. The min/max
values can be reset any time while the unit is logging. For more
information please refer to the Product User Guides for the relevant
products.

For UHADO-16, UTRED30-16 and UTRED30-Wifi models trip min/max
settings are permanently being shown on the display. If you enable this
setting, a user may reset the min/max values any time while the unit is
logging.
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Advanced USB Logger Settings

LogTag® Analyzer allows you to set additional options for USB loggers,
which decide:

« which type of files are generated at the end of the trip

. settings for time, temperature units, MKT parameters and

« how the individual elements of the generated PDF file will be
displayed.

Note: The appearance of the PDF file can only be defined
during configuration of the logger. It is not possible to alter the
appearance once the USB logger has completed its trip.

Additional tabs are displayed in the Parameter Pane:

Alarm Settings File Settings Advanced Settings

File settings

Generate data list Dat=lroamak (LTt sale ¥ As

(®) DOMMAY () 12-hour (am/pm) | | (®) Range of readings
[ show upper alarm line = . (C) Range of sensar
[ show lower alarm line (L) MM/DDAY (&) 24-hour O Minimum range

Show ¥ axis grid lines
W] show X axis grid lines
[] Show MKkT [83.144

[ Frioritise download over e generation

Files to generate: [v/| FDF [W/]LTD [ |csv

PDF temperature unit: | Celsius v UpperLimit; 18

KJ/maol PDF Time Zone: UTC <1200 v Lower Limit: = 0.0

Use local PC time zone (UTC =12:00)
PDF Brandname:

Alarm Settings | File Settings | Advanced Settings

Figure 42: File Settings tab for USB loggers

Generate Data List

The PDF file always contains a one page overview report. Please refer to
the individual USB Product guides for information about the contents of
the report.

Select this check box to show additional data list pages with a single
row for each reading, along with the with date, time and temperature
values, plus any special events that were recorded against this reading.

When you clear this box only the report summary page will be created.
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Show upper alarm line

Show lower alarm line

Select which alarm line will be displayed on the PDF. Clear the boxs if
you don't wish to see the alarm lines.

The chart will not automatically zoom to include the alarm
lines, if they lie outside the selected Y-axis scale. If you wish
to always see the alarm lines, set a custom range Y-axis zoom
which includes the alarm values.

Show Y-axis grid lines

Show X-axis grid lines
Select which grid line will be displayed on the PDF. Clear the boxes if
you don't wish to see the grid lines.

The position of the grid lines is automatically determined; it depends on
the Y-axis settings and the time span covered by the readings.

Show Mean Kinetic Temperature (MKT)

Selecting this box calculates and displays the MKT value on the PDF
report. If selected, you can accept the suggested default value of the
Activation Energy of 83.144 KJ/mol, or type a custom AH value in the
text entry field. This value is then used for the MKT calculations.
Typical values range from 60.000 to 100.000 KJ/mol.

When you use LogTag® Analyzer to download a USB logger, the custom
value can also be used for the MKT calculations in the software. This is
controlled by a setting in the customisation for the Mean Kinetic
Temperature (on page 120)

Prioritise Download over File Generation

When enabled, the logger attempts communication with LogTag®
Analyzer before generating on-board files. Please seePrioritising
Communication over File Download on page 53 for a more detailed
explanation of this feature.

Files to generate
Select either check box if you want the USB logger to automatically
create the corresponding file type every time it is plugged into a USB
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port. The files are then accessible on a read-only drive or mounted
device via your file system.

The files created by the USB logger are not automatically
copied to a permanent storage volume on your computer. If
you wish to retain the files you need to manually copy them to
a location such as your Documents folder.

If you clear all check boxes, no files will be generated and you will need
to access the data with LogTag® Analyzer.

Date format

Select one of the options that corresponds to the date format you wish
to use for the PDF report. You can choose between DD/MM/YY and
MM/DD/YY formats.

Time format

Select one of the options that corresponds to the time format you wish
to use for the PDF report. You can choose between 24 hour and 12 hour
(am/pm) formats.

PDF Temperature units

Select the temperature units used on the PDF report and in the CSV file
from the drop down list. For UTRID-16 loggers this also determines the
unit shown on display. It is not possible to configure different units for
PDF and Display.

PDF Time Zone

You can clear the Use local PC Time Zone box and choose a different
time zone. This is useful if you ship to receivers in a different time
zone and you wish them to see the times in their local time.

If you choose your own time zone settings you will need to adjust the
time zone for daylight saving yourself. For example, if you want the
PDF data to show the correct time for a user in New York, set the time
zone to UTC - 5 during Standard Time and to UTC - 4 during Daylight
Saving.
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Note: The time zone displayed in the PDF cannot be adjusted
by the receiver! To view the logger's data in other time zones
the receiver will need to download it with LogTag® Analyzer
and adjust the displayed time zone. See Date and Time Format
on page 165 for further details.

Use local PC Time Zone
When selected, the PDF file will display times and dates in your local
PC's time zone. The time is automatically adjusted for daylight saving.

Y-axis scaling
Select one of the available options to scale the temperature axis for the
chart of the recorded readings.

« Range of readings; this scales the chart area so the highest and
lowest temperatures recorded are displayed at the top and bottom of
the area. If you choose this option the maximum screen area is used
to display all recorded readings.

. Range of sensor; this scales the chart to show the full temperature
measurement range of the logger.

. Minimum range: When you select this option, the entry fields for
the two temperature values become active. Enter the values you
wish to use as maximum and minimum values for the chart's y-
axis. This is useful if you wish to easily compare readings from
multiple loggers in similar environments.

If readings outside your selected range are recorded during
the trip, the scaling is adjusted so the chart always displays
all recorded readings.

RH-axis scaling

For UHADO-16 loggers, two Y-axis scales are displayed, one for

temperature (left) and one for humidity (right). The scaling selection

made here affects the RH scale only, the temperature is adjusted to

suit.

« Range of readings; this scales the chart so the maximum and
minimum recorded humidity values are displayed at the top and
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bottom of the area. If you choose this option the maximum screen ( } } } )
area is used to display all recorded readings. Note: Newer USB loggers suppress file generation while

: N ® . . oriticing C .
« 0-100%; this scales the chart to show the full humidity range of the LogTag Argllrrers [ nlimioyg (s Emormsmg COmmUIMC.athp
logger over File Download on page 53). This speeds up communication

o° ] ) ] between software and logger and is particularly useful for
o Minimum range: When you select thls option, the entry fields fpr multi-trip loggers, as they can be re-configured quickly
the two humidity values become active. Enter the values you wish to without having to wait for all files to be generated. If you wish
use as maximum and minimum values for the chart's RH-axis. This

, , , ; , _ to access the files on the device itself please close LogTag®
is useful if you wish to easily compare readings from multiple Analyzer and wait for the drive letter to appear.

loggers in similar environments. \ Y

If readings outside your selected range are recorded during
the trip, the scaling is adjusted so the chart always displays
all recorded readings.

USB Loggers
There is a short delay after a USB logger is plugged in, before it can be
accessed by LogTag® Analyzer. This has two causes:

« As soon as the USB logger is plugged in, it generates any files it has
been configured for. This process is skipped for units that are
factory-new, as there are no files to generate, however with
subsequent configuration for multi-use devices this process can take
some time, especially if the unit has a full memory buffer and has
been configured to create PDF, CSV and LTD files. While the files are
being generated, the green LED is permanently lit.

. After file generation is complete, the logger starts a registration
process with the operating system called USB Device Enumeration. It
will take a few seconds while the operating system loads the
required drivers. When this process is complete, the green LED
blinks.

LogTag® Analyzer can only detect and communicate with the USB
logger once all files are generated and it has completed USB
enumeration (see note below).
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Multi-Alarms in USB Loggers

USB loggers can be configured for up to 6 different alarm trigger
conditions, depending on the model.

All USB loggers have a primary upper and a primary lower alarm.

USRIC-8, UTRIX-16, UTRED30-Wifi and UTRED30-16 allow four freely
configurable alarms in addition to the primary upper and lower
alarms, for a total of 6 temperature alarms.

UTRID-16 allows two upper and two lower alarms in addition to the
primary upper and lower alarms, for a total of 6 temperature
alarms.

UHADO-16 allows two freely configurable temperature alarms in
addition to the primary upper and lower alarms, for a total of 4
temperature alarms. It allows a single primary upper and lower
humidity alarm, but each alarm can be configured with different,
independent delay values.

Initially, start with the primary upper and lower alarms trigger
conditions and activate additional conditions separately. For each
threshold value you enable, you can set the usual values such as
threshold temperature, activation type and alarm delay value.

You need to observe some basic rules when entering alarm conditions
into the configuration screen in LogTag® Analyzer:

A primary upper alarm must be entered before more upper alarms
can be entered.

A primary lower alarm must be entered before more lower alarms
can be entered.

Any additional upper alarms must have higher threshold values
than any previously entered alarm.

Any additional lower alarms must have lower threshold values than
any previously entered alarm.

You can enter a different number of upper and lower conditions, or
only upper, or only lower conditions, or none at all. You can,
however, not make all alarms upper alarms, and you cannot make
all alarms lower alarms either.

LogTag Analyzer User Guide

Temperature

Upper threshold Alarm 6

Primary upper threshold

Primary lower threshold

Lower threshold Alarm 3

Figure 43: Alarm ranges for USRIC-8M

Fourth Upper Alarm (6)
Third Upper Alarm (5)
Second Upper Alarm (5)
Upper
PrimaryLower Alam
Second Lower Alarmm (3)

Lower
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Primary upper alarm range

Non-alarm range

Primary lower alarm range

30.0

V[ 15.0
V| |10.0
v (8.0

V|20
0.0

AR AR AF[4p

A[4r

A A A A

a

After |:| 2 % Accumulative v

After ! & ¥ | | Accumulative v | violation readings (30 Minutes)
After 12z ¥ | | Accumulative ¥ | violation readings (1 Hour)
After 12 7 | | Consecutive ¥ | violation readings (1 Hour)
After 12z ¥ | | Consecutive ¥ | violation readings (1 Hour)
After |:| 2 &  Accumulative v

Figure 44: Representation in LogTag® Analyzer
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« Threshold values for adjacent alarms can be equal and combined
with different alarm types and delay time values. For example, you
can enter a primary upper alarm with an 8°C threshold and 10
accumulative readings, plus an alarm with an 8°C threshold and 5
consecutive readings. In this instance the alam will be triggered, if
either 10 readings in total are above 8°C, or 5 consecutive readings
above 8°C have occurred.

Any alarm condition that is activated will be shown on the PDF and in
the software.

USRIC-8M and UTRIX-16M models

For a short period in 2017, USRIC-8 and UTRIX-16 models with multiple
alarm threshold values were sold with the suffix M after the model
name, i.e. USRIC-8M and UTRIX-16M. Effective November 2017 this
suffix has been dropped from the model designation, and USRIC-8
(from serial number 5035127752) and UTRIX-16 (from serial number
5040022407) now support multiple alarm threshold values. Models
without the M suffix delivered before this date only allow simple alarm
settings with one upper and one lower alarm (they can also not be
upgraded).

If you are configuring earlier USRIC-8 and UTRIX-16 models
that do not support multiple alarm thresholds you will not be
able to select the (Advanced Alarm Settings )

For any loggers that do not support the advanced alarm

settings, only primary upper and lower alarms will be set. The
remaining alarms will be disregarded.
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Figure 45: Entry line for alarm trigger conditions
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For the UTRID-16 a slightly different screen is shown. Here, the alarm
symbols that appear on the LCD are depicted next to the entries in the
software. The rules above are the same with one notable addition, that
a maximum of three upper and three lower alarm conditions can be
entered.

LogTag Analyzer User Guide

Temperature

Tertiary upper alarm range

Secondary upper alarm range
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Primary upper threshold

Primary lower threshold

Tertiary lower threshold

Figure 47: Alarm ranges for UTRID-16

TertiaryUpper Alam i‘
SecondaryUpper Alam 4 A
PrimaryUpper Alarm A
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SecondaryLowerAlam ' W
TertiaryLower Alam  § W

Figure 48: Representation for UTRID-16
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Wireless Connection Parameters

When configuring a logger with built-in wireless capability such as the UTRED30-Wifi an
additional tab is available, allowing you to enter the connection details for your Wireless
Network (WLAN).

You have the option to leave the settings unchanged. This is the default setting when you
configure the device.

When you configure a device for the first time you will need to enter details here. Ex-
factory units do not come with any pre-entered wireless connection data.

If you do want to change the settings, you will need the following details to connect to your
WLAN:

o SSID (Service Set IDentifier) or Network Name
This is the identification of the wireless network you wish to connect to. You can select one

of the broadcast Network Names from the list of available networks, or enter an SSID from a

hidden network. This is required if you intend to deploy the device at a location with a
different WLAN.

« Network Security Key

This is sometimes also called the Pre-Shared Key (PSK), Passphrase or simply the Network
Password. You need this password so the wireless network will allow the device to connect.

« Dynamic (DHCP) or Static IP
If the WLAN has a DHCP server, enable DHCP.

If necessary your IT Network Administrator can advise you of these settings.

Scanning the network

To connect to a wireless network in range simply select the network from the list of available
networks.

If the network is not in range you will need to specify the SSID manually.
Select SSID > Enable DHCP
Enter S5ID  Wi-Fi_MNetwork_1

Wifi Password | “ttet

Select SSID  Leave Wi settings unchanged L

Alarm Settings  File Settings  Advanced Settings | Wi Settings

Figure 49: WiFi Settings tab

Leave Wifi settings unchanged

[#] Erable DHCR

Leave Wifi settings unchanged

Wi-Fi_Network_1
Wi-Fi_Network 2
Test_Metwork

Figure 50: Available wireless networks
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When you have selected the network, enter the network password.

Please note that LogTag® Analyzer does not check the validity of the password. Please
ensure that the correct password is entered.

Specifying a DHCP server

In most networks a DHCP server will allocate all the details required for networked products to
connect to the internet. If your network does not have a DHCP server, clear the Enable DHCP
check box.

You can now enter individual network settings such as
o Static network IP address

o Subnet Mask

o Gateway IP address

o DNS server address

Using the LogTag® Online Connection Wizard

If the LogTag® Online Connection wizard is available on your PC, the WiFi settings tab will look
different.

You can still choose to leave the WiFi and Network settings unchanged.

If you need to enter new settings, or amend existing settings, you can choose to start the
LogTag® Online Connection Wizard once the logger has been successfully configured for

logging.

The LogTag® Online Connection Wizard is a separate program that

« allows configuration of wireless and network parameters of your WiFi enabled loggers

« allows configuration of wireless and network parameters of your WiFi enabled interfaces

« enables you to create an account with LogTag® Online (or sign in if you already have an
account)

. helps you register wireless devices against your account

You can find more information about the LogTag® Online Connection Wizard in its online help
at http://help.logtagrecorders.com/LTOWizard/.
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[[] Enable DHCP
IP Address: | 192 168 100 20
Subnet Mask: (255 | (2558 | |255 | |0
Gateway: 192 | 168 | |100 1

pns: [192 | [188 |[100 |[1

Figure 51: Entering network connection settings

(@) Leavewirelessand network settings uncranged

Startthe LogTag Oniins connectionwizard 10 enter naw satings

Alarm Settings  File Settings  Advanced Settings | Wifi Settings

Figure 52: WiFi Setting tab when the connection wizard is present
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Using the LogTag® Access Wizard
You can use the LogTag®Access Wizard by either clicking the toolbar icon (as shown) or by
selecting Wizard from the LogTag menu.
The LogTag® Access Wizard performs following tasks:
1. All connected interface cradles and USB ports are checked for attached LogTag® products.
If any of them contain previously recorded data these are downloaded and saved.
2. The configuration window is displayed.

The Wizard performs the functions Downloading and Configuring in sequence, so you do not
lose any data.

Note: While the wizard is visible the Automatic download feature will be temporarily
disabled. You will also not be able to access the Wizards while an automatic download
is in progress.

When the wizard completes, you can click |Restart Wizard |, and the process will start from the
beginning.

Quickly re-configuring a LogTag®

You can configure a LogTag® logger without first displaying the configuration screen. To do
this, you can click Quick Re-Configure from the LogTag menu, and you will see the Upload
configuration screen, where a recorder will simply be re-configured with the settings used for
the previous trip.

You can also press the F6 function key.

There are certain rules when using this function:

« You can use multiple interfaces. Each LogTag® detected in an interface is re-configured with
the same data used for its previous trip. Loggers do not have to be of the same model, and
can each have different configuration settings.

« Re-configuration is only possible for loggers which used the "Push button" or the "Push
button from hibernation" start method for their previous trip. If the recorder's previous trip
was started by the date/time start method the quick re-configure option will result in an
error message being displayed.

. If a logger requires a password for configuration you will be requested to provide this
password. If you enter an incorrect password, the configuration process will be aborted.

Ll

Wizard

Figure 53: LogTag Access Wizard from toolbar

|E@ Configure 3
I@ Download F4
[il_ Hibernate F5
igj Quick Re-configure F&
r;l Profiles 7§
=

Wizard 2
[ "

Figure 54: LogTag Access Wizard from menu

[F@ Configure F3
F\@ Cownload F4

@ Hibernate F5 -

@ Quick Re-configure F&

Q Profiles [}H
@ Wizard F2

Figure 55: LogTag® quick-reconfigure function
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« If the LogTag® is still logging when you reconfigure it, you will be asked to confirm whether
or not you wish to stop the current trip.

Automatic Re-Configuration after Download

To process loggers even faster, you can set-up an option to re-configure a logger with the same
settings after it has been downloaded by using the automatic download option.

This feature is set up in the Automation section of the general options by selecting Re-
configure with same settings after automatic download.

Once enabled, a LogTag® is automatically downloaded once inserted in the interface cradle, and
immediately re-configured for logging, using the same settings as for the trip just completed.
You will receive a confirmation once the configuration is complete.

If the logger is still logging during download, you also need to acknowledge that it must stop
recording before a re-configuration can proceed.

Please note this option only works when a LogTag® is automatically downloaded when inserted
into the interface, i.e. the "Enable automatic download of readings from LogTags" option must
be enabled, and the download triggered by inserting the logger into the interface. This does not
apply when the LogTag® is downloaded through the menu of by pressing F4.

A If the LogTag® you have downloaded does not have a configuration password and has
also finished logging, the only visual feedback on the PC will be after the logger has
already been re-configured for a new trip. You will only be able to access the data from

the trip just downloaded on the PC, but not within the recorder. Therefore, if the file
location for storing data is not accessible at the time of downloading, the re-
configuration will not proceed..

Continuous operation

All LogTag® products have a limited amount of memory to store the readings they record. When
selecting the option to Record readings continuously, the LogTag® will not stop once the
memory is full; instead it will replace the oldest reading stored with the newest reading.

Not every model supports continuous operation. If you configure a LogTag® and you cannot
select this option, your model does not support this feature.
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Pre-start data collection

LogTag® products support a feature called pre-start logging, which can be selected during
configuration.

When pre-start logging is enabled, the LogTag® will automatically start recording as soon as
configuration is completed. It will record at the same sampling interval as defined in the
configuration and will continue to record until the user starts the LogTag® by pressing the
START/MARK button. Once the LogTag® has been started, it will record started readings as per
the configuration settings. While the LogTag® is recording pre-start readings the Alert LED will
not activate, even if an alert condition is present.

Pre-start logging is useful as a fail-safe recording setting so if the LogTag® is not started at the
appropriate time, the readings will still be available to view later.

When the readings are retrieved from the LogTag®, any pre-start readings will be separately
displayed, so the user can quickly identify the readings recorded before and after the LogTag®
was started.

All LogTag®s have a finite amount of memory to store the readings they records. Therefore,
while the LogTag® is recording pre-start readings the LogTag® will operate in its 'continuous
operation' mode, which is explained further in the section Continuous operation on the
previous page. Once the memory within the LogTag® is full, the oldest pre-start reading will be
overwritten with the latest pre-start reading, or the latest started reading if the logger has been
started.

Once started, the logger will first fill any remaining memory, then overwrite the oldest pre-
start readings until the complete memory is filled with started readings.

If a LogTag® has been configured to start recording at a certain date/time, or for push button
start from hibernation, no pre-start readings will be recorded.

Restricting Access

You can enable a password protection feature, which requires any user to enter the correct
password when they next configure the LogTag® for recording. This prevents a user from
accidentally erasing data

During configuration, select Configure requires a password. A password entry field appears,
where you can enter a password.

A confirmation of this password is required.

Password:

[ ]configure reguires a password
= :
|| Download requires a password

Figure 57: Password entry
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Tip: Sometimes users tick the password required box, but don't enter a password. Such
a "blank" password is valid, hence the password request dialogue will appear when re-
configuring such a unit. In this case simply selecting will advance to the next
screen. A warning message will inform you when you are using a blank password.

Protecting Recorded Data

Not only can you protect a logger's configuration; most models can also be set up so they
require a password before you can access recorded data. This function can be enabled in the
main configuration screen by selecting Download requires password. The same password is used
to protect configuration and download.

The features can be used independently. You can use a download password without a
configuration password, and vice versa, or use both passwords, or none.

Password Rules

The password can be up to 6 characters long (16 characters for USB loggers) and can contain a
mix of letters, numbers and special characters. The selected input language of the computer's
operating system determines which special characters can be selected.

If a user decides to make use of special characters, extra information about the language used
is stored inside the recorder. Users will then need LogTag® Analyzer 2.3 Release 7 or later so the
password is correctly interpreted.

This feature is not available in USB loggers.

If you use special characters for languages such as Japanese or Chinese the maximum number
of characters that can be used will be reduced due to the increased memory required to store
the characters.

Please see Code Pages on page 178 for a more detailed explanation.
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Verify Access Password

If the Configure requires a password option was enabled or the password was changed during
the configuration process the user is required to verify the password before it will be stored in
the LogTag®. A window similar to this will appear:

Once a password has been stored in the LogTag®, it can only be accessed by providing the
correct password. Therefore, if you forget the password you will no longer be able to access the
LogTag® Passwords are case sensitive - the passwords "Bob" and "bob", for example, are
different.

Hibernation - Prolonging battery life

If your LogTag® is not going to be used for extended periods of time you should hibernate it.
While in Hibernation the LogTag® will consume minimal power, which will extend the battery
life when compared with leaving an idle LogTag® operating.

While a LogTag® is hibernated it will...
not record and store any new readings.
not activate the Alert and OK lights.
not respond to the START/MARK button being pressed.

The only exception is when the LogTag® has been configured for Push button start from
hibernation in the configuration screen. In this case pressing the START/MARK button will
'wake' the product and commence logging according to the configured settings. Not every
model supports this feature.

To 'wake' a hibernated LogTag®, go through the usual process of Configuring a LogTag® for
recording (on page 45).

To hibernate a LogTag®, select Hibernate... from the LogTag menu.

You can also use the F5 function key.

The password for the LogTag(s) has

changed. Please verify the new
password to be used.

Description:  Password Update
Password:

@D o Q) cocel @ nev

Figure 58: Password confirmation

[ conigue F3
[ pownioaa F4
Iiz Hibernate ]
[@j Quick Re-configure® ~ F6
[ ) Profiles F7

@ Wizard F2

Figure 59: Hibernating a logger
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You will see the window one on the right when hibernating a logger.
One of the following icons will show next to each of the items in the list:
« (no picture) indicates the LogTag® is still in the process of being hibernated.

« ¥ The LogTag® was successfully set to hibernation.
. X The software was unable to set the LogTag® to hibernation.

Once a LogTag® has been successfully hibernated it should be removed from the Interface
Cradle before pressing any other button. As soon as the software communicates with a
hibernated LogTag® (for example through automatic download) it will be returned to normal
operation.

The extent to which Hibernation will prolong the battery life of a LogTag® varies between
different models and versions of LogTag® products. Some LogTag® models do not support
Hibernation.

Starting and using the LogTag®

Once a LogTag® has been successfully configured, it must be started to take readings.

A logger can start automatically at a date and time set during configuration, or manually by
pressing the START button on the logger.

The different start methods are explained in more detail in the section about Configuration
Parameters.

For exact procedures how to start a logger or indicator product please refer to the individual

Product User Guides and Quickstart Guides, available for download from the product web pages

at http://logtagrecorders.com.

a

|

UsE
USE
USB
use
USB
UsB
use

G Again

-
Location

The software will locate the LogTag products for you and set them to
Hibernate mode. Please do not remove LogTagi(s) or disconnect
interface(s) during this process.

Only LogTagi(s) with a tick has(have) been hibernated.

Interface Model LogTag ID
tHID 5034000005
LTI/HID 5999000002
LTI/HID 5040000036
LTHID 5040000030
LTI/USB OOFEOFD6 Not found
LTYHID 5040000038
LTIYUSB 03101C06 1060026140

0 Close
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Configuration Profiles

To simplify the task of configuring multiple loggers with the same
parameters, you can store the settings you would enter during
configuration (such as alert limits, logging interval, number of
readings etc...) in a Configuration Profile, then use the profile to
configure loggers as required.

Configuring a logger with a pre-defined profile requires only three
steps:

1. Select Profiles from the LogTag menu
The window now displayed gives you an overview of the profiles
already installed. You can also add new profiles or edit and delete
existing ones.

2. Select the profile you wish to use in the Configuration Profiles
main window

3. Click on Configure loggers

The next few pages detail the steps required to add and manage
configuration profiles.

LogTag Analyzer User Guide

Configure F3
p@ Download M
@ Hibernate F5
[% Quick Re-configure F&
a ;4' Profiles F7
B Wizard F2
Figure 61: LogTag Profile Menu
[ —r— =
Db e o e b1 coribgure: bnxgers with the swlie sefirgs
— e |
- =
(] s.-.---; | 0 comea L

Profile Path &
Filename

Profile Control
Buttans

Frofile File
Controls

Figure 62: Configuration Profiles Main Window
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Profiles Grid

When you first select this feature the profiles grid will be empty. You will fill the grid by adding Name Model Attributes =
profiles, or importing profiles. Trix Profile TRINTREX R/
Profiles from the grid can then be used to configure loggers. A single click on the column title Haxo Profile RAX0 R

will sort the profile using this column. Double-clicking on a profile will configure all loggers UTRID UTRID Rl

currently in connected interfaces using the parameters stored in the configuration profile. You
can select multiple profiles for export or deletion when you hold down the CTRL key while
clicking, but you cannot edit or apply more than one profile at the same time.

11

1|

Figure 63: Profiles in the profile grid

Profile Control Buttons

Clicking on a profile row and clicking [ Configure LogTags) will configure all loggers currently

attached, using the parameters stored in the profile (you can also do this by simply double- ot one -
clicking the profile name). =

To be configured, loggers must have the same model name as in the profile.
Use the control buttons to add new profiles and to edit or delete existing profiles.

Clickingwill bring up the Edit Profile window without any parameters. Type a Profile
Name into the text entry field and select a Model from the list.

Once you have selected a model, the configuration parameters for this model appear. They are
the same parameters as already described in Configuring a LogTag® for recording on page 45

@

Figure 64: New profile window
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The same window will be displayed when you click. Every entry field is now populated with
the saved value for this profile. Any entry field can be edited, with the exception of the model
type and the profile name.

Click to store the profile in the Profile file, to discard any changes and to
display the help screen for this window.

Profile Storage File Name and Path

The collection of profiles displayed in the profiles grid is saved in a single file on your PC, which
is called the Profile File. This file is typically stored in a folder called LogTag Configuration
Profiles inside the My LogTag Documents folder. Every time you open LogTag® Analyzer this
profile file is activated.

You can select alternative collections by opening different files. This can be useful if for
example you want to keep different profiles for different customers, or you prefer to separate
and organise your profile collections.

You can click on the [ button and select a different profile file. If you have unsaved changes
you will be asked to confirm if you want to first save these changes. An explorer window will
then open, where you can select a new profile file.

Note: To create a new profile file, export one or more profiles to a new profile file. You can
then open the new profile file and add, edit or delete profiles as usual. Alternatively, you can
download an empty profile file template from
http://logtagrecorders.com/download/software/analyzer/Blank_Profile.ltp.

Profile File Controls

If you have stored your profiles in different profile files, you can transfer data between
different files with the (Import] and (Export] buttons.

When you click on the button, a file explorer window will open. Browse to the profile
file from which you want to import the profiles and confirm your selection by clicking (Open)
All profiles from the selected profile file will be imported into the currently active profile. If a
profile is imported that has the same name as an already active profile, you need to confirm
whether you wish to skip the import of this profile or overwrite the active profile with the
imported profile.

You can export selected profiles to a new file by highlighting a profile and clicking [Export] A
file explorer window will open, where you can enter a new profile file name (the file will be
created when you click, or overwrite an existing profile. If a profile is exported, and a
profile file already exists, you need to confirm whether you wish to cancel the export of this
profile or overwrite the profile file. You can export more than one file at the same time by
selecting the desired files while holding down the CTRL key.
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Profile Name  Trix Profile
Model TRIX_TREX

User Information
Description:

|| povinioad req

Logging Parameters
Push button start v | [ |Enablep

(®) Record readings 5o that:

Number of reading

[JEnable the OK (Green) indicator
Enable the Alert [Red) indicator, when:

After |2 =

consecutive alert readings (None)

Temperature Alarm Settings | Advanced Alarm Settings

Q =

|| configure reguires a password

() Record readings continuously, overvirite oldest when memory full

Readings recorded will span at least |26

Record a reading every |00:05:00
Begin recording after a delay of |00:00:00

[ Leave alert indicator enabled even if readings return to non-alert range

v

uires a password

re-start logging

Days

s to record 7500 maximum is 16159

= | 5Minutes
*  None

Readings abowe[ | |70.0 «c

ar||4r

Readings below| | |-20.0 c

After 2 =

alert readings have occurred (None)

© e @

Figure 65: Editing a TRIX-8 profile

Configuration profile TRIX a
Do you want to replace it?

Iready exists.

Figure 66: Prompt when overwriting an existing Profile
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You cannot amend a profile file by exporting a profile to it. Exporting a profile will
always overwrite the target profile file.

Profile Dialogue Controls

Clicking will store the profile in the location entered above. Clicking will
discard any changes and return you to the main window.

Please note there are some restrictions when you work with configuration profiles:

Configuration profiles cannot use the date/time start mechanism. If a defined start time
were to be applied to a profile, this time would most likely have passed by the time the
profile is applied. If you need to configure a number of loggers and you want them all to
start at the same time you should use the standard configuration method and the
function.

You cannot configure one type of logger model with a profile written for another model.
You cannot have multiple profiles with the same name.

If you have exported a profile to a profile file, cancelling the main edit window will not undo
the changes.

If you try to apply a profile to a recorder with a password protected configuration, this same
password must be provided in the profile. There is no separate password confirmation
dialogue.

Loggers that can be upgraded to use a download password will automatically be upgraded
when a profile is applied using this feature.
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Sometimes a logger cannot be configured using a particular profile. In this case one of the
following errors will be displayed:

Message

"Logger does not
support advanced
alert settings"

"Logger cannot
record more than
X readings"

"Password in
profile does not
match logger
password"

"A password
cannot be applied
to this logger"

"Logger only
supports latched
master alarm"

"Profile logger
type does not
match"

"Lease expired.
The max. number
of starts has been
reached."

Table 13: Profile error messages
What it means

You have selected a profile which has separate upper and lower alert settings, but
the logger you wish to configure does not support this. You will need to use a
different profile, or use a different logger if this feature is important for this trip.

You have selected a profile that requires the logger to take more readings than fit
into its memory. You will need to use a different profile, or use a different loggerif
this feature is important for this trip.

You have selected a profile with a password, and the password currently stored in
the logger is different. You will need to use the normal configuration process to
remove the password; after that you can use the profile function to configure the
logger with the new password. If the logger does not allow the password to be
changed, you will need to use a different profile.

You have selected a profile with a password, but the logger is factory configured so
the user cannot change or enter a password. You will need to use a different profile
that doesn't have a password protection, or use a different logger if this feature is
important for this trip.

Loggers typically can have a setting applied that allows an alarm to reset if
conditions go back to within specification. Some older TRID30-7 loggers do not
support this feature, and if you attempt to configure such a logger with a profile
using this setting you will see this error. You will need to use a different profile or
use a later model TRID30-7 if this feature is important for this trip.

You are trying to configure a unit with a profile that was created for another model.
A profile is specific to a logger model, so you will need to use a different profile.

You are trying to configure a unit which has no more trips left. You will need to use
a different logger.
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Printing Calibration Certificates

Starting with version 3.1.6, you can view and print a logger's factory
calibration certificate directly from LogTag® Analyzer.

You can access the certificate:

« by clicking [Show Certificate | from the report tab after the logger was

downloaded
« by clicking (Certificate of Calibration] during configuration of the logger

The certificate issue date is the date the logger was first configured.

You can also access the factory calibration certificate from the report
tab when opening a saved data file, provided the recorded data are
from the period during which the certificate was still valid.

You will not be able to access the certificate:

« before the logger is configured for the first time. You will not be
able to click until the configuration is uploaded
successfully to the logger

. after the logger was adjusted by a third-party calibration laboratory
using LogTag® Calibrate

. if the logger is configured after the factory calibration certificate
has expired

. if a logger was manufactured before 1. April 2019
« for indicator products
. on a multi-chart report

If a logger was first configured with a version of LogTag®
Analyzer prior to 3.1r6 you may still be able to view the
calibration certificate. Please note, however, that the
certificate date may differ from that on the certificate issued
by your distributor. In this case, the distributor issued
certificate is correct.

LogTag Analyzer User Guide

|71 certifcate et catsration —oi—
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LogTag Recorders

PO/Box 16-295, Northcote, Aucklznd 0748, New Zealand tel «549 950 4828

CERTIFICATE OF CALIBRATION

Cenificate No: UTREDSA-WIFI-ADA1000053RS
LogTag Temperature Recorder
Medel number: UTRED30-WFI

Serial number: A0A1000059RS

LogTag Recorcers Lta hereby cerifies that the product referenced above by Model numser
and Serial number has been tested and calibrated guring manufaciure in accordance with
LogTag approved procedures, and Ihe product meets (ke published spedfications

Reference Instruments:-

- Hioki Digial Multimeter Model DT4282, Semal¥ 161107506

«  Dostmann Elecronic Thermometer Model P795, Serials 79513030203

Instrument calibrations are traceable 1o the L of
New Zealand (accredited to ISOAEC 17025) and 12 the Intemational System of Metric
Units, which is equivalent to NIST.

This certificate is issued by: LOGTAG RECORDERS LIMITED

Dated: 40712019

sones: (O~

LogTag Fest e Lk

Figure 67: Factory Calibration Certificate
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Results from LogTag® Loggers

Once a LogTag® has finished its trip, you can
« download the data to a PC
This section explains this in more detail.
. view and analyse the information
Read about this in the section Analyzing the results on page 88
. print the information or save it to other formats.
You can find details in Printing the results on page 117

LogTag® products store all recorded data in their internal, non-volatile memory. You can
download the data as many times as you want, as long as the logger is not re-configured or
hibernated.

When you download the data, a file is automatically created in a pre-defined folder. Typically
this is the C:\Users\User\Documents\My LogTag Documents folder, but you can customise this
location to your requirements File and Folder Settings (as described on page 154).

Downloading data stored in a LogTag® does not erase the data from memory, however if you
have enabled the "Automatically re-configure..." option you will no longer be able to access the
data in the logger once this process has started.

If the LogTag® is currently recording while you retrieve the information, it will continue to
record without interruption. If the logger is in the process of taking a log you may see a slightly
longer download time as communication pauses to allow the log to be taken.

There are three ways to retrieve the recorded results from a LogTag®:
« Vvia automatic download

Slot the LogTag® into the interface cradle, or plug it into a USB port while the LogTag®
Analyzer software is running (even when minimized). If the automatic download feature is
enabled, the software will automatically retrieve the recorded readings, save the information
to your disk drive and display the information. While the software is retrieving the readings
you will see an animation. A new animationm will be displayed for every new logger
attached.

You can also enable the option to automatically re-configure the LogTag® with its current
settings (see Automatic Re-Configuration after Download on page 69).

page 80

o A new LogTag has been detected in the interface. Please
wait while its readings are downloaded,
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Figure 68: Downloading a LogTag® automatically
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« via the menu system
Click Download from the LogTag menu.
You can also press the F4 function key.
« Using the Wizard
Click the LogTag® icon on the toolbar or click on Wizard from the LogTag menu.

The wizard retrieves the readings stored in the LogTag® and then offers to configure the
LogTag® for its next trip.

Progress Pane

When you initiate the download manually, rather than using the auto-download feature, the
LogTag Download window will be displayed. Each logger found will be listed in the Progress
pane, much the same as in the Configuration Window.

When you see this icon displayed, communication was established, but no data were
downloaded. The most likely cause is that there are no readings in the logger.
@ When you see this icon, no logger was found in the attached interface.
f] Data from this logger was downloaded, but the logger has has a low battery. It should not
_ be used for another trip

This icon is displayed after the logger has been successfully downloaded and the data

fF]@ saved.

The progress bar will also show the word Downloaded

f] This icon is displayed after an unsuccessful attempt to download the logger. Further error
_® messages will be displayed to indicate why the logger was not downloaded.

When the logger has completed its trip and you wish to see the recorded readings, place the
LogTag® into the Interface Cradle.

@ Quick Re-configure

:;4' Profiles
Wizard

Figure 69: Download Menu
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Figure 70: Wizard Toolbar Icon
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Figure 71: Progress Pane when downloading data
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If the LogTag® is still recording it will continue to do so. A USB logger, however, will not record
temperatures while plugged in; instead it will record Paused readings.

The software will automatically download any readings and save them in a file.

Once the readings have been successfully downloaded, the software will display the
information. The chapter Results from LogTag® Loggers on page 80 explains in more detail
what information is displayed and how you can influence its appearance.

Your LogTag® may now also be reconfigured for another trip with the same settings as before,
if you have this option activated (see Reconfigure with same settings after automatic download
on page 143.)
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Figure 72: Downloading a LogTag®logger
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LogTag® Data files

Every time you download a LogTag® Logger to your computer the data are automatically saved to a file with a

* 1tdx file extension (LogTag® Data Extended). This file is then opened, and presented to you on screen. When you
download a LogTag® product, and view the data, you are therefore viewing the file that was saved when the
LogTag® was downloaded.

The *.1tdx file is unique to LogTag® products and can only be read by LogTag® Analyzer software.

You can customise a number of options for this file in the Edit - Options window:

« You can define the file's name, for example by specifying details about the logger from which the data were
downloaded (File Name on page 155)

« You can decide if existing files with older data should be overwritten or kept (Uniqueness on page 160)

« You can automatically have files sent to email recipients and FTIP sites (Automation on page 143)

« You can decide which additional other file formats are created, for example PDF files (Exports and Reports on
page 162)

You can also combine data from multiple files as on page 86.

Please refer to the respective sections in this user guide for more information.

Note: If the logger you are downloading has not taken any readings, a message such as the one one on
the right will be displayed.

Digital signatures

Support for digital signatures is primarily provided for compliance with the US FDA 21 CFR Part 11 regulation -
Electronic records and electronic signatures. Various industries, however, may find inclusion of digital signatures
beneficial towards their quality control and assurance systems.

Digital signatures allow users to record an event in a LogTag® Analyzer file along with their digital signature. To
add digital signatures to data files, LogTag® Analyzer must be connected to the LogTag® User Server software. For
more information how to connect see User Server on page 169, or contact your local network administrator.

To add a signature to a file, open the file it and click on Signatures located on the toolbar, which will display the
File Properties window with the Digital Signatures tab already activated.

Then click New to start adding a digital signature.

Once the Add Digital Signature dialog box appears, enter your LogTag® Analyzer user password and select the
meaning for the digital signature that is being added.

Click to permanently add the digital signature to the file or o abort. Multiple digital signatures from
the same or different users can be added to a single LogTag® Analyzer file.
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How secure is my data
LogTag® files are encrypted and contain checks to detect if the file changed since it was originally created. If the
software detects that a file has been tampered with, or has become corrupted, the software will not open the file.

LogTag® devices will also insert error detection codes automatically during recordings, which are used to detect
data errors. When these detection codes for a block of recordings fail the integrity validation, the relevant readings
are marked as non validated readings. Non validated readings are displayed differently to validated readings to
indicate that they have failed their integrity test.

Non validated recordings typically occur in the scenarios following scenarios:

1. One or more readings in the non validated block of readings is not the genuine recorded value.

2. A communications or hardware failure has occurred during the transfer of the data from the LogTag® to the
computer. Try downloading the recordings from the LogTag® again; make sure the contacts on the back of
the LogTag® are clean, the contact pins in the Interface Cradle slot are clean and return evenly to their
normal position when the LogTag® is removed.

Since the software does not modify any of the recorded data within a LogTag® file at any time, if the software can
open the file, regardless of how long ago it was created, the contents of the file will still represent the original
recorded information retrieved from the LogTag®.

Therefore, the files created by the LogTag® Analyzer software meet all criteria for data integrity and data security
as set forth in the US FDA 21 CFR Part 11 regulations. The firmware code that is embedded in the processor chip of
each LogTag® cannot be extracted or reverse-assembled. Accordingly, data sets that are recorded in the memory of
the LogTag® cannot be downloaded or modified except by being transferred to a LogTag® file. There is no way to
interfere with the process of the transfer of information between the LogTag® and the software in such a way that
data integrity would be compromised.
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Viewing file properties

The file properties window provides users with a summary of the key
properties of the data included in the file, such as model ID and serial
number, alert range and range of readings, start time end time and
total number of readings as well as the battery status. If the LogTag®
has a limited number of trips left, this is also indicated here.

The file properties window is accessed by clicking on Properties in the
File Menu or via the toolbar command.

LogTag Analyzer User Guide

EHZI Send
Upload

[‘LD Properties
B

Digital Signatures

Select Recent File 3

0 Exit

Figure 75: File properties Menu

Summary | Digital Signatures  Activities

LogTag ID

|TU10030254

Model ID

Description

Number of started readings
First reading
Last reading

Readings range

Data originally acquired

HAXO-8

2616

12/16/2016 12:16:14 AM

12/16/2016 10:03:44 PM

400 to 850 °C 00 to 1000 *RH

228 to 270 °C 39.6 to 571 %RH

12/16/2016 9:03:21 AM

Figure 76: File properties
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Saving a Multi Chart file

If the main LogTag® Analyzer window currently displays a Multi Chart (see Combining charts onto a single chart), you can save it by clicking & on
the toolbar or selecting Save from the File menu. Select a file name and location for your Multi Chart file. The file extension for Multi Chart files is

* multix.
A Multi Chart file contains a copy of each individual file that makes up the chart along with any zoom settings, annotations and the information that
describes which relation the data files have to each other.

To open a previously saved Multi Chart configuration file, click on the £ toolbar icon or select Open from the File menu , then select the "* multix"
file to be opened. To save a Multi Chart file under a different name, select the Save As command from the File menu and enter a new file name.

[ You can save a Multi Chart file as a PDF, but not as any of the other export file types. ]

LogTag® indicator products such as the TICT or TIC20 do not have date/time related readings and therefore do not appear on a Multi-Chart.

Selected LogTag® Data files (*.sltd)

The file type *.sltd is a legacy file type, which you can open with this version of LogTag® Analyzer. In this file LogTag® Analyzer version 2.X allowed
you saving data zoomed to a particular time window. When opening a *.sltd file, LogTag® Analyzer version 3.X will extract the data for the complete
trip and present the data zoomed to the time window stored in the file.

Since the new * 1tdx format has this function built in, the support for saving this file type has been discontinued.
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Calling up previous results

To open a stored file, click the Open toolbar icon or click Open... from the File menu. This will
display the Open file dialogue.

Browse to any location accessible by the Windows® Operating System, including network and
ftp locations. Select the desired file and click. Please refer to your operating system's
help for more information.

You can also open files directly from your LogTag® Online account. Please refer to the section
about Integrating LogTag® Analyzer with LogTag® Online for more information.

The files that have most recently been opened are listed in the Select Recent File sub-menu the
bottom of the File menu. After the software has been installed for the first time, there are two
files in this list, even though no files have been opened yet. These are sample files, which have
been installed along with the software, so that users can see an example of how a LogTag® file
looks. These files are not required for the correct operation of the software and therefore may
be deleted at any time.

You can also open files directly from Windows® Explorer or your email software by double
clicking on the file or right clicking and selecting Open. When opening files from email
programs that store attachments in temporary folders such as MS Outlook, you may be asked to
store the file in a new location when performing further actions such as selecting multi-charts
or uploading to FTP sites.

If the software is unable to open the file, it will display an error.
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Figure 77: File Open dialogue window

Unsupported LogTag version. You may need to update your
software.

Figure 78: File not compatible with
current version of LogTag® Analyzer
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Analyzing the results

Data are displayed and analysed in file windows, which appear inside the main LogTag®
Analyzer window. Each file window displays the data of a single logger and has a series of View
tabs along the bottom. Clicking on a tab changes the way the information is displayed; different
windows can display different tabs.

You can activate Multi-Chart display, and all open file windows are combined into a single
window. You can find more information about this feature in Multi-Charts (Combining Charts
into a Single View) on page 98.

These are the different ways to display the information in the file windows.

Table 14: View Tab summary

Tab selected Information displayed

Report Tab A summary display of the downloaded data, including a summary of the important
trip information and an overview graph.

Chart (or Log A display of the data in a humidity and/or temperature versus time chart.

Chart)

Data A listing (spreadsheet style) of the time versus humidity and/or temperature data.

Summary A summary of the data, including averages, ranges, alert results, LogTag®
identification data, and other information.

Day Summary A summary of the day statistics for display loggers.

Day Summary A display of the minimum/maximum data in a temperature versus time chart; for

Chart the iSo°Tag indicator only.

Not all tabs may be displayed. You may for example see only Report, Chart, Data and Summary,
if the LogTag® does not have a statistics memory.

The readings range determines which section of the trip is shown in the view tabs. Click on the
drop down arrow and select the range you wish to display. Note that you can only make this
selection in the Chart and Data view tabs.

Report | Chart | Data Summary Day Summary All Readings

Cewrite R i orse

Figure 79: View tabs and reading range selection
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Tab selected
Pre-Start Readings

Started Readings

All Readings

LogTag Analyzer User Guide

Table 15: Reading range selection
Information displayed
The file window only shows data for pre-start readings, but omits any

readings taken after the logger started. This cannot be selected if the logger
has not taken any pre-start readings.

The file window only shows the data for readings taken after the logger
started, but omits any readings taken prior to the start. This cannot be
selected if the logger has only taken pre-start readings

The file window shows the data for all readings taken by the logger.

The most used tabs will typically be the report tab or the chart tab, as the information displayed
in either of them gives an instant overview of the data, whether just recorded and downloaded
from a LogTag®, or retrieved from previously stored data files.

Note: Indicator products such as the TICT or TIC20 only display the Report and Day
summary tabs. The iSo°Tag indicator displays Report, Log Chart, Data, Day Summary
and Day Summary Chart tabs. A reading range selection is not possible for these

products.

The following sections describe each type of information display (Report, Chart, Data,
Summary, Day Summary and Day Summary Chart) in more detail.
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Chart Display

Clicking on the Chart tab presents the
information in the file window as a 2-D line
chart with markers. When you first start
LogTag® Analyzer, this tab is activated by
default, but you can change this in the
Options .

You can see how temperature (and humidity
if applicable) changed during the trip.

If you want to see parts of the graph in more
detail, you can zoom in and display a smaller
section of the data. Move the cursor to the
upper left corner of the area you wish to
magnify, hold down the left mouse button
and move the cursor so it covers the area you
wish to see.

LogTag Analyzer User Guide
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When you release the left mouse button, the
area highlighted now fills the window.
Depending on the zoom level not every data
point may have a marker displayed. LogTag®
Analyzer intelligently adjusts the display of
markers so the graph line is still visible. These
markers can also be turned off, and their
appearance can be altered. You can learn
more about this in the Charts Section. You can
also see a number of other marks.

Inspection marks are recorded in the
o LogTag®'s memory each time its
START/MARK button is pressed.
Download marks are recorded in the
LogTag®'s memory each time it is
downloaded to a PC.
A Paused mark will be shown when
the product records readings for
which the statistics functions are
suppressed.

A Min/Max reset mark will be
o displayed for each time the min/max
display on a logger is reset.

When the mouse pointer is moved over the
chart, a tooltip is displayed near the mouse
pointer (as shown in the example). It displays
the reading closest to the mouse pointer
position. If the readings are very close
together, you may want to zoom in further
and then inspect individual readings with the
help of tooltips.

When elapsed time is chosen for the x-axis
display, the tooltip will also show the elapsed
time.

You can also add annotations (Chart
annotations) to the chart.
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The chart area displayed in the window can be copied to the clipboard by...
right-clicking anywhere on the chart and clicking Copy from the shortcut menu.
Pressing CIRL-C
Clicking Copy from the Edit menu.

This picture can then be pasted into any Microsoft Windows® application.

The chart is copied to the clipboard at its current zoom range.

You can change the appearance of all charts permanently by changing the options in Charts. If
you wish to temporarily change the appearance of only a single chart in the file window you
can use the Chart Control Panel, or the shortcut menu when you right-click on the chart.
These controls influence general items on the chart, such as turning on and off marks and grid
lines; these can be useful for finding information on the chart easier. Clicking on an enabled
item will disable it and vice versa.

The shade controls can be used to highlight the alert and non alert areas of the chart for easier
identification.

You can use the zoom controls to define which part of the data is displayed on screen (see
Zoom Control) and the Annotation menu to display text on the chart (see Chart annotations).
To close a window, click the x on the file window tab. You can also click the * on the right side
of the window. When you right-click on a file window tab, you can also close the file itself, but
also close all other files, or close all files.

The Chart Control Panel

The chart control panel provides you with an easy way to turn elements of the chart on or off,
to annotate the chart and to manipulate which part of the data is being displayed.

The upper part of the chart control panel contains some of the functions you can also find on
the toolbar. These are replicated here to give you easy, convenient access in one location. These
include scaling functions, time axis and inspection mark zoom.

(=)

Zoom Out

Y

:: Zoom Readings
#|  Manual Scaling
bk

Real Time
Elapsed Time

Zoom

Previous

00 QI

et

Figure 82: Upper Chart Control Panel
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The lower part of the Chart Control Panel controls what additional information is displayed on
the chart. The default values for the various grid lines, markers and shadings are set in Edit -

Options - Charts.

~

defaults.

The options you set in the chart control panel are stored with the chart, provided you
save the file after you have made the changes in the chart.

At a later stage, if you wish to return to the default settings you can click Reset do

You may also receive charts from other users with settings different to your own. These
charts can also be reset to default values using this method.

Feature

Align charts
(multi-chart only)

Reset do defaults
Annotate chart
Show annotations
Inspection Marks
Reading Marks
Download Marks
Paused Marks
X-Axis Grids
Y-Axis Grids

Show only validated

Table 16: Additional information for Charts
What this feature does

Shifts all charts so their first readings align on the canvas. Please see
Aligning Charts on page 101 for more information.

Changes the appearance and position of all charts so they correspond with the

settings made in Edit - Options - Charts.

Opens the Annotation Panel and allows you to annotate the chart. Please see
Chart annotations on page 104 for further details.

Select, if you wish to show the chart's annotations, clear, if you wish to hide
them.

Select, if you wish to show each recorded Inspection Mark in the chart, clear,

if you wish to hide them. This setting also controls the Min/Max Reset Marks.

Select, if you wish to show the chart's Reading Marks, clear if you wish to
hide them.

Select, if you wish to show each recorded Download Mark in the chart, clear,
if you wish to hide them.

Selec,t if you wish to show each recorded Paused Mark in the chart, clear, if
you wish to hide them.

Select, if you wish to show the X-Axis (vertical) grid lines, clear, if you wish
to hide them.

Select, if you wish to show the Y-Axis (horizontal) grid lines, clear, if you
wish to hide them.

Select, if you wish to show only validated readings on the chart, clear, if you
wish to hide them. Please see How secure is my data on page 84 for further
information about non-validated readings.
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Feature What this feature does
Above Alert Shade Select, if you wish to show readings above the upper alarm limit with a
(single-chart only) different background colour, clear, if not.

Loggers with more than 2 alarms may show more than one
background colour. Please note these cannot be turned off

individually.

Non Alert Shade Select, if you wish to show readings in the non-alert area with a different
(single-chart only) background colour, clear, if they should appear with a white background.
Below Alert Shade Select if you wish to show readings below the lower alarm limit with a
(single-chart only) different background colour, clear, if not.
Temp alert range/ If the button shows Temp alert range, the alert shading uses the temperature
Hum alert range maximum and minimum alert values for the shading. If the button shows
(HAXO-8 single-chart Hum alert range, the alert shading uses the humidity maximum and
only) minimum alert values for the shading.

The Y-Axis gridlines also adjust so they align with the corresponding

divisions.
Hide/Show (/ =€) Clicking hides the Chart Control Panel when it is currently shown, clicking

=4 shows the panel when it is currently hidden.

Manual Scaling

Sometimes you will want better control over the temperature and humidity scale, or the time MasiSae W

window in which readings are displayed, than you can achieve with the mouse zoom.

To do that, you can enter the zoom values directly: O Range of readivgs
(@) Custom range

Right-click anywhere on the chart area and select Manual Scaling. The dialogue as shown will - &

(_) Range of sensor

. From *C ToC
be displayed. 20 2] e B 00 =
You can select:
. .. . from to
« Range of sensor; the chart is zoomed to the minimum and maximum values for each sensor. e . . e
These values are dependent on the logger model. = =
« Range of readings; the chart is zoomed so the axis covers the minimum and maximum @) Date Otrdex
reading values (with a small margin added). e Wedne s Fetran 7. 2012 [§O0 O ;| EEnees
fo: Thursday, February 3, 2012 v 2204 @ :_ 5853 4

« Custom Range

When selecting this option you have complete control over which part of the graph is
displayed. @ « Q) conce @
You can specify

[C] apply to all open charts

Figure 84: Manual scaling window
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o The temperature (and humidity ranges if applicable) for the y-axis.

o the date and time range for which the readings will be shown. Please note that you
cannot enter dates and times outside the span of the logger's logged data.

o Alternatively you can specify an index range for the readings. You can see each reading's
index in the data tab. This is useful if you wish to display a certain part of multiple files
that do not cover the same date and time range.

Initially the dialog shows the current zoom settings.

If you select the check box Apply to all open charts, these settings will be applied to all

currently open charts as follows:

« The Y-axis scaling (temperature and humidity) will be applied to every open chart. Range of
sensor and Range of readings use the currently active chart's sensor range or reading range
for all charts. If you want each chart to display its own sensor or reading range, please select
the corresponding option in Default Zoom in the chart options.

« The X-axis scaling (time) will be applied to every chart with readings inside the selected
time frame, including pre-start readings.

If a chart's readings fall completely inside the specified range, the X-axis will not be scaled.
If a chart's readings fall partially inside the specified range, the X-axis will be scaled so only
those readings inside the range will be displayed.
A chart will always display the readings at the time they were recorded. As a result the first
and last readings may not always align perfectly with the selected time frame, particularly
with long log intervals.

« No scaling will be applied to files where the active tab is the summary tab, day summary tab
or one of the data list tabs.

The zoom range is also not applied to TIC20 and TICT indicator products.

If you clear the check box Apply to all open charts, the chosen settings will only be applied to
the currently active chart.

Click to apply your selected settings, or to abort.
@

To return to the previous zoom level, click Zoom Out from the Edit menu, click zemos on the
toolbar or right-click anywhere on the graph area and select Zoom out. You can do this

individually for each chart. You can also right-click and select Zoom Readings.

Inspection and download mark zoom

You can also zoom directly to certain parts of the chart by using the inspection mark zoom icons
on the toolbar and in the context menu. Note that these controls are disabled when a Multi-
Chart tab is active.
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® Zoom to inspection marks

7 This zooms the chart so readings are shown between the oldest reading recorded and the first
Zeom  jnspection mark in the data. If this function is not available then there are no inspection marks
in the data currently being displayed.

The next two commands will not be available until this command is activated.

o Previous inspection mark group

This zooms the chart so readings are shown which were recorded between the first inspection
Pfredos - mark currently being displayed and the previous inspection mark.

This function is not available when the oldest reading is already being displayed.

o Next inspection mark group

This zooms the chart so readings are shown which were recorded between the last inspection
Next mark currently being displayed and the next inspection mark.

This function is not available when the newest reading is already being displayed.

B Zoom out

rd Zooms out one level of the chart in the currently active window. If you are displaying a chart
Zmomut  and this function is not available, then all available data are already being displayed and you
cannot zoom out any further.

L For this function, Min/Max Reset Marks are treated as if they were Inspection Marks. ]

In addition to zooming out and manually scaling the chart, you can right-click anywhere on the
chart and use these additional functions:

From first reading to first inspection/download mark

This zooms the chart so readings are shown between the oldest reading recorded and the first
inspection mark or download mark that exists in the data. This is different from the "Zoom to
inspection marks" feature as it also evaluates download marks. You can use this function to
look at the first set of data where a logger is downloaded more than once during a trip, for
example in a cold chain transport where goods are transferred from a cargo ship to a
distribution truck and you are only interested in the shipping portion of the trip.

From last inspection/download mark to last reading

This zooms the chart so readings are shown between the last inspection mark or download
mark and the newest reading in the data. This is different from the "Zoom to inspection marks"
feature as it also evaluates download marks. You can use this function to look at the last set of
data where a logger is downloaded more than once during a trip, for example on a distribution
truck which has multiple drop off points and you are only interested in the last portion of the
trip.
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If either of the two menu points are greyed out you are either already looking at this part of the
data, or there are no inspection or download marks present.

In the General section of the Options you have the opportunity to define either of these two
settings as the default when files are opened or recorders are downloaded.
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Multi-Charts (Combining Charts into a Single View)

You can overlay data from multiple loggers in

one view. When you click mun in the
toolbar, all file window tabs containing data

for a single logger are combined into one
window, where you can access a Multi-Chart,
a Multi-Report and a Multi-Data listing by
clicking the corresponding tab.

Charts will be shown in different colours, as
chosen in the colour palette in the Options for
Charts, where you also define the composition
of the Chart Legend. The legend contains an
entry for each chart showing the chart's
colour and the description defined in the
settings.

You can annotate a Multi-Chart in the same
way you annotate a single chart.

You can also view Min, Max and Average
Charts, and select other options.

When you close a newly created Mutli-Chart,
it will either be stored automatically, or you
will be asked if you want to store the chart.
This depends on the settings made in File and
Folder Settings (as described on page 154).

File Edit LogTag Window User Server

LogTag Cnline  Help

For Help, press F1. To use a LogTag, press F2.

@ Select Display TimeZone ~

LogTag Configured Time (Display Clock Adjusted)
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Figure 85: Seven charts combined into a multi-chart
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Hiding and Showing Charts

In the Multi-Chart window you can hide each
chart individually. Right-click anywhere on
the chart, point to the entry of the file you
wish to hide and click to clear the tick. To
show the chart again, repeat the procedure
and select the name again.

Opening additional files

If you open additional files, these will initially
be shown in separate file window tabs,
including data from freshly downloaded
LogTag®s. You can add the data for these files
to an existing Multi-Chart.

Right-click anywhere on the Multi-Chart and
point to Attach Document. Click on the name
of the file you wish to add.

Removing files from the Multi-Chart

If you wish to permanently remove a file from
the Multi-Chart , hide the chart as described
above

Before closing a Multi-Chart with hidden
charts, ensure that you have a copy of the
files for the hidden charts. Once saved, the
hidden files will be permanently removed
and cannot be recovered.
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More than one Multi-Chart window

If you open at least two additional files, you
can generate a second Multi-Chart by clicking
the Multi-Chart icon from the toolbar. All
files shown in separate windows will be
combined into a new Multi-Chart window.The
new Multi-Chart window additionally contains
all charts from the original Multi-Chart, but
they are initially hidden. They can be shown
as described on the previous page.

Extracting individual files from a Multi-Chart

A Multi-chart contains the complete data sets
for each of the loggers from which is was
generated.

You can view the data for each individual
chart in a single-chart window by extracting
them to a *.1tdx file.

Right-click anywhere on the chart, point to
Open Document.and click on the file you wish
to extract. A new file window tab will open,
showing the contents of the extracted file,
which is saved in the same location as the
Multi-Chart.

LogTag Analyzer User Guide
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Aligning Charts

Select Align Charts from the Chart Control Panel to automatically align all charts in the current
Multi Chart window to the earliest start time:

« When Started Readings is selected, the charts are aligned so the first started reading is
shown at elapsed time zero. Charts with no Started readings (i.e. charts with only pre-start
readings) are hidden in this view.

« When Pre-start Readings is selected, all charts with Pre-start readings are aligned so the
earliest Pre-start reading is shown at elapsed time zero. Charts with no pre-start readings
are hidden in this view.

« When All Readings is selected, all charts are aligned so the earliest reading is shown at
elapsed time zero, regardless whether this is a Pre-start reading or a Started reading.

Every chart is assigned a different colour based on the Chart palette and elapsed time is shown.

If you use the toolbar Icon to switch to Real Time, the charts will be shown in their
original relative position.

Shifting Charts

For easier data comparison, chart start times can be shifted while you are viewing the Multi
Chart display.

To shift a chart, move the mouse pointer over the chart until a tooltip from that chart is
displayed. Right-click, then click Shift Chart. A dialog box will be displayed, where the new start
time and date can be selected.

Click the down arrow next to the date to display a calendar where you can select the new start
date. Highlight the hours or minutes from the time and use the up and down arrows next to the
time to change the numbers.

You can revert the chart to its original display by clicking Original start time.

To apply the selected start date and time click .

Min/Max/Average Chart Display

When you click the Average icon Q in the toolbar, the currently active Multi-Chart file tab will
now show charts for the calculated values of minimum, maximum and average readings,

instead of the individual charts.

Select naw start date and time for Warming Drawer
Example

Sunday, October 1, 2017 w | | 15:49 ® .

O Criginal start time

m 0 Carcel e Help

Figure 87: Shifting a chart
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Switching from Average display to Standard display and vice versa, or changing the Readings
Range will force the Multi-Chart to be re-drawn according to the default settings. You can then
use the standard zoom controls to show the portion of the charts you want to see.

You can annotate the Average Chart in the same way as any other chart tab; such annotations
will be visible in the other chart tabs and are stored with the multi chart when saved. An
annotation that is linked to a data point on the chart will still be shown, even if the data point
itself is no longer being displayed.

Please note the following behaviour:

Zoom settings will not transfer to the Average tab.
Download marks and inspection marks will not be displayed in the "Average" tabs.

Non-validated readings and re-calibrated readings will not be displayed with the special
attributes, even if set in the options. If you have chosen to show non-validated readings,
they are included in the minimum/maximumy/average calculations, otherwise not.

To avoid memory overflows, the maximum number of data points or loggers that can be
shown in the average chart is restricted. If you try to show average charts outside these
limits, you will see this warning message:

If one or more of the charts have sections with readings outside the LogTag®'s sensor range,
LogTag® Analyzer is unable to calculate the minimum, maximum and average values, and
those sections of the graph will not be displayed. This will likely result in a "broken" graph
line, regardless of whether show readings beyond specifications in the Charts section in the
Options Window is enabled or not (Charts on page 138).

Due to the large number of calculations performed in this feature, specifically when opening
large numbers of charts spanning long periods, having the Average displayed can occupy
large amounts of memory and run slow. Therefore we recommend only turning the feature
on when required.

Clicking on the Average Icon in the toolbar again will turn the average display off. Selecting the
single charts command in the toolbar will open each chart in the Multi-Chart in a separate File
Window, however the Average Chart tab will not be closed.

Analyzer doesnot currently support Average fimetionality
for data sets greater than 100,000 readings or more than 200

loggers.
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Behind The Scenes

To create some meaningful results, LogTag® Analyzer uses a special trend line process to
calculate the minimum, maximum and average values across multiple charts, rather than a
histogram. It is important you understand this mechanism, so you can interpret the displayed
readings correctly.

This is an example of two LogTag®s, one with a 5 minute log interval (A) and the other (B)
logging every 2 minutes.

Before the data are displayed in an average tab, LogTag® Analyzer normalises every chart's
readings so they fall in line with the logging interval of the LogTag® with the shortest log
interval, in this case unit (B). It does not shift any charts, but rather calculates a theoretical
value for those reading times by linear interpolation. Interpolation determines probable
environmental conditions, i.e. what the LogTag® would have recorded had it taken a reading at
that time.

Without this method, it would not be possible to compare LogTag®s with different log intervals,

or units that have the same log interval, but were started at different times.

As a result of this process, absolute values for minimum and maximum may not always be
shown if they do not fall on normalized times, as seen in the example at 10:35 - despite 21°C
being the maximum it will not be displayed as it is not a normalized value.

Note: The charts in above example are based on LogTag®s started at the same time. If unit
(A) had been started earlier, depending on the start time unit (B) may also have its readings
interpolated. To ensure the chart with the shortest log interval always has its real values
shown, please use the Aligning Charts function from the context menu.
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Chart annotations

You can include additional information in your chart tab by adding textual and graphical
annotations. Annotations are stored in the *.1tdx file and will be shown again when you next
view the file. Annotations will be printed, and will also be shown on anyone else's computer, if
you are sharing annotated files. You can place up to 58 individual annotations.

If a chart's annotations are currently shown, you can hide them by right-clicking anywhere on
the chart and clearing the tick for Show Annotations. You can show them again by selecting
Show Annotations. You can also perform both actions via the Chart Control Panel.

Adding Annotations
To start annotating charts, right-click anywhere on the chart and select Annotate Chart from
the menu. This will open the basic view of the Annotations Panel.

You can also open this by clicking Annotate Chart from the Chart Control Panel.

When the Annotations Panel is open, an annotation will be placed at the position of the mouse
pointer every time you click the mouse button on the chart canvas. You can choose different
types of annotations with different behaviour. The following table explains what each of the
options in the Annotations Panel mean and how they influence the look and position of the
annotation:

Table 17: Basic annotation options
Option Selection What it does

Anchor type Chart Point If a Chart Point annotation is placed, the annotation will always be
linked to the time stamp of the reading on which the mouse pointer is
positioned when placing the annotation. If the chart is zoomed or
panned, and the data point is not visible, the annotation is also not
shown. When a chart becomes part of a multi-Chart, all Chart Point
annotations for the single chart are also visible in the multi—-chart.

Chart Point Annotations are good for marking specific times on the
chart with additional information.

Background If a Background annotation is placed, the annotation will always be
linked to the position on the canvas in which it was placed. Even if
the chart is zoomed or panned, the annotation will always stay in the
relative position from the canvas edges.

Background annotations are good for placing information relating to
the entire chart. The Statistics Information for example is placed on
the canvas using a background annotation.

Copy
Delete Annotation

Annotate Chart M
Lag

Zoom Cut
Zoom Readings

Manual 5caling

Show &nnotations

Inspection Marks

JIE

Reading Marks

Figure 92: Chart Right-Click Menu

Annotations Advanced

Anchor Type: | Chart Paint w
Add DataPoint Information[w/]

Type: | Callout Rectangle W

Figure 93: Chart Annotation Panel
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Option Selection
Add DataPoint Enabled
Information Disabled
Add Series Enabled
Information Disabled
Type Callout
Rectangle

Callout Ellipse

Line

LogTag Analyzer User Guide

What it does

This option can only be selected when the Anchor type is Chart Point.
If enabled, text will automatically be added to a callout, showing date,
time, value and type of reading. If disabled, the callout will be

empty.

This option can only be selected when the Anchor type is Background.
If enabled, text will automatically be added to a callout, showing the

charts series information from the legend. If disabled, the callout will
be empty.

When this annotation
type is selected, a
rectangular callout shape
is used when placing the
annotation. If the Anchor type is Chart Point, a pointer to the related
reading is also added, To add text or change the automatically placed
text double-click the annotation.

11/30/2012 10:48:21 AM 19.7 °C
1112 0050 Trip:=2_2307 °C

When this

annotation

type is

selected, an 11/30/2012 10:48:21 AM
elliptical 19.7 °C

callout shape 1112 0050 Trip:2_2307 °C

is used when
placing the
annotation. If
the Anchor type is Chart Point, a pointer to the related reading is also
added, To add text or change the automatically placed text double-
click the annotation.

When this annotation type is selected,
you can place a line on the drawing
canvas:

« Move the mouse pointer to where you wish the line to start

« Press and hold the mouse button
e Move the mouse pointer to where you wish the line to end
« Release the button
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Option Selection What it does

Arrow When this annotation type is selected from
the drop down, you place an arrow on the
drawing canvas:
« Move the mouse pointer to where you wish the arrow head to start

o Press and hold the mouse button
e Move the mouse pointer to where you wish the arrow tail to end
« Release the button

Rectangle When this annotation type is
selected from the drop down, a
rectangular shape is placed on the
drawing canvas. This rectangular
area is useful for highlighting
sections of the chart, but please note that you cannot place text inside
this shape.

Chart Statistics This annotation is only available as a Background annotation. When it
is selected from the drop down, a rectangular callout is placed on
drawing canvas, and text will automatically be added to the callout,
showing the information defined in Chart Statistics on page 137, for
example range of readings or min/max/average values.

Tip: If you wish to place a rectangle with text inside, place a
Chart Statistic Annotation
and replace the text with your own.

You can refine the appearance of annotations in the advanced view of the Annotations Panel.
This view can be activated by clicking the Advanced button when the Annotations Panel's basic
view is shown.

You can click Basic to return to the basic view. If you close the Annotations Panel while in
advanced view, next time you open it, it will also show the advanced view.

You will be familiar with these options from many other Windows programs:

Annotations | Basic |
Anchor Type:  Chart Point L
Add DataPoint Information[w/]

Type: Callout Rectangle w
Style
Line Width |1 =
Calor . Line Style |Solid  +
Transparency | 100 & Line Color .
Font
Font Color: D Size (10 =
Eont: | Segoe Ul ]
Font Style: | Normal W

Figure 94: Advanced View of the Annotations Panel
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Table 18: Appearance settings

Group Selection What it does

Style Line width These parameters define the look of the shape object that is
Line Style placed with every annotation. Line width, style and colour
Line Colour define the outline of the object, colour determines the object's
Colour fill colour and transparency defines how opaque or transparent
Transparency the object will be. 100 is equal to the object being fully opaque,

0 to the object being fully transparent.

Font Font Colour These parameters define the properties of the font used for text
Size inside the callouts. Note that only a small selection of system
Font fonts is available.
Font Style

Note: Mouse zooming and panning is disabled when making annotations.
You can, however, still use manual scaling to zoom to the desired section of the chart.

To stop annotating the file, close the Annotations Panel; right-click anywhere on the chart and
select Annotate Chart from the menu. You can also close it by clicking Annotate Chart from the
Chart Control Panel or by clicking the Annotations Panel's Close button . If you change file
window tabs, the Annotations Panel closes automatically.

Editing Annotations
To change the position of an annotation, use the mouse and point to the annotation. When the

pointer has changed to %, press and hold the mouse button, move the annotation to the
desired location and release the button.

To change the size of an annotation, click inside the annotation. The sizing handles appear. Use

the mouse and point to one of the handles until the cursor changes (I, o, R‘m, o Or +). Press
and hold the mouse button and drag the handle to the desired size.

To edit the text of an annotation, double click the annotation.

Deleting Annotations

To delete an annotation, click inside the annotation and press the Delete key. You can also
right-click inside the annotation and click Delete Annotation.

284
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w
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Figure 95: Chart with different types of annotations
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Report Display

The Report display tab provides a convenient and quick way of seeing e e
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Multi-Chart Reports
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A Multi-Chart can also be viewed in the Report tab, where you can see
a brief summary for each logger and a smaller version of the chart.
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Data Display

When you click the data tab, the readings are displayed in a
spreadsheet-like list in chronological order, including an index, date &
time and elapsed time.

The data tab only displays readings shown on the corresponding chart.
If the chart is zoomed in, the data tab only shows those zoomed
readings. You cannot use the scroll bar or arrow keys to display
readings before or after the currently zoomed readings; to expand the
number of readings switch to the chart and zoom out.

On the list you can also identify any special marks attached to the
reading, such as download marks (identified through rose background),
inspection marks (identified through red background), paused marks
(identified through blue background) and min/max reset marks
(identified through green background). The text colour identifies if a
reading has been above the upper alert value (red), below the lower
alert value (blue) or within specification (black). You can scroll through
the readings with the arrow, page up/down, home and end keys, or use
the mouse wheel.

You can sort the list by clicking on one of the column headers. This can
be useful, for example, when you want to look at all events and the
times they occurred.

You can add a comment for each reading. This comment will be stored
against the reading when you save the file. In the row for which you
wish to add a comment, click in the Comment column and type your
text.

The list grid can be copied to the Windows clipboard and pasted into
other windows applications such as Excel. Press CTRL-C to copy the
entire currently displayed list. Copied data always include the header
row, even if it is not highlighted, and are always sorted by index. You
can also click Copy from the Edit menu, or right-click on a row and
click Copy All. You can also copy only the highlighted rows if you
right-click anywhere in the highlighted section and click Copy
Selected. You can select as many rows as you wish using the mouse.
Point to the first row you want to select. Press and hold the mouse
button, drag the pointer to the last row you wish to select, and release
the button.
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Figure 100: Data tab
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Multi-Chart Data Tab

Data listings are also available when viewing
a multi-chart. Here, the data listings for the
individual loggers are combined into a single
list, with each line representing one reading
from a single logger.

Marks, text and background colours are shown
in the same way as for single file lists.

Readings are initially sorted and indexed
chronologically, but can be sorted by clicking
one of the column headers. This can be
useful, for example, when you want to look at
all readings from a specific logger. If you wish
to return to the original chronological sort
order, simply click the Index column header.

You can add a comment for each reading. This
comment will be stored against the reading
when you save the file. In the row for which
you wish to add a comment, click in the
Comment column and type your text. Copy
and Paste functions work identical to the
single file data tab.
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Im;ex Serial #: Date Time Eiapsed Humidity %RH Temperature *C Events Comment _%J
T3 FRIBE20425 23/08/2011 10:05:00 00:05:00 72
74 00B0D20511 23/08/2011 10:05:00 00:05:00 29
75 7000045085 23/08/2011 10:05:00 00:05:00 BA
76 23278M 23/08/2011 10:05:00 00:05:00 19
77 0018230625 | 23/08/2011 10:05:00 00:05:00 09
78 so10000827 108/20, LoRn AT Al 90
T Logger Serial Numbers 94 Below Alert
80 FF1BE20425 23/08/201 10:05:30 00:05:30 72
81 0080020511 23/08/201 10:05:30 00:05:30 535
82 7000045085 23/08/201 10:05:30 O005:30 B4
83 23278M 23/08/2011 10:05:30 0005:30 18
84 0018230625 23/08/2011 10:05:30 000530 09
85 5010000827 23/08/2011 10:06:00 0006:00 N2 90
86 5010002909 23/08/2011 10:06:00 0006:00 379 94 Below Alert
87 FFIBE20425 23/08/2011 10:06:00 O0:06:00 72
88 0060020511 23/08/2011 10:06:00 99
s List Index i
%0 . e 18
91 0018230625 23/08/20M 10:06:00 00:06:00 09
92 5010000827 23/08/2011 10:06:30 000630 535 90 Above Alert
93 5010002909 23/08/2011 10:06:30 00:0630 69.6 85
94 FF1BE20425 23/08/2011 10:06:30 00:06:30 72
85 0DGOD20511 23/08/2011 10:06:30 00:06:30 EE
96 7000045085 23/08/2011 10:06:30 000630 B4
97 23278M 23/08/2011 10:06:30 000630 18
98 0018230625 23/08/2011 10:06:30 000630 09
99 5010000827 23/08/201 10:07:00 000700 483 90
100 5010002909 23/08/2011 10:07:00 00:07:00 579 95
101 FFIBE20425 23/08/2011 10:07:00 000700 70
102 0060D20511 25/08/2011 10:07:00 000700 29
103 7000045085 237082011 10:07:00 000700 84
104 23278Mm 23/08/2011 10:07:00 00:07:00 18 =

Report 0|a|1|Dm|

Figure 101: Multi-Chart Data Tab
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Summary Display

The summary tab offers a brief statistics overview of some of the important trip data. You can
customise the statistical data you wish to include in this tab in the Options dialogue for the
Summary Statistics on page 136.

The first section shows the data for the complete trip, regardless of whether or not the chart is
zoomed in. The second section is only displayed if the chart is zoomed in, and displays the
statistics for only the zoomed readings.

If there are readings beyond the limits of the sensor within the time interval displayed, the
statistics for this interval will show "**""

The zoom controls available for the chart tab are inactive in the summary tab.
If inspection marks are present in the data, statistics summaries for each of the inspection
mark groups in the data can be seen amended to the end.

The list grid can be copied to the Windows clipboard and pasted into other windows applications
such as spreadsheets, including the list header row.

Displaying statistics

The statistics displayed on the Summary tab can be configured in the Options dialog. Refer to
the topic on Summary Statistics on page 136. By default, all statistics are displayed on the
Summary tab.

Statistics can also be displayed on the chart, in a Chart Statistics Annotation. Refer to the topic
on Chart Statistics on page 137 for more information about configuring the chart statistics.

If there are readings beyond the limits of the sensor within the time interval being displayed,
the statistics for the relevant interval will be displayed as "**".
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4 | Statistics for Started readings

VLouTw ID
Description

Battery status

Time zone

Reading interval
MNumber of staris
MNumber of readings
MNumber of started readings
MNon alert range
First reading

Last reading
Elapsed Time
Readings range

£045000020

CK

UTC +1300

30 Seconds

4

16129

16129

0.0 to 201°C
10/7/2016 35908 PM
10/13/2016 623208 AM
5 Days 14 Hours 24 Minutes 30 Seconds
158 to 271 °C

4 Statistics for between the first reading and inspection mark =1

First reading

Last reading

Elapsed Time

Readings range

Average reading

Standard Deviation (S)

Time below/equal lower alert
Time above/equal upper alert

Time not in alert

‘lﬂ.f‘l.f.’.Oﬂl 12:00:51 PM
10/1/2003 11221 PM
1 Hour 12 Minutes
81 to 126°C
10.7 *C
371°C
None
1 Hour 12 Minutes
None

Degree Minutes below lower alert 0.0 *C-Minutes
Degree Minutes above upper alert 16575 *C-Minutes

Mean Kinetic Temperature

113°C

4 | Statistics for between inspection mark #1 and inspection mark #2

First reading

Last reading

Elapsed Time

Readings range

Average reading

Standard Deviation (S)

Time below/equal lower alert
Time above/equal upper alert
Time nat in alert

10/1/2003 1:1251 PM
10/1/2003 4:12:21 PM

3 Hours

-144 to 145°C

-125*C

4.7'C

MNong

26 Minutes 30 Seconds

2 Hours 33 Minutes 30 Seconds

Degree Minutes below lower alert 0.0 "C-Minutes
Degree Minutes above upper alert 2244 *C-Minutes
Mean Kinetic Temperature 892

Figure 103: Statistics tab when inspection marks are included
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Day Summary Display

The day summary tab is displayed for
LogTag®s with an integrated statistics
Mmemory.

LogTag® logger products with display
For these logger models the day summary
display shows the history of up to 30 days,
arranged into 24 hour periods, with
information about maximum and minimum
values for the day, and if alarms have been
triggered on those days.

The Day summary grid can be copied to the
Windows clipboard and pasted into other
windows applications such as spreadsheets,
including the header row.

LogTag Analyzer User Guide

o Min.read =
Time abovejequal upper aler eacing ime beiow/equal lomer alert

o | wsizme -l a | a7 [ o !

4 10802008 [ = |11 a [ 5 | 0 B Day summary header row
2 | 10292016 49 a 12 0

-3 1282016 43 a as ]

4 meTRME 43 [ 8 0 5

25 oezs @ 215 A 1 Day 1w A 0 Summary Grid
£ mazseie @ 186 A 1 Day 173 A 0

024006 | 183 A 10 Minutes a7 ¥ 9 Hours 10 Minutes

Alarm Marker Above Limit Marker Below Limit Marker

Report  Chart Data Summary  Day Summary

Figure 104: Day summary for loggers with display and
statistics memory
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LogTag® indicator products with display
These indicator products typically have
multiple alarm levels. Time above or below
each alarm level is displayed, with
information about maximum and minimum
values for the day, if alarms have been
triggered on those days and how much time
elapsed on that day until the alarm was
triggered.

The Day summary grid can be copied to the
Windows clipboard and pasted into other
windows applications such as spreadsheets,
including the header row.
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Day Summary Chart

iSo°Tag indicators show a tab not available for
other types of indicators or loggers. It shows
the minimum and maximum recorded
temperature values for each day the indicator
was running in form of a 2D line chart.

What you can do on this chart is almost
identical to the Chart tab, tooltips show the
data for each you can zoom in and out, you
can place annotation marks and manually
scale the chart. There are, however, some
exceptions:

« There are no download marks. To download
an iSo°Tag with LogTag® Analyzer it must
first be stopped, hence a download mark
can never be recorded.

« Real time shows an approximation of the
date in which minimum and maximum
values were recorded. The iS0°Tag's 24
hour day period starts at the time of the
day the indicator is activated, not at
midnight.

« The data points are linked by a line for
visual appearance only.

« An inspection mark is recorded against a
day, not a specific sample.

« Average and multichart buttons have no
effect on this tab.

« Since the data points don't represent
readings, there is no chart statistics display

LogTag Analyzer User Guide

ISOTAG: Year Rracoeding (almont} 309500000% Started 307-2014 Fishbed 607 20150dx X

Temp *C ISOTAG: 2095000003 Started O07/08/2014, Finished 07/06/2015
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Printing the results

Printing from LogTag® Analyzer is similar to printing from other
Windows software.

Before you print for the first time, however, we suggest you take some
time to set-up your preferred page settings.

Page Setup

Click Page Setup from the File menu, the Page Setup window will be
displayed.

You can set page margins, paper size and orientation. You can check
what the print will look like by clicking Print Preview from the File
menu, as described on page 39.

Printing a single document

Click the Print icon () on the toolbar or click Print from the File

menu to display the Print window.

Choose a printer and, if required, adjust its properties.

Choose the range of pages to be printed:

« All - All pages will be printed

« Selection - Prints the range of readings you selected, for example
by highlighting rows in the data tab.

. Current page - Prints only the current page.

« Pages - Prints only the pages you specify in the text entry.

Please note that LogTag® Analyzer will try to print charts and reports
on a single page where possible.

Printing multiple documents

You can print all currently open documents at once.

Click Print All from the File menu; the printer dialogue will be
displayed. After you have made your selection click print, and each
document's currently active tab will be printed with the respective
zoom settings.

LogTag Analyzer User Guide
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Automatically calculated statistics

When displayed recorded data, the software will automatically calculate and display some
statistics calculated from those data. These statistics are shown on the summary tab and are
also calculated for each sequence of data points between the inspection marks.

If any readings within the time interval are beyond the limits of the sensor, the values for
Average Reading, Standard Deviation, and Mean Kinetic Temperature will not be displayed for
the relevant time interval .

Average Reading
The Average Reading is the arithmetic mean of the sequence of data points. It is calculated by

n
adding all the data point values together and then dividing the total by the number of data E i
points. Mathematically this formula can be expressed as illustrated. i=1
For example, if there were 5 data points to calculate the arithmetic mean of and they were, av = n

12.3, 15.9, 16.2, 14.7, 14.9, then the arithmetic mean would be 14.8.

The number of decimal places displayed can be set to 1, 2 or 3 by clicking Options from the Edit Figure 109: Formula for average reading

Menu, then navigating to the Summary Statistic section and selecting the number of decimal av is the calculated arithmetic
places from the Decimal Places entry. Please note this setting is shared amongst all statistics mean
calulations.

n  is the number of data points
to include in the calculation
tj are the sequence of data

points to include in the
calculation
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Degree Minutes

Some products and materials change their characteristics or degrade, if they are exposed to
temperatures outside the ideal conditions for extended periods. For example, some products
may experience freezer burn if they experience an extremely cold condition or experience a
colder than ideal temperature for a long period of time. LogTag® Analyzer will automatically
display the results of two separate Degree Minutes calculations. The result of the first is based
on the readings recorded below the "ideal conditions", the second on the readings above the
"ideal conditions". The "ideal conditions" used in the calculation of the Degree Minutes
formula are represented by the non-alert range based on the upper and lower alert values
entered during configuration of the LogTag®.

Mathematically the formula for calculating the degree minutes above alert can be expressed as
illustrated.

For example, if there were 5 data points to calculate the degree minutes of and they were, 12.3,
15.9, 16.2, 14.7 and 14.9 degrees, each of these temperatures were recorded at 2 minute intervals
and the high alert temperature threshold was 12.6 degrees, then the degree minutes
temperature above the upper alert threshold would be 22.6 degree-minutes.

page 119
n

degmin = > abs(t; —a) X s
1=1

Figure 110: Formula for degree minutes

deg min Total Degree Minutes spent
above/below the alert
threshold.

ti The temperature that was
above/below the alert
threshold.

a The alert temperature
threshold.

S The duration of time, in

minutes, the temperature was
sustained.
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Mean Kinetic Temperature

Some products and materials have accelerated rates of degradation at higher temperatures. For AH
example, perishable food items and pharmaceutical products can degrade and many forms of _ R_

; . ; : R mkt = — 273.15
bacteria grow exponentially as the environmental temperature increases. Mean kinetic % _AH
temperature is a calculation that accommodates the non-linear thermal effect, which | =0 P\ &x (t;+273.15)
temperature can have on products. Mean kinetic temperature is represented as the equivalent a n
temperature the product was thermally subjected to during the time the various temperature
readings were recorded.

Mathematically the formula for calculating the mean kinetic temperature can be expressed as Figure 111: Formula for mean kinetic temperature
ilustrated. ‘ . . o mkt is the mean kinetic

For example, if there were 5 data points of which to‘ calculate the mean kmepc temperature, temperature, in degrees
they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees Celsius, then the mean Kinetic temperature Celsius

would be 14.9 degr;es Celsius using the d_efaglt AH. AH s the activation energy.

By1 delfatl_ﬂtrl LogTag® Analyzer uses an activation energy value of 83.144 KJ/mol for the R s the the universal gas
calcuiation. . ) . . constant, which is 0.0083144

To enter a custom value for AH, click Options from the Edit Menu, then navigate to the KJ/mol K

tSur??alg Statistic section where you can enter the desired value in the Use the following value n is the number of data points
ext held. o ) AH it s diff ; to include in the calculation
Charts and the Statistics page display the parameter if it is different to the default value, ti  represents the data points to

and display Logger deltaH if the parameter from the logger was used. include in the calculation, in

degrees Celsius
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Standard Deviation

The standard deviation is a useful measure for determining how spread out the readings are
from the arithmetic mean (Average Reading). Most controlled environments typically try to
keep the environmental conditions at a stable and consistent humidity and/or temperature. The
standard deviation can be used to help indicate how stable the environmental conditions were
maintained. One standard deviation (sometimes expressed as "one sigma") away from the
mean, positive or negative represents approximately 68 percent of all the readings. Two
standard deviations, or two sigmas, away from the mean represents approximately 95 percent
of the readings. Three standard deviations represent about 99 percent of the readings.

For example, if the arithmetic mean of the readings was 50.6°C and the standard deviation was
2.3°C, then approximately 68% of the readings were between 48.3°C and 52.9°C, 95% of all the
readings were between 46.0°C and 55.2°C and 99% of the readings were between 43.7°C and
57.5°C. Further more, if all the readings were recorded over a span of 1 day (24 hours) then the
temperature was between 48.3°C and 52.9°C for approximately 16 hours and 19 minutes during
the recorded period of time.

Mathematically standard deviation can be expressed as illustrated. Figure 113: Population based standard deviation
LogTag® Analyzer allows the calculation of sample or population based standard deviation.

Which of those is used for the calculation can be set by clicking Options from the Edit Menu, § the calculated sample based standard deviation
then navigating to the Summary Statistic section and selecting sample based or population SN the calculated population based standard deviation
based. n the number of readings to include in the calculation
Here you can also adjust the number of decimal places used to display the result, but please av  the calculated arithmetic mean

note this setting is shared amongst all statistics calculations. ti a reading to include in the calculation

For a more detailed explanation of the various ways to calculate standard deviation please
consult the relevant literature related to statistical and probability calculations.
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Sharing recorded data with others

You can share data downloaded from a LogTag® device with other users in a number of
different ways.

« If the person you wish to share the data with has access to the same software version of
LogTag® Analyzer as you, you can send the latest *.1tdx file via email, or upload it to an FTP
server.

You can find more details about sending files automatically or upon request in the sections
about Automatic emailing and uploading to FTP sites on the next page and Sending a file by
email directly from LogTag® Analyzer below

« If they have an earlier copy of LogTag® Analyzer prior to version 3, it may be easier for them
if you send a legacy file, such as the *.1td format. You can use the Save As function, then
send the file manually via the Send Mail function.

« If the other user does not have access to a version of LogTag® Analyzer, you can send the
data in various export formats, such as spreadsheet files, PDF files and various other text
format files. You can find the relevant information in the sections about Saving a file for use
in spreadsheets on page 124, saving Exports and Reports on page 162

Sending a file by email directly from LogTag® Analyzer

You can email files to someone else directly from inside LogTag® Analyzer.

When you click the Send Mail icon from the toolbar, a new email message will be created in

your default email program, with the currently active file already attached to the message. @

Type the recipient's email address, add a message that you wish to include and then click Send. S

Clicking on Send in the File menu will achieve the same results as clicking the Send Mail icon. Figure 114: Send Mail Toolbar Icon

Note, the recipient of the file will need to have LogTag® Analyzer software installed to open
and view the file you sent. LogTag® Analyzer software is free and can be downloaded from
http://logtagrecorders.com/software/LTA3.

If you want to send data in file formats other than the LogTag® Analyzer format, specify the
desired file formats in the Exports and Reports section in the Options Window (Exports and
Reports on page 162). The data files will automatically be attached to your emails in the desired
formats.

To send a Multi-Chart, it must first be saved to disk (Saving a Multi Chart file on page 86).
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Note: You can automatically send emails and upload files to ftp sites using LogTag®
Analyzer's automated SMTP and FTP functionality. Please see Automatic emailing and
uploading to FTP sites below for further details.

Automatic emailing and uploading to FTP sites

Every time data are downloaded from a LogTag®, LogTag® Analyzer can automatically email the
resulting data files to pre-selected recipients or upload them to an FTP site.

Email uses SMTP (Simple Mail Transfer Protocol), which defines how electronic mail is
distributed across networks.

FTP (File Transfer Protocol) describes a mechanism by which files are transferred between
different computers and networks.

LogTag® Analyzer supports different authentication methods for each protocol, which you can
select when you configure the settings for each service. Here, you also set whether the process
should be automatic, on request, or both.

If you wish to learn more about FTP, SMTP, email and networking please refer to one of the
many good articles available on the Internet, such as the ones on Wikipedia or the various FTP
and SMTP client providers.

If you activate manual uploading/emailing, but not automatic uploading/emailing, you need to
click the Upload button on the toolbar to upload or send the file in the currently active window.

0 1)

Upload Upload

Figure 115: Active and inactive Upload Toolbar Icon

If the button is inactive, neither email nor FTP options are enabled.
When uploading or emailing files this will be shown in the status bar Upload Status on page 41.

Tip: The manual email function described here is different from the "send mail" button
on the toolbar. The Send mail button opens a draft message in your standard email
program and attaches the data file. You then need to complete the recipients' email
addresses and press the send button. The manual email function via SMTP does not use
your standard email program, but the configured SMTP settings and requires no further
action once the Upload button on the toolbar is clicked. You can, however, not change
the recipient without changing the SMTP settings.
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Note: The automatic functions only work if a file is created by downloading data from a
LogTag® in the interface. If the uniqueness settings in the File and Folder Settings are
set so that certain conditions do not result in creation of a new file, no file is uploaded
or emailed either.

Note: If you upload a file via the manual or automatic FTP function, any file that
already exists on the server with the same name will be overwritten without warning.
It is up to you to make sure files are created with unique file names.

Saving a file for use in spreadsheets

Occasionally you may wish to export a LogTag® data file so you can analyse it in more detail
using a spreadsheet program such as Microsoft™ Excel. You can choose between a few different
options to achieve this:

« You can use the File - Save as command from the menu, and select the *.csv option.
CSV files can be read by most spreadsheet programs.

p

A"

Please note that files created by LogTag® Analyzer may not always be true CSV files
( Comma Separated Values), as they use the list separator from the Windows
operating system. It does however mean the file can be opened with MS Excel
without going through the data import facility. To create a true CSV file select "Use
custom list separator" and enter a comma in the adjacent field. You can also use the
custom list separator to generate files for applications which require other list
separator characters.

« Select the Data tab and press CTRL-C or click Edit - Copy from the menu. Open an empty
worksheet in your spreadsheet program and select CTRL-V or click Edit - Paste from the
applications's menu. The data will be pasted in the cells and you can save the file in the
format of your spreadsheet program.

« Automatically export the data into a CSV file when a logger is downloaded. Please Exports
and Reports on page 162 for further details.

LogTag® Recorders also offer a conversion program, which you can use to bulk convert legacy
* 1td files to *.csv files. You can download this utility called LogTag® Convert from the software
download page at http://logtagrecorders.com/software.

page 124
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PDF files

LogTag® Analyzer can save the currently active LogTag® file to a PDF file. One single file will
be generated, which contains the report, chart images, summaries and a data list.

PDF files can be generated automatically, or by selecting Save as from the File menu. Select a
file name and location for your PDF file. Automatic generation of PDF files is enabled in the
section about Exports and Reports on page 162. Here you can also define the composition of the
PDF file.

Click the button; the PDF Export Settings dialogue is displayed, allowing you to
select which content of the PDF file will be created.

[ Note: The report page is always included in the PDF. ]

If a chart is zoomed, the PDF file will also contain a zoomed setting.

Saving a file as text

Occasionally you may wish to export a LogTag® data file so you can import it into other
software as text. You can either do this manually using Save as from the File menu, or
automatically when you download a logger.

You can choose between different text formats:
« You can save the file as a *.txt file.
This file is a tab delimited file that can be opened in any text editor on a PC.
« You can save the file as a *.txtm file.
This file is a tab delimited file that can be opened in any text editor on a Mac.
« You can save the file as a *.html file.
This file is a mark-up text file that can be opened in any browser.

You can define the contents of these files by clicking Options from the Edit menu and selecting
the Exports and Reports tab.

LogTag® Data files (*.Itd)

The legacy file type *.1td is the main file format of LogTag® Analyzer software before version 3
was introduced.

PDF Data Settings
D Show readings beyond specification as blank

Include the following
[ ] chart image
Data
[v] summary
Eﬂ Day Summary

PDF Layout Settings

Paper Size: | A4 v

Orientation: (@) Fortrait () Landscape

Q =

Figure 116: PDF Export Settings
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You can open these files with LogTag® Analyzer version 3 without loss of information.
Annotations, chart titles and receiver notes will all be converted and visible when saved using
the new *.1tdx format.

You can also save data in the *.1td format using LogTag® Analyzer version 3, so they can be
accessed by LogTag® Analyzer version 2 or earlier. However, none of the additional settings
such as annotations, zoom and notes are saved.

You can decide which file format you want to be the default format in File and Folder Settings
on page 154.
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Integrating LogTag® Analyzer with LogTag® Online

LogTag® Online is a web based storage, analysis and sharing portal for data recorded by
LogTag's range of data logging products. You can upload complete trips or live temperature
data recorded from loggers, associate the data with locations and share them with members of a
collaboration team.

What LogTag® Online can do is described in detail on the Help Center web page at
http://www.help.logtagrecorders.com/LTOnline/.

The following section shows the integration of LogTag® Analyzer with LogTag® Drive, one of
the features of LogTag® Online.

« Signing in and out of your LogTag® Online account

« Uploading files directly to the LogTag® Online Drive from Analyzer
« Uploading data to LogTag® Online locations

« Opening files stored in the LogTag® Online Drive from Analyzer

« Working with multiple LogTag® Online Teams

You can automate some of these steps in the LogTag® Online settings.
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Signing in

To upload data to LogTag® Online you must

. have a valid LogTag® Online account

. connect LogTag® Analyzer to your LogTag® Online account by entering the sign in
credentials

You can create a new LogTag® Online account by clicking Create an Account LogTag
Online menu, which will open a browser, clicking and following the on-screen
instructions.

Initially, a red dot shows next to the LogTag Online menu, indicating that you are not signed in.
Click Sign In from that menu, and a window opens where you can enter your details:

Provide the email and password for your LogTag® Online account and click .

Once you are connected, the dot next to the LogTag Online menu changes to green, indicating
that you are now signed in.

In the settings for LogTag® Online you can choose to complete the sign in process
automatically next time you start LogTag® Analyzer. You can also choose to sign in manually
every time you start LogTag® Analyzer.

Working with multiple teams

LogTag® Online allows you to be part of multiple teams, but you can only upload or view files
for one team at a time. If you are part of multiple teams, you need to select which of these
teams you wish to be the currently active team.

Click Current team from the LogTag Online menu and click the name of the team you wish to
be active.

Now, when you upload files to LogTag® Online they will be uploaded to this team, and only this
team's data files are available for opening.

If you are a member of only a single team, this will automatically be selected.
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Automatically uploading files to LogTag® Online

If you have a LogTag® Online account you can upload data from your loggers directly to
LogTag® Online, using LogTag® Analyzer. This is useful if you wish to share data online with
others who do not have access to a PC with LogTag® Analyzer.

This feature is enabled in the LogTag® Online section of the Option settings. If enabled, the
data for each LogTag® product you download to your PC is also uploaded automatically to your
team's account, provided you are signed in (The LogTag menu shows a green dot). Loggers you
upload are automatically registered as a device in your team's account.

Data are only uploaded if a new file is generated when the logger is downloaded. If no
new file is generated, for example when downloading a logger that has stopped, for a
second time, no data are uploaded.

Note that you can only upload the data at the time they are downloaded from the
logger. It is not possible to upload files manually.

If your logger is attached to a location
If your logger is attached to a location, the logger's data are added to the location data each
time you download it via LogTag® Analyzer.

0 You can attach all logger models to a location4, including USB loggers, but not
indicators.

If your logger is not attached to a location

If your logger is not attached to a location, a data file will be uploaded to LogTag® Drive in
addition to being stored locally on your PC. This can be viewed in LogTag® Online in the same
way as a file uploaded via one of the wireless interfaces (LTI-WIFI or LTI-WM-WIFI). Other
team members can then download the file and view it in LogTag® Analyzer.

4 Attaching a logger to a location is done in LogTag® Online or via the WiFi wizard. For more information about locations please see the
® A~ .
LogTag~ Online help.
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Opening files directly from LogTag® Drive

When you are signed in to your LogTag® Online account from LogTag® Analyzer, you can open
data files stored in LogTag® Drive directly. Click Open from the File menu, or click the Open
toolbar icon.

The folder list contains an Analyzer entry (similar to your dropbox or Onedrive entries), showing
the currently selected local storage folder as well as an entry LogTagOnline.

v B Analyzer

LogTagOnline

My LogTag Data
Click LogTagOnline to show a list of files currently stored in your LogTag® Online account.
These files represent shortcuts to the actual file content stored in LogTag® Drive. Once you

have selected a file for opening, it will be copied to your local storage folder, then opened in
LogTag® Analyzer in the same way you would open a locally stored file.

Any file you open will be copied to your local storage folder, regardless of the settings
made in Automation. This means the file will be available even after you have signed
out from your LogTag® Online account. The shortcut in the Select recent File menu will
reference the local file.
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Many of LogTag® Analyzer's features can be customised to suit your specific requirements.

This is done in the options dialogue, which you can open by clicking on the Options icon in the

toolbar or by selecting Options from the Edit menu.

Options

Figure 120: Toolbar Icon

To change any of the options, select the corresponding category in the left pane of the options
window. You will the see what can be changed in the right pane. Most of the options available
will be applied as soon as you click . For example, if the language selection or the date

format are changed, all windows that are open will be updated without the need to restart the

software.

Some of the display settings, such as decimal point and date/time formats, are
controlled by the regional settings of the Windows™ operating system. These can
usually be found in the Control Panel under "Regional and Language Options". Please
refer to your Operating System's documentation for further assistance.

Edit | LogTag Window
1 copy ctri+C

‘:-_-"\ Zoom Out

s
Real Time

@ Elapsed Time

T Zoomto Marks

(:) Previous group of Marks

OI Next group of Marks

@ Options D?

Figure 119: Edit Options Menu
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Many of LogTag® Analyzer's features can be customised to suit your specific requirements.

This is done in the options dialogue, which you can open by clicking on the Options icon in the
toolbar or by selecting Options from the Edit menu.

Options
Figure 121: Toolbar Icon

To change any of the options, select the corresponding category in the left pane of the options
window. You will the see what can be changed in the right pane. Most of the options available
will be applied as soon as you click ‘ For example, if the language selection or the date

format are changed, all windows that are open will be updated without the need to restart the

software.

Some of the display settings, such as decimal point and date/time formats, are controlled by
the regional settings of the Windows™ operating system. These can usually be found in the
Control Panel under "Regional and Language Options". Please refer to your Operating
System's documentation for further assistance.

Edit | LogTag Window
u Copy Ctri+C
Zoom Out

Real Time

@ Elapsed Time

Figure 122: Edit Options Menu
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General Settings

The General Settings options allow you to change various preferences that will effect the
overall appearance of the information shown by LogTag® Analyzer.

Show temperatures in...
Here you set the unit used for temperature values displayed in the software's dialogues, lists,
charts and reports. The options are:

. Fahrenheit (°F)
« Celsius (°C)
« Kelvin (K)

For loggers with a display and USB PDF loggers the temperature unit used on the
display or in the PDF is set during configuration. It is independent of the temperature
unit chosen here.

Default time interval to display
Here you set the default time zoom level. This is zoom is applied when a file is opened or a
logger is downloaded. You can set this to:

« All readings
« From first reading to first inspection/download mark
« From last inspection/download mark to last reading

The section about Inspection and download mark zoom on page 95 explains in more detail how

this feature works.

Language

This setting determines which language the software uses. Supported languages are:
« English US

« English (UK)

. French

« German
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« Russian
« Spanish

Enable automatic checking for a newer version
The LogTag® Analyzer software can periodically check to determine if a newer version is st
available for download from the LogTag® Recorders website. .
To enable this feature select Enable automatic checking for newer version and set the number LogTag Anclyzer
of days between checks by entering or selecting a number in "Check every XX days". To disable i pay

the feature, Cleaf the bOX. Dewnlasding infarmation from Internet about the latest version. Mo perscnal infarmation is being sent
If you enable the automatic check, and a new version is available, a window with an overview of e L R R
the update will be displayed. Please see Upgrading LogTag® Analyzer on page 22

==&

I in fulurs you see this messege you kaow thes i on upgiade available!

Figure 124: A software update is available
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Summary Statistics

This option allows you to specify which statistics are displayed in the Summary tab.

Automatically calculate and display following data
Select all options you wish to be shown, and clear all options you wish to hide.

For the calculated statistics data you can specify additional parameters. These settings are
shared with the Chart Statistics.

Decimal Places

Select the number of decimal places displayed for Mean Kinetic Temperature (on page 120),
Average Reading (on page 118), Standard Deviation (on page 121) and Degree Minutes (on
page 119).

Standard Deviation

Select the basis for the method used to calculate the Standard Deviation. The default is Sample

Based (S)

Mean Kinetic Temperature
You can select the value for the activation energy or use the default value of 83.144 KJ/mol.

Ignore paused readings when calculating statistics

If you enable this, any readings marked as paused will not contribute to the overall statistics

calculations. This is the default setting. If disabled, all values will be included.
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Chart Statistics

This window allows you to specify which statistics are displayed on the chart tab.

Display the following statistics in Chart Statistics annotations
Select all options you wish to be shown, and clear all options you wish to hide.

Insert chart statistics annotation when a new document is

created

Select this if you wish to include the statistics you selected automatically when a new chart is
generated. Initially the box will be placed in the upper left corner of the chart, but you can drag
it to a different location if desired.

Clear this box if you want to do this manually for each chart.

Panel Transparency Setting

Set the level of transparency for the chart statistics box. The lower this value, the more
transparent the box will be, so you can see the chart behind the box, and vice versa.

Annotation font defaults

This group of settings determines the default look for the font used in annotations. You can set
the font, size, style and colour. you can later change these parameters in the annotation panel.

HAXO-8 statistics

Here you can set if you wish to insert only the statistics for temperature, only the statistics for
humidity, or both when you download or open HAXO-8 logger data.
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Charts

In the Chart Options window you can influence how charts are being displayed in the chart tab.
[ eneral settings Options - Charts Restore Defaults [ Disable chart anti-sliasing ffaster)
Restore defaults Do | e o e
Clicking this will re-set all controls and values on this window to the default settings. m @M

Paused Marks
.
Heading =

X-Axis Grids
e
253, Date and Time

Y-Auis Grids
Show only validated

Mark Mon vaildated readings | ]
Above Alert Shade

Man Alert Shade

Relrvus Blart Sharls

A< Il d< <

You can combine a number of different variables and your own text to create a chart title. The

Marker Style v Marker Size v
5 Communication Ports

controls work the same as described in the section about the File Name on page 155. T ool Dot EEEEEEEN
i Line Width |Moderate 3 Point) v EEEEEEER
QLD”'"Q Default Zoom: | Range of readings v
QLDETEE Online Multi Chart Series ID: | Filename hd
c h a rt d efa u I ts [/] Reset all opendocuments ta the options selected above

Mouse Zoom: | Left Mouse Button v Mouse Pan: | Right Mouse Button v

Wheel Zoom: |No Key Needed v Wheel Pan: |Control Key v

The various settings can be enabled or disabled by clicking the check box for the relevant item . e P
in the list. If ticked, an item is enabled. -
Q@ Q cone o M > TS

When you highlight an item, relevant controls below the list will become active.
You can click on the colour selection box to change the colour. Figure 127: Chart options

Some items cannot have their colour set, for example the axes. In this case the colour selection
box will not appear.

Markers:
Aside from turning markers on and off you can select colour, style and size.

Shaded areas

You can set the chart background so different colours are used for the regions "at or above high
alert limit", "between high alert limit and low alert limit" and "at or below low alert limit".
This allows out-of-range and in-range data to be recognised easily on the listed or charted data.
Select the shading for each area independently, and select a colour.

By default these settings are enabled, with red for "above alert", blue for "below alert range"
and green for the non-alert range.

By selecting a line style for the "above high alert limit" and "below low alert limit" regions you
can improve the readability of the charts on black and white printouts.
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Gridlines
Enabling the grid lines displays vertical (x-axis) or horizontal (y-axis) lines which help you
identify readings relative to each other. By default both grids are enabled.

Non-validated readings

You can choose to include or exclude non-validated data from the chart display by clearing or
selecting the "Show only validated" check box. If non-validated data is to be displayed, it can
either appear just like validated data, or you can define a different colour and marker style to
be used. Select "Mark non-validated readings" to display non-validated data in the selected
colour/style.

Readings beyond specifications

Sometimes the LogTag® can record readings beyond the specified measurement range. In this
case

« the Chart and report tabs will not show the out of range values and the chart curve will
appear with broken lines

« the Data tab will include "<" or ">" for each reading that is beyond the specification range

. the Statistics display will include "**" for each statistic that includes readings that are
beyond the specification range.

If the option "Show readings beyond specification" is enabled, all recorded reading values will

be displayed, even if they are beyond the operating range of the LogTag®.

For example, the TRIX-8 has a published minimum temperature of -40°C. Temperatures down
to —41.5°C may be displayed if the Show readings beyond specification is enabled, however the
accuracy of recordings between -40°C and -41.5°C is unknown. -41.5°C will be displayed even if
the temperature falls to a much lower actual value.

LogTag® Recorders provides no guarantee of temperature reading reliability or accuracy beyond
the published range for any product; enabling this option for general use is not recommended.

Chart Palette Colours
Select the colours for the chart lines. In single charts the first colour is used for temperature,
the second for humidity.

In Multicharts the colours are used in the order the charts are opened. The same colours are
also used when the Multichart is switched to display average/min/max.

When you choose custom you can set your own colours.

page 139



Customising the software LogTag Analyzer User Guide page 140

Some experimentation with these settings will show very quickly how they work. Select a colour
in the colour panel, click and go to the Data screen to see the resulting change.

Default Zoom

You can define the minimum and maximum y-axis values initially displayed when opening the
chart.

« Range of readings: this scales the chart so the maximum and minimum temperature
displayed is just above/below the highest/lowest temperature reading recorded by the
LogTag®. If you choose this option the maximum screen area is used to display all recorded
readings.

« Range of sensor: this scales the chart to show the full temperature measurement range of
the logger.

« Custom range: When you select this option, an additional dialogue appears. Here you can
enter two temperature values and two humidity values, which are used as maximum and
minimum values for the chart's y-axis, regardless of the value of the recorded readings. frox: X

These settings are stored when the software is closed.

0 oK 0 Cancel 0 Beip
Regardless of these settings, you can always zoom in or out using the various zoom settings
(see Zoom Controls). When using the context menu in the chart tab you can also temporarily Figure 128: Custom range selection window
override the manual settings with new ones.

Multichart Series ID

Here you select which property of the file is listed in the legend for a Multichart next to the
colour code for the chart. You can choose from the following pre-selected combinations of
properties:

. Filename

« Model and Serial Number

« Model and Description

« Serial Number and Description

« Model, Serial Number and Trip number

« Model, Description and Trip number or

« Serial Number, Description and Trip number
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Auto-hide Chart Menu

If you wish to see more of a chart when it is first opened, you can select this feature. The Chart
Control Panel will then be minimised when a chart tab is first opened. If selected, you need to
click the toggle button in the lower right corner of the screen to view the chart panel.

Disable chart anti-aliasing

Selecting this option will enable charts to draw faster on the screen, however they will not look
as smooth and have more ragged edges.

Figure 129: Anti-Aliasing turned on

Reset all open documents
When selected the options as entered will be applied to all open documents when the clicking

on @ «

Figure 130: Anti Aliasing turned off

Zoom and Pan Controls

These settings control how you pan and zoom using the mouse's wheel and buttons. You cannot
use the same control for different actions, i.e. you cannot use mouse zoom and mouse pan with
the same button.

Mouse Zoom
By default you zoom in by dragging a rectangle on the chart while holding down the left mouse
button. You can change this to the right or middle button, or disable the function.
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Mouse Pan
By default you pan by holding down the right mouse button and dragging the chart. You can
change this to the left or middle button, or disable the function.

Wheel Zoom

By default you can use the mouse wheel to zoom in and out without holding a key on the
leyboard. You can change this so you need to hold the CTRL key or the SHIFT key while rotating
the wheel, or you can disable the function.

Wheel Pan.

By default you can use the mouse wheel to pan left and right (when the chart is already
zoomed in) by holding the CTRL key while rotating the wheel.

in and out without holding a key on the keyboard. You can change this so you need to hold the
SHIFT key while rotating the wheel, requiring no key, or you can disable the function.
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Automation

The Automation options determine what the software does automatically when it detects a
LogTag® in the Interface Cradle.

Enable automatic download of readings from LogTag®

When enabled, LogTag® Analyzer will automatically retrieve the recorded data from any
LogTag® product as soon as it is connected to the computer, either via an interface cradle or via
USB. While the software is retrieving the recordings you will see this window:

o A new LogTag has been detected in the interface. Please
wait while its readings are downloaded.

With this function enabled, it is not necessary to go through the download wizard procedure.
This function is very useful when working with multiple LogTag®s.

This function can be temporarily disabled by holding down the CTRL key on the keyboard while
placing the LogTag® in the interface.

You can also easily enable or disable this function by clicking the button in the top right of the
toolbar. It changes colour and shows whether auto download is currently on or off.

Auto-download is

Reconfigure with same settings after automatic download

When this is selected, a LogTag® will be automatically re-configured with the same settings
that were used for the previous trip, once the data have been downloaded. You can also disable
the re-configuration warning that appears if the logger is still taking readings by selecting
Disable Warning (this field only appears once you have selected the automatic re-configuration
option).

This option can only be selected if Enable automatic download of readings from LogTag® is also
enabled. -
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Display readings after successful download

If selected the software displays the downloaded data immediately after the download has
finished, either after an automatic download or when downloading using the Wizard.

Only show the latest set of readings after download

When selected only the most recently downloaded data set is display on the screen. If multiple
windows are being displayed, they will be automatically closed and only the most recently
downloaded readings will be shown.

Automatically save data files to default folder if source is

read only

If selected, LogTag Analyzer creates a permanent copy of any *.1tdx file opened from a read-
only source. This copy will be stored in the folder specified in File and Folder Settings on

page 154. This is useful if for example you open a file directly from the mass storage device of a
USRIC-8 or from an email you received. In this case you do not have to explicitly create a copy
of the file yourself to retain a local copy, and you will be able to make and save annotations.

Clear the check box if you do not wish to create these copies. In this case you will need to copy
a file manually from a read-only folder to a read/write folder if you wish to make annotations.

Tip: If you open a *.1td file from a USB logger's mass storage device directly, you will
not be able to save the file after you have unplugged it. Therefore we recommend
turning this option on, particularly if you do not use the automatic download option.
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Automatic emailing and uploading to FTP sites

Every time data are downloaded from a LogTag®, LogTag® Analyzer can automatically email the

E-Mail

resulting data files to pre-selected recipients or upload them to an FTP site. E-mail downloaded files: [ ] agtomatically
For each method you can select whether you wish to make the process automatic, on request, St [ Jonrequest
or allow both: me
automatically Upload downloaded files to FTP Server: I:‘automatical\y m FTP settings
L]

Clear Queue D on request

Every time a logger is downloaded, the files are automatically emailed to the specified
receivers, or uploaded to the specified FTP server

. on request

You need to click he Upload button on the toolbar to upload or send the file in the currently
active window.

Figure 132: Selection of FTP and SMTP activity

When neither box for emailing has a tick, no emailing will be possible. Similarly, when neither
box for FTP upload has a tick, no uploading via FTP will be possible, however in both cases any
settings entered in the Settings windows will remain stored.

Click Email settings or FTP settings to set up the connection data. Usually this information will
be provided by your network administrator, who may also provide you with a file containing the
required settings. Your network administrator will detail instructions how to import these
settings into LogTag® Analyzer.

Occasionally, a file is unable to be transmitted due to network errors. You can click
to stop LogTag® Analyzer from retrying to transmit the data.
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SMTP and email settings

A Disclaimer

The distribution of unsolicited emails provides huge inconvenience to anyone with an
email account. LogTag® Analyzer's email function allows the automated emailing of
files to a large number of recipients simultaneously without user interaction. Some

organisations consider this as spam and may blacklist your account.

It is therefore of the utmost importance that you as the sender obtain permission from
the recipients to send these files. LogTag® Recorders provides this functionality as a
feature assisting in the distribution of information between various users within an
organization and will not assume responsibility for any misuse of its software.

Setting up automated emailing requires two main pieces of information:
« The name of the SMTP server which you wish to use to send the emails and
« A valid user name and password for the SMTP server.

Once you click on the SMTP Settings button a dialogue window will appear, allowing you to
enter the configuration data for the SMTP email function. A lot of these settings will be familiar
to you from your standard email program.

Table 19: SMTP Server settings
Field What to enter

SMTP Server  Enter the name of the SMTP server you were given by your network administrator

SSL/TLS SSL stands for Secure Sockets Layer, TLS for Transport Layer Security. You may be
required to tick this box if your SMTP server requires a secure connection. Most SMTP

servers now use TLS; your network administrator will provide you with the required
information.

Port Number  The default port for providing SMTP connections is 25. Some network administrators
change the port number on their SMTP servers to increase security and stop hacking
attacks. If your network administrator has advised a different port for connection, please
enter it here.

In this case you may also need to change the settings of you firewall.

If you wish to learn more about this topic please see any of the published articles on
networking and TCP/IP available on the Internet.

No When selected, no authentication will be used.
authentication

SMTP Server Settings
SMTP Server
(®) Mo authentication
() Use Gmail authorization
O Use User Name and Password

User Name
Password
Email Settings
Sender Name
Email
Subject Line
Recipients
Add
Send test email
Adtach file im the following formats
LogTag File (itd / Jtdx 7 multix)
|__\ CSV [Comma delimited)

[ PoF (Portable Document Farmat)
Advanced Seftings

I:‘ Log uploads, log file in folder
D Store pending uploads between sessions,

Q QK 0 Cancel

Port: |25
O ssums

.v

[ ]HTML
]_\ Test (Macintosh)

[ Jext Tab delimited)

D Log connection errors

automatically resume uploads on program startup

g Help
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Field

Use Gmail
authorisation

Use User
name and
password

User Name

Password

Field

Sender Name

Email address

Subject Line

Recipients

What to enter

LogTag® Analyzer supports Gmail's OAuth authorisation method for sending email via
their SMTP server.If you use this method, please see the separate section about
Connecting to Gmail on page 183 for a detailed explanation.

Even without SSL or TLS most SMTP servers require an authentication method, especially
if the SMTP server you are using is not provided by your ISP, e.g. if you are using email
accounts from a hosted site. In this case you need to tick this box and provide login data
for this SMTP server.

Enter the user name you have been allocated by your network administrator required for
Authentication. Please note that for authentication this often needs to include a full
email address rather than just the SMTP login.

Enter the password you have been given by your network administrator required for
Authentication.

Table 20: Email settings
What to enter

Enter the name as it should appear in the recipients email program. This can be
your name or someone else's name.

Enter the email address that recipients can reply to by pressing the reply button of
their email program. This can be your email address, or someone else's address.

Text entered in this line will be displayed in the subject line of the email when
displayed on the recipients' email programs. Clicking on the ®* button will allow
you to specify some file related information which will be entered into the subject
line at the time of sending. You can enter your own text with the file related
information.

Enter the email addresses of the intended recipients. Pressing the "add" button
will bring up a new entry window where you can enter a recipient's name and
email address.

Name

E-mail Address

Add 0 Cancel

You can also highlight a recipient's name and edit the data or remove it from the
list.
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As a minimum you only need to provide an SMTP server address and one recipient email
address for this function to work.

Every time you make changes to these settings you should perform a test by clicking the Send
Test email button. LogTag® Analyzer will

« check you have provided valid connection data,

. send a test email to the email addresses in the recipient list.

If any of these actions fail, LogTag® Analyzer will display the following error message:

Some common errors are:

« The SMTP server requires authentication, and the data provided were not correct. Please
enter the correct authentication data.

« LogTag® Analyzer could not connect to the specified SMTP site because it could not find it.
This could be due to internet connectivity issues, due to an incorrect port number or a mis-
spelt server name.

« One or more of the addresses in the recipient list have an incorrect mail format (i.e. are not
in the format a@b.com). LogTag® Analyzer can only check for the correct format of the
addresses, but not for correctness of the recipients email addresses. Please note if you do not
provide a correct return address, you may not know that intended recipients are not
receiving the messages

We recommended you add your own email address to the list of recipients. This way
you get feedback if your email has been sent correctly in your email program. It is also
good practice to enter a valid and correct email return address for yourself. Some ISP's
will not relay messages without a sender's address.

Table 21: Additional settings
Field What to enter

Attach file in the  Select all files that you wish to attach when the email is sent. Each file ticked here
following formats  will be created, regardless of the settings made in Edit - Options - Exports and
Reports.

When first using LogTag® Analyzer, the LogTag File entry will be automatically
selected. You can, however, use any combination of files to transmit, including
none.
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Field What to enter

Log uploads If a tick is placed in the box next to "Log uploads" the message exchange between
the SMTP server and LogTag® Analyzer is recorded into a file. These files are
automatically named "YYYY_M_D_LogTag Analyzer SMTP.log" and are stored in
the location specified in Logging.

Log Connection Tick this box if you wish connection errors to be logged. This is recommended if

errors you frequently experience upload errors and you wish to discuss this issue with your
network administrator.

Store pending This feature is selected by default.

uploads between [ emailing files is interrupted due to a network error, a temporary copy is stored

sessions locally, and LogTag® Analyzer will attempt delivery when it is next started. If you

no longer wish to send these files, click the Clear Queue button in the Automation
window to delete the temporary copy. Your generated data files will not be affected.

If the feature is disabled, files not sent when the software is closed will have to be
manually re-submitted.

FTP settings

For the most basic FTP servers you only need to enter following information to upload data:

« The name of the FTP site and a directory on the site in which the files will be stored once FTP Server Settings .
FTP 5 Port: 21
uploaded o .
User Name nu_r.ify protocol
« A valid user name and password allowing you access to this directory and e (®) e
()ssL
« A file format to upload Remots Folder [7] Creste Folder Omis1o
L) SFTP
Sometimes the FTP server requires additional configuration data. Many of these settings will be ==
allocated to you by your network administrator. Firewall/Prosy Settings
(@) Use Internet Explorer setlings from Registry
Table 22: FTP Server settings ) Usegesion smtis Froxy Method | Auto-detact v
Field What to enter Proy Server Port: [0
. . X [7] Use User Hame and Password
FTP Server Enter the name of the FTP site. Omit ftp:// when entering the (T
name.
Passwaord
User Name Enter the user name that allows access to the FTP server Upload file in the following formats
. LogTag File [Itd [ Jtdx / .multi) HTML
Password Enter the corresponding password = ) i = )
[]csv icomma delimitea) [ Text (Macintosh
Port Number The default port for providing FTP connections is 21, but some [L] PoF Fortable Document Format) []7ext (rab aetimitea)
network administrators change the port number on their FTP Ranced ot
servers to increase security and stop hacking attacks. [ og upioads, log file in folder (] tog connection errars
If you wish to learn more about this topic please see any of the Dﬁfgfﬂ:ﬁ;‘:;:2::::?3?:‘::32;; e
published articles on networking and TCP/IP available on the
Internet. |0 oK 0 Cancel 0 Help
A -

Figure 135: Basic FTP settings screen



Customising the software LogTag Analyzer User Guide

Field What to enter

Security Protocol Choose between none, SSL, TLS or SFTP. You may need to
provide additional settings for SFTP. These settings are
explained in FTP settings on the previous page.

Remote folder Enter the folder in which the data files should be uploaded.
This needs to include the ftp user's home folder name.

Create Folder Select this if the remote folder is not yet present on the FTP site
and you wish to create it.

Your network infrastructure may require you to specify a proxy server. Unless you were given
settings by your network or IT administrator leave this at its default value.

Table 23: Firewall/Proxy settings

Field What to enter
Firewall/Proxy Use the settings from the registry or choose your own settings.
Settings

Every time you make changes to these settings you should perform a test by pressing the Test
connection button. LogTag® Analyzer will

« check you have provided valid connection data,
. if necessary create the folder you have specified and
. put a small test file in the selected location.

If any of these actions fail, LogTag® Analyzer will display a connection failure message.

Some common errors are:

« The remote folder could not be created or accessed. Select a different folder name, add the
required permissions to the desired folder or change to a folder with required permissions.

. LogTag® Analyzer could not connect to the specified FTP site because it could not find it.
This could be due to internet connectivity issues, due to an incorrect port number or due to a
mis-spelt name.

« User name or password are incorrect.

After you have provided the connection setting, select which files you wish to upload.

Only those files will be attached that exist at the time the upload is being initiated. To
make sure the desired files are available for attaching, select each format to be
automatically exported in Edit - Options - Exports and Reports
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Table 24: File format settings
Field What to enter

Attach file in the  Select all files you wish to attach when the email is sent. .
following formats

Some of the optional settings in the last section will assist in troubleshooting.

Table 25: Additional settings
Field What to enter

Log uploads If enabled, the message exchange between the FTP server and
LogTag® Analyzer is recorded into a file. These files are
automatically named "FTP Activity Log_YYYY_MM. html" and
are stored in the location specified in Logging. A new file is
generated each month.

Log Connection If enabled, connection errors are also logged. This is

errors recommended if you frequently experience upload errors and
you wish to discuss this issue with your network
administrator.

Store pending This feature is selected by default.

uploads between  [f emailing files is interrupted due to a network error, a

sessions temporary copy is stored locally, and LogTag® Analyzer will

attempt delivery when it is next started. If you no longer wish
to send these files, click the Clear Queue button in the
Automation window to delete the temporary copy. Your
generated data files will not be affected.

If the feature is disabled, files not sent when the software is
closed will have to be manually re-submitted.

Once all entries for the FTP server settings have been made, click to save the settings.

FTP Settings when connecting via SFTP

SFTP (SSH File Transfer Protocol) creates an FTIP link using a secure data stream. In addition to

authentication via Username and Password, LogTag® Analyzer offers authentication via a
Public/Private Key Pair.

If you wish to know more about asymmetric cryptography please refer to one of the
many books or articles available on the topic.

When selecting Password, you provide the same details as you would for a standard FTP
connection, except that the default port is now 22.
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FTP Server Settings

FTP Server SFTP Server.domain Port: |22
User Name sftpuser Security
protocol

(@) Password | “*Heees
= s () none
(_) Private Key Osa
(LS
(@) SFTP

Remote Folder Uploads O create tolder

Test connection

When selecting Private Key, the entries change to allow you to specify the key pair for the
authentication.

FTP Server Settings

FTP Server SFTP Server.domain Port: (22
User Name sftpuser Security
protocol
(_) Password ¥
5 ) none
(®) Private Key Load key. (st
Key Password Generate key O)7ls
Remote Folder Uploads O create tolder (@) SFTP

Test connection

The key pair is provided via one of three methods:
1. They key pair is generated on the SFTP server, and the public key is added to the list of
authorized keys that the server allows by the server administrator.
You will need to obtain and import the private key into LogTag® Analyzer. To do this,

click and browse to the private key file you have received. LogTag® Analyzer
accepts OpenSSH and PuTTYGen keys. If the key was sent to you in OpenSSH format the

file name may not have a file extension, and may not be displayed in the file explorer
window that opens after you click . In this case, click the down arrow next to

Private Key File and select All files.
Private Key File (*.ppk) vl—

The key may be protected by a password. You can enter this password in the Key
Password field.

Note: If the key is protected by a password, you must enter this in the password

field before you load the key, or you will receive an error message.
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You should now be able to test your connection.

2. The key pair is generated by LogTag® Analyzer and the private key is instantly added to
LogTag® Analyzer.

Generate the key pair by clicking . If you wish to protect the private key with
a password enter it before generating the key.

A file explorer window opens and you are asked to save the public key to a file. Browse to
a suitable location, enter the name for the key and click.

Forward this file to the administrator of the SFTP server, so you can be included in the list
of authorized users. LogTag® Analyzer generates a 2014-bit RSA key (stronger keys can be
generated via method 3).

We recommend you create a backup copy of the private key and store it in a safe location.
To do this, click anywhere in the private key field and press CTRL-A, then CTRL-C to copy
the key to the clipboard. Press the Windows button (A8) on your keyboard, type notepad
and press Enter. Press CTRL-V to insert the contents of the clipboard. Save the file to a
private location on your PC. Enter "yourkeyname.ppk" (including the quotation marks) as
the file name to save it as a Private PuTTY Key.

Testing your connection cannot be done until the server administrator has advised you
that the key has been added to the list of authorized users.

3. A third-party program is used to generate they key pair, such as PuTTYgen or SSH-
keygen. This would require you to generate the key pair, save send the public key to the
server administrator and import the private key into LogTag® Analyzer with the method
described above.

Please discuss any further issues with your network administrator.
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File and Folder Settings

The File and Folder Settings options help you manage the LogTag® data files.
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File Name

LogTag Analyzer User Guide

Whenever information is downloaded from LogTag® products it is always automatically saved

on your PC.

The file name entry helps you to give meaningful names to the files, so you can identify them
easier if you have to open them at a later date, or share them with others.

You can mix normal text and pre-defined place holder elements in this definition field. When a
new file is created, the normal text appears as entered, and the place holder elements are
replaced with the corresponding information from the logger data or your computer

environment.

Use the button at the end of the edit control (®*) to display a list with available elements.
Selecting an element will insert place holder text representing this element at the cursor
location; alternatively you can enter this text directly.

You may use one or more of the available elements in any order. If you type additional text into
the definition field, you must not add it inside an element's place holder text. If you manually
enter placeholder text, the letters must be in upper case as shown in the following table (for
example, "%ID" not "%id") and include the % marker.

Element

Date File
Created

Date LogTag
Finished

Date LogTag
Started

Date of first
reading

Date of last
reading

Table 26: Description of available file name elements and their place holder text

Placeholder Text File name shows...

%DATE

%FINISH-DATE

%START-DATE

%FIRST-DATE

%LAST-DATE

The date when the LogTag® information was originally
retrieved.

The date of the last reading recorded after being started.
If the LogTag® was not started then this information will
be blank.

The date the LogTag® was started to record information.
If the LogTag® was not actually started and only pre-
start information was recorded then this information will
be blank.

The date of when the LogTag® began recording
information, even if it was under pre-start conditions.

The date of the last reading recorded, even if there are
only pre-start recordings.
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Date File Created
Date LogTag Finished
Date LogTag Started
Date of first reading
Date of last reading
LogTag ID

Model ID

Number of Times Started
Serial Number

Time File Created
Time LogTag Finished
Time LogTag Started
Time of first reading
Time of last reading

Description

Figure 138: Available file name elements
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Element

Date/Time
LogTag Finished

Date/Time
LogTag Finished

LogTag ID
Model ID

Number of
Times Started

Serial Number

Time File
Created

Time LogTag
Finished

Time LogTag
Started

Time of first
reading

Time of last
reading

Description

Placeholder Text
%START

%FINISH

%ID

%PRODUCTID

%START-COUNT

%SERIALNUM
%TIME

%FINISH-TIME

%START-TIME

%FIRST-TIME

%LAST-TIME

%USERID

LogTag Analyzer User Guide

File name shows...

The date and time of the first recorded reading. If the
LogTag® was not started then this information will be
blank.

The date and time of the last recorded reading. If the
LogTag® was not started then this information will be
blank.

The unique LogTag® identification value.

The product identifier (part number) for the LogTag®
used to record the data.

The number of times the LogTag® has been started since
manufacture.

The unique serial number of the LogTag®.

The time when the LogTag® information was originally
retrieved.

The time of the last reading recorded after being started.
If the LogTag® was not started then this information will
be blank.

The time the LogTag® was started to record information.
If the LogTag® was not actually started and only pre-
start information was recorded then this information will
be blank.

The time of when the LogTag® began recording
information, even if it was under pre-start conditions.

The time of the last reading recorded, even if there are
only pre-start recordings.

The user defined identifier for the set of information
recorded by the LogTag®.

You may use the \ character to specify that a file name definition includes a sub folder name.

This is useful if you want to group/sort files automatically together and it cannot be done using

the folder name controls (for example if you want sort the files by User Id).
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Characters not supported by the operating system such as : * ¢ < > | are not permitted. If you
do include one of these elements they will be replaced with the _ character.

Any date or time element will use the formatting settings defined in the Date and Time
options. _

Folder Name

Here you define the directory where files are automatically stored after data have been
downloaded from your logger or indicator. This can be a local folder on your hard drive or a
network drive path. UNC folder names are supported. You can:

. Browse the directory structure with the [. button and select the desired directory.
. Enter the path manually.

Current full year
You can mix normal text and pre-defined place holder elements in this definition field. o eRt ot veer
When a new file is stored, the normal text appears as entered, and the place holder Month name
elements are replaced with the corresponding information from the logger's data or your Abbrevizted month name
computer environment. Month
Use the button at the end of the edit control (®¥) to display a list with available elements. Deyrame
Selecting an element will insert place holder text representing this element at the cursor REbeEvited deyTiame
location; alternatively you can enter this text directly. Day
You can insert following variables, provided the final resulting name is a valid UNC folder DMT e
name: ::::. 4)
Table 27: Available elements and their placeholder text for the storage folder Week of the year
Element Placeholder text Path name shows... SrECCamay
Current full year  %YYYY The year in which the file was created, using a four digit ::::::;nam
number.
User home path
Current short year = %YY The year in which the file was created, using a two digit User home drive
number. User documents
Month Name %MMMM The month in which the file was created, using its full name . . . .
Figure 139: List of available variables
Abbreviated %MMM The month in which the file was created, using a three
month name letter abbreviation (such as Jan)
Month &MM The month in which the file was created, using a two digit

number with a leading zero where required.

Day name %DDDD The day on which the file was created, using its full name

page 157



Customising the software

Element

Abbreviated day
name
Day

Day of the week

Hour (24)
Hour

Week of the year

User domain

Computer name

User name

User home path

User home drive
User documents

Public Documents
folder

Placeholder text

%DDD

%DD

%D

%HH

%H

%USERDOMAIN

%COMPUTERNAME

%USERNAME
%HOMEPATH

%HOMEDRIVE

%DOCUMENTS

%PUBLIC__
DOCUMENTS

LogTag Analyzer User Guide

Path name shows...

The day on which the file was created, using a three letter
abbreviation (such as Wed)

The day of the month on which the file was created, using a
two digit number with a leading zero where required.

The day of the week on which the file was created, using a
single digit number from 1-7. (The first day of the week is
obtained from the regional settings in your OS)

The hour of the day using a two didgit number between 1
and 24

The hour of the day using a two didgit number between 1
and 12

The week in which the file was created, using a two digit
number with a leading zero where required.

The domain name of the network the user is
connected to.

The name of the computer as entered in the system
description.

The user' user name as required for logon.

The path (excluding the drive letter) of the user's
home directory.

The drive letter on which the User 's documents
directory is stored.

The path (excluding the drive letter) of the user's documents
directory.

The path name including the drive letter to where the
public documents are stored. This is typically
C:\Users\Public\Public Documents\

A valid storage directory would be %HOMEDRIVE\%HOMEPATH\Documents\My LogTag
Documents. You do not need to enclose the string with quotes.

You need to make sure you have write access to the resulting directory. If LogTag® Analyzer is
unable to write to or create a directory, a warning message will appear when you next download
a logger and you will then need to select a different directory.
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Note: Some Network Attached Storage Devices (NAS Drives) use versions of SMB/CIFS
(Server Message Block) file servers which do not correctly report back whether a file
exists or not. Consequently, LogTag® will overwrite an already existing file with the
same name without warning, regardless of the settings made in the Automation
options.

Display X items in my most recently used list

This determines how many of the most recently accessed files are listed in the File menu for
quick access. Once this number of files has been reached, the reference to the oldest file
opened will be removed and the most recently opened file will be added to position 1. Only the
file reference is removed from this list, the actual file is not deleted. Changing this setting will
take effect the next time LogTag® Analyzer is started.

Display
This determines which view tab will initially show when a file is first opened.
« Chart; this will display the data in a time versus humidity and/or temperature chart.

. Data; this will display a list grid (spreadsheet style) of the time versus humidity and/or
temperature data.

« Report; this will display a condensed overview of the data including averages, ranges, alert
results, LogTag® identification data, and a small chart.

. Summary; this will display a summary of the data, including averages, ranges, alert results,
LogTag® identification data, and other information.

Default File Format

Select if downloaded data are stored in the * Itdx format, or as the legacy * 1td format.
« The *.ltdx format includes
chart control panel settings
zoom settings
annotations
receiver notes
... file event information
This file format cannot be opened by LogTag® Analyzer versions earlier than 3.0.
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« The legacy *.1td format can be read by earlier version of LogTag® Analyzer, but does not
store any of the additional settings above.

You can open a file in * ltdx format and store it in *.1td format, but you will lose the extra
information.

We recommend you select the *.1tdx format, and only save the *.1td format if you need to send
the data to someone without the latest version of LogTag® Analyzer.

Uniqueness

With this setting you decide what the software should do when a LogTag® is downloaded, and
the file name settings File Name on page 155) would result in duplicate file names in the
selected storage location. This is important if for example you have kept the default file name
settings, and download a logger more than once a day.

The options available include:

1. Always create a unique copy of files (recommended)

The software will automatically append " Copy n" to the end of the file name, where "n"
will be a unique sequential number.

2. Overwrite file if the file already exists

The existing file is replaced with a file that contains the information just downloaded. The
old file will no longer be accessible. This is only recommended if you do not use
""continuous operation" (Continuous operation on page 69).

3. Prompt if an existing file already exists.
A message will appear asking you whether or not you want to replace the existing file.
If you answer Yes the existing file is replaced as in option 2.

If you answer No the software will append " Copy n" to the end of the file name as in
option 1.
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This setting only takes effect if the file that is being saved is different to the file that is
already stored. If you download a logger that has already stopped, the resulting file
would have the exact same content as the file already stored. In this case no additional
files are generated, regardless of what settings you have made here. You will see a
change in date for the "Last modified" property in Windows Explorer, as it is opened by
LogTag® Analyzer for comparison. The only time such a file would be re-generated is if
someone had added a digital signature to the original file, and downloaded the logger
again. In that case the uniqueness settings would determine if a file would be

generated again, and what name it would be given.

Auto-Save on Exit

This setting determines what happens when you make changes to a chart, such as changing
zoom settings or annotating, and you exit the software or close the file.

« Save document changes on close

Any changes you make to the zoom settings, annotations, chart settings or receiver notes are
automatically saved. This is the recommended setting.

« Prompt to save document changes on close

If you make changes to the file, you will be asked whether or not you wish to save the
changes.

« Do not save document changes on close
When you choose this setting you will need to save any changes yourself.
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Exports and Reports

In addition to the native *.ltdx file you can automatically create files in other formats every
time a LogTag® is downloaded. You would use this for example if you wanted to perform
further analysis of the downloaded data in MS Excel, or email a PDF file to someone who does
not have LogTag® Analyzer installed on their computer.

Automatic file creation

To automatically create an additional file of a different type, place a check mark in the tick box
next to the file type in the list. You can select more than one additional file type.

Autamatically export new files to the following format(s)
[ esv icomma delimited) [ POF Portabie Document Format)
DL [ Test (Tab delimited
[ ] Test pacintosh)

The additional files will be automatically saved when downloading a LogTag®, using the file
name and folder location defined in File and Folder Settings on page 154. If during the download
no new file is created (for example when downloading a unit that has previously been
downloaded), no export data are generated either.
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These file formats cannot be imported back into LogTag® Analyzer. It is also not
possible to detect any manipulation to these files since they can be edited with third
party software.

Figure 140: Export Options
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You can select which extra information will be included separately for each of the different
export formats. Click the down arrow in | ™= ¥/ 3nq select the export format you wish to
adjust.

In the dialogue window displayed adjust the options to suit and click to save your selection.
Clickif you wish to discard any changes you have made.

You can include or exclude...

pre-start logged data

column headings

the trip summary

readings beyond specifications

the day summary for loggers and indicators which store this type of data

reading time, elapsed time, or both
For CSV files you can additionally select a custom list separator and a file extension. CSV files
normally use a comma as a separator between individual values of a row. By default, LogTag®
Analyzer uses the list separator from the "Regional and Language Options" in the Windows
Operating System. For some regions the resulting file is strictly speaking no longer a CSV file,

however it maintains compatibility with the import of CSV files into MS Excel. You can also use
a self selected separator instead.

The options for the PDF files are more extensive than for other files, please see PDF files on
page 125

Attaching files to emails
Here you select the file formats for the email attachment created through the Send Mail
command when Sending a file by email direct from Analyzer.

[ atways include pre-start log data

D Include each column heading

[ ] show summary

|_| Show readings beyond specification as blank

D Incluede Day Summary

tEhExport Reading Time -_ ) Export Elapsed Time
() Export Reading Time and Elapsed Time

(9‘;- Use list separator from Windows Regional Settings

"_l Use custom list separator: File extension: .osv

o oK - 0 Cancel e Help

Note: If you select an item in the list of Send Mail file formats, the format is not
automatically selected for export. If you wish to automatically upload files to an FTP
site or email them using the automatic emailing function you need to select them in
this section for automatic export, and also enable them in the FTP settings (as
described on page 149) and the SMTP and email settings (as described on page 146).

Copying Charts
You can copy the contents of a chart to the Windows clipboard by pressing CTRL-C while the
chart tab is active.

Here you can select which format the data should have, and which resolution.

Figure 141: Customising Export Options

Send Mall command automatically attaches a copy of the file in the following format(s)

LogTag File (itd / Ftdix / muitix)
[wlcsv (Comma detimited)
[Jrmae [ rext (Tab delimited)
[ rext paacintosn)

Figure 142: List of file formats for attaching via Sendmail.

|:| FOF [Portable Document Format)
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Report appearance
The remaining fields on this page influence the apperance of the report tab. You can decide the

default zoom level (Full page, Page Width and Custom), as well as a custom percentage. You
can also define the alternating row colour.
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Date and Time Format

Here you can set how dates and times are displayed in all tabs, reports and exports.

Short Date, Long Date and Default time use the settings from the Regional and Language
settings of the Windows operating system, accessible through the Windows Control Panel. g““"‘ il ==
You can customize how the date or time information is displayed by selecting Custom Date or @m.‘s;@.g g
Custom Time and combining the elements as listed in the tables Mean Kinetic Temperature on Qs At
page 120. The letters must be in the correct case (for example, "MM" in the date string, not @) swomscen >
"mm" as you would use for time value). You can use the characters '.', '/', ',' or '-' to separate il e wavise e o
o~ ®) pennt
elements, but you cannot add text. T S e
Table 28: Date options i ki aais =
Element Meaning " [ L
d Day of month as digits with no leading zero for single-digit days. Elmw et (L3004 49205
Fickia bl Dispiay Time Zane: | Configuration Time Jore =
dd Day of month as digits with leading zero for single-digit days. = T
ddd Day of week as a three-letter abbreviation.
. o o Q Caneel Expart Optiors ) g Heip
dddd Day of week as its full name.
Figure 143: Date and time options

M Month as digits with no leading zero for single-digit months.

MM Month as digits with leading zero for single-digit months.

MMM Month as a three-letter abbreviation.

MMMM  Month as its full name.
y Year as last two digits, but with no leading zero for years less than 10.
vy Year as last two digits, but with leading zero for years less than 10.

Vyyy Year represented by full four digits.
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Table 29: Time options
Element Meaning

h Hours with no leading zero for single-digit hours; 12-hour clock.
hh Hours with leading zero for single-digit hours; 12-hour clock.

H Hours with no leading zero for single-digit hours; 24-hour clock.
HH Hours with leading zero for single-digit hours; 24-hour clock.

m Minutes with no leading zero for single-digit minutes.

mm Minutes with leading zero for single-digit minutes.

S Seconds with no leading zero for single-digit seconds.

ss Seconds with leading zero for single-digit seconds.

t One character time-marker string, such as A or P.

tt Multi character time-marker string, such as AM or PM.

For example, if the date was 2 January 2012 and the date format was defined as yy-M, dd the
date would be displayed as 12-1, 02.

A sample of the chosen date and time format is displayed in the sample box.

This setting does not affect how the date and time information is stored in a *.1tdx file,
only how the information is shown.

Time zones

Each LogTag® stores a time zone along with the real time. This allows recipients to view data
from a logger in their own local time, even if it originated from a different time zone. Most
loggers store the time zone of the computer used for configuration, but for some the time zone
can be specifically defined during configuration, for example in USB PDF loggers, where it is
often desirable to set the time zone of the recipient.

The Display Time Zone field allows you to select which time zone LogTag® Analyzer will use. It
can be accessed by clicking Options from the Edit menu and selecting the Date and Time tab.
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Time zone

Local PC Time
Zone

Download Time
Zone

Configuration
Time Zone

UTC/GMT Time
Zone

Use logger
display clock
when available

Use PDF time
zone for USB
loggers

LogTag Analyzer User Guide

What is displayed

All times are displayed in the time zone of the computer used for viewing the data.

This is the most commonly used option, as it displays the dates and times on
screen in your local time zone.

Note, that this is not the same as the download time zone, if you
were sent a file from a logger downloaded in a different time zone.

All reading times are displayed relative in the time zone of the computer
used for downloading the data.

All reading times are displayed in the time zone of the computer used for
configuring the LogTag®.

You would use this option if you wanted to view the data in the same way
the sender of the logger would see it.

All times are displayed in Universal Time Coordinates, or Greenwich Mean
Time representation.

This is the best option when comparing different loggers from different
senders in different time zones.

If selected, all times are displayed relative to the clock that is showing on
the display of the logger, if it is equipped with a display that has a clock.
You would typically select this option, if you want the logger's display
clock to show the same time values as the Report generated by LogTag®
Analyzer.

If selected, reading times are displayed in the time zone set in the USB
PDF logger.

Regardless of the option you select, the recorded data inside the LogTag® are not affected.
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Communication Ports

LogTag® Analyzer supports communication with multiple ports simultaneously, so it is possible
to connect and use more than one interface cradle at the same time. Each time you use
LogTag® Analyzer to configure, download or hibernate a logger it needs to check each enabled
port to see if an interface with a logger is attached to that port. In this dialogue you can define,
which communication ports should be checked for connected interface cradles. The more ports
you leave enabled, the longer it will take LogTag® Analyzer to establish which ports have
interfaces connected, and which don't.

You should therefore only enable ports you plan on connecting an interface to. Ports not used
for communication with LogTag® products should be excluded, which speeds up
communication.

When you first install LogTag® Analyzer, all COM ports are disabled by default, as the most
common method of communicating is via USB interfaces.

This is especially useful if you have Bluetooth devices connected to your computer, which
generate a large number of virtual COM ports. It can take LogTag® Analyzer a long time during
download or configuration to detect if these virtual ports have an interface connected, so
disabling the ports significantly improves communication time. Any new COM port established
after you disable all serial ports will also be automatically disabled.

If you wish to use an RS232 serial interface, you can clear the check box Disable all serial ports.
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Figure 144: All COM ports disabled, USB enabled



Customising the software LogTag Analyzer User Guide

User Server

The User Server options define if and how LogTag® Analyzer should connect to the LogTag®
User Server software. If you do not have LogTag® User Server software installed on your
computer or network, you will not need to changes these settings. Connection to the LogTag®
User Server software is typically only used in multi-user environments or if your organization
requires compliance with the US FDA 21 CFR Part 11 regulations for use of digital signatures that
are controlled by a central administrator.

The settings required in these fields will be provided by your network administrator. You will
also need to select I agree to be able to store these settings. Once a valid connection to the
LogTag® User Server software has been established, you will be required to provide a valid user
name and password (How users log on on page 181) to continue using LogTag® Analyzer.

A Note: If the LogTag® User Server software runs on a different computer, you need to be
connected to that computer via a LAN or WAN to use LogTag® Analyzer software or

make any changes to these settings. You will not be able to use LogTag® Analyzer if
you cannot establish a connection to the User Server software.

For more information please refer to the Digital Signatures Suite web page, which can be
accessed via the LogTag® website.

To enter or change these settings LogTag® Analyzer must be started with local
administrator privileges. Close LogTag® Analyzer, right click its shortcut and click Run
as administrator. Make the changes after you have provided Administrator credentials,
then close LogTag® Analyzer and start as usual.
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Figure 146: Running LogTag® Analyzer as administrator



Customising the software LogTag Analyzer User Guide

Activity Logs

[t can sometimes be useful to keep a record of the configuration and download logs of a
LogTag® logger. LogTag® Analyzer can store a number of different logs in text files. Settings for
what is stored and where are made in the Logging window.

When the Log configuration data option is ticked, the selected parameters are written into a
text file, which is named "Analyzer_config_log YYYY_TTT.txt". When the Log download data
option is ticked, a second file is generated, named "Analyzer_download_log_YYYY_TTT.txt"

YYYY is the current year, and TTT is a string, the composition of which is dependent on the
frequency of the log generated. You can opt to generate a new file every day, every week or
every month. We recommend to choose this depending on the frequency and quantity of loggers
configured and downloaded, the default is every week.

Clicking on the button will allow you to select a Log folder of your choice where the log files
will be stored. This folder is also used for the FTP and SMTP logs. For each logger configured or
downloaded a new line is started in the corresponding text file; individual entries in each line
are separated by the character specified in the Field separator text field, and you can choose to
also enclose each value in quotation marks by selecting Add Quotes.
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Figure 147: Configuration logging options
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You can view the files by either browsing to the log folder and opening the file with a text
viewer, or you can click VIEW and open the log for viewing in LogTag® Analyzer's internal
browser.

Different parameters are available for configuration and download logging.

You can change the order of the entries in each line by highlighting the entry and clicking on
the up or down buttons. Clicking the tick box enables all parameters to be included in the log
file.

For diagnostics purposes you can select Log Communication Messages. This generates an
encrypted log file which you can send to LogTag® Recorders for analysis. The feature will be
disabled when you next re-start LogTag® Analyzer.

|Z| Date

m Time

W] Logger i

[v] Description

r_J_‘ Pre-start Enabled

[W/] Wrap Log Memary
|[w/] start Method

‘ Log Duration

} Log Interval

@ Log Count

[] start detay

Lowier Alert(s)

I—i| Upper Alert(s)

[W] Consecutive Alert
W] Hon Consecutive Alert
[w] Lateh Alert

W] Crear Alert

[W] Configure Requires Password
|[] Download Requires Password
W] Model 1D

[W] Enabled Ok

Figure 148: Parameters available

for Configuration logging
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[¥] Time

[¥] Logger D
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:|i| Pre-start Enabled
: Wrap Log Memory
[v] start Method
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Log Interval

[¥] Log Count

|i-| Start delay

E| Lower Alert(s]

W] Upper Alertis)
([w] Consecutive alert
.‘M Mon Consecutive Alert
[] Latch Alert

] clear iert

/| Configure Requires Password
1 Download Requires Password
] Model ID

[w] Enabied ok

Pre-start Logs

] started Logs

[+] File name

Figure 149: Parameters
available for Download

logging
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LogTag® Online

Here, you can control some aspects of the LogTag® Online connection.

Automatically sign in to LogTag® Online when Analyzer is started

This setting allows you to use your previously entered credentials to automatically sign into
LogTag® Online when you start LogTag® Analyzer the next time.

If you are a member of multiple teams you will be signed into the team that was active
when you last closed LogTag® Analyzer.

Upload files to LogTag LogTag® when user is signed in

Enable this to automatically upload a copy of every file generated when downloading a logger.

generated. You will not be able to upload files already stored locally.

H =

0 am ([ oo

[ Uploading files to LogTag® Online can only be done automatically when a file is ] LogTag Online Option Settings

Store pending uploads between sessions, automatically resume uploads on program
start up.
Enable this to resume any uploads that were interrupted.
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Importing and Exporting Option
Settings

LogTag® Analyzer's option settings can be exported and then imported into other installations
of LogTag® Analyzer. This is useful if you want to distribute settings to multiple users on the
same computer or copy settings from one computer to another. You can also use this if you are
upgrading your computer, and want to transfer the settings to the new computer.

You can access these functions from the Edit - Options dialogue.
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Exporting the Options Settings

With LogTag® Analyzer open, select Edit - Options and click on [Export Options) If the button
displays Import Options, click the down arrow, then click | Export Options .

A window will open, where you can select the option settings that will be exported.

Select all applicable check boxes, or choose Select All to export all settings. Only settings with
the check box enabled will be exported.

You need to enable at least on option, or you will receive an error.

Click and in the file explorer window that opens browse to a directory and enter the file
name of the export file. The * asxml file extension will be added automatically.

+ [+ ThePC 1 Demements
Oigmine »  Newholsur - @

1 This
B Desicn LinpTagPesdustion
- L]
| & My LogTag Dma
& Crwntpach My P

B Ma Wy Packites
Pt Wy Sewms

B o by Tranciatad Brcjecrs i ~

e e [ Gmone ]
e p e Anabaer SeSngs ke sl

e et s

Figure 151: Selecting the export file name and location

Once you click , the export file will be written to the folder specified, and you will receive a

confirmation message of the successful export.

Options export to file Dr\ Users), User' Docurments | My
LogTag Data), All Settings asxml complete

Figure 152: Successfully exported settings file

" Export Options.

Export Options W

Import Options

Export the following settings:
[ setect an

D{Seneral Settings
D Summary Statistics
[ cnart Statistics
[ charts
D.Automation
[ Fite and Folder Settings
[ ] exports and Reports
D Date and Time
[ ] communication Ports
[]com port settings
D User Server
DVerify User Server connection on import
[ Jupdates
[]Lagging
[—ICO nfiguration Profiles
|:| LogTag Online

@ « |O o Q =

Figure 150: Selecting the options settings to be exported
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Importing the Option Settings

You can use one of the following methods to import option settings into LogTag® Analyzer.

. With LogTag® Analyzer open, select Edit - Import Options.

& 3 =} o LegTagLocal » Softwaeteiting » LTAT besting ) anrch LTAD testing o]
Cuganise » Mew folder ie R

| B i pc o

B Deshtop & New settings scermi L

| Deurments

& Downlosds

B Music

= Purtures

B videss

S Local Dk (0

- Duta (D5} v »
e porne: | New settings.azud <| | Anatyzer Settings File asarmtl

o

Figure 153: Import options dialogue

Browse to a previously stored *.asxml file and click on Open.

« Double click on a *.asxml file in Windows Explorer, on the Desktop or in an email
attachment.

» Drag and drop a *.asxml file onto the LogTag® Analyzer icon on the desktop.

« Open the file via the File - Open dialogue in LogTag® Analyzer.

Only settings present in the *.asxml file will be imported. If a setting already exists in LogTag®
Analyzer, and a different setting is imported, the new setting from the imported file will
overwrite the existing setting.

Once the import is complete, you will see this dialogue.

o Settings import from file completed successfully.

Figure 154: Import successful
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If there are any problems with the import file, for example a file format incompatibility, an
error message will be displayed showing the import failed.

o Unsupported File Format
All Settings aswenl

@ = |

You cannot import a settings file generated with LogTag® Analyzer version 2. You will receive
the following error message:

Unsupported File Format

Italoptiondtest asml
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Appendix

Code Pages

A computer determines which character to display based on a table of
values, which is specific to a written language. This table is often
referred to as the code page.

A small number of characters are independent of a computer's input
language. These are '1-9', 'a-z', 'A-Z' and some special characters, for
example punctuation and brackets. These are listed in the ASCII table
as shown.

An additional 128 characters are available, which are specific to each
code page. The following examples show the differences between the
available characters for the Latin and Thai code pages.

LogTag Analyzer User Guide
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0020 ) poz1 | oozz | ooz3 | oo24 | o025 | ooze | oo27 | ooze | oo2e | ooza | 002B | 002C | 00200 | 00ZE | o02F
a 1] 2 3 4 5 6 | 7 g 9 : ; < | =1 = 7
0030 | 0031 | 0032 | o033 [ o024 | o035 | oose | o037 | ooze | oo3e | ooa | 003E | 003C | 0030 | 003E | 003F
C] A B C D E F = H I J K L M N 8]
0040 | o041 | o042 | o043 | oods | o045 | oods | o047 | oode | oods | ooda | 004E | 004C | 0040 | OD4E | OO4F
r|log|R|8|T|U|V|W|x|Y |2 [ | ] A
o050 | 0051 | oosz | oos3 [ ooss | ooss | oose | 0057 | 005e | 0069 | 00BA | O0SE | DOSC | 00SD | OOSE | OOSF
h a|lblecl|ld]le | £ lg |k |[1]3] k|1l | m|n|o
ooe0 | o061 | oos2 | oos3 [ ooss | ooss | ooss | o0s7 | o0se | 0068 | 00A | O0GE | DOSC | 00BD | ODGE | 00SF
=) q r = t u v wo| X 37 = { | } ~ | BEL
ooro | 007t | ooz | o073 | oors | oors | oore | oovr | oove | oovs | oora | o07E | oo7c | oo70 | oo7e | YOFF

Figure 155: ASCII Table of printable characters
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Figure 157: Code page 1252, Western languages

Figure 156: Code page 847, Thai language



Appendix LogTag Analyzer User Guide

In LogTag® Analyzer password and user ID fields are text entry fields.

The code page is used to determine the characters LogTag® Analyzer i
displays on screen and stores inside a logger. Which code page is Programs (1)
selected depends on which input language you have selected for your | %7 charmap.exe
computer. When the LogTag® is downloaded in a different country, the

user ID is displayed with the characters from the code page who's

reference is stored in the logger. This is possible because all Windows

code pages get installed as part of the operating system, although only

one is used at a time to display characters.

Passwords are always displayed with the asterisk character, but you
will need to type them into a confirmation dialogue (especially if the
password on download feature is enabled). You can use the Windows
character map to enter characters that are not available in your
language. To access the Windows character map, enter charmap.exe in
the "Search" or "Run" box of the Start menu, depending on your
operating system, and press Enter.

Some code pages make more than these extra 128 characters available,
but this requires more storage in the logger's memory, which reduces
the number of characters available for password and user ID. These
languages are Chinese (Traditional), Chinese (Simplified), Korean and
Japanese. For every character not in the ASCII character table A
computer determines which character to display based on a table of
values, which is specific to a written language. This table is often
referred to as the code page. on the previous page the number of
characters that can be stored is reduced by one. This means a password
can be as short as 3 characters, and a description as short as 19
characters (or 18 characters for a TRID30-7 or TRED30-7).

' See more results

| charmap.exe

Figure 158: Accessing charmap.exe on Windows 7
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These samples shows the extended character overview and a character

subset.
B2 | =2 88 |22 | 84 | 8B | 8C | ap | BE | &F

5o | 51|82 |83 98 | 99 | 94 | 9B [ ¢ | op | SE | SF
R I I R
FF&2 | FFe3 | FFe4 | FFes | FFee | FFE7 | FFes | FFe3 | FFea | FFEE | FFEC | FFEO | FFEE | FFEF
R R R R
FF72 | FF73 | FF74 | FF75 | FF76 | FF77 | FF7e | FF7a | FR7a | FF7E | FF7C | FRTD | FF7E | FFTF
P07 [ T S S R I O O I I .
FFez | FFas | FFe4 | Fres | Fras | FRe7 | Fras | FFsa | FRea | FFSE | FRec | FRSD FF&F

FF3E

glafla |z |0k

Figure 160: Code page 932, Japanese language

You can find more information about the history and technical

background of code pages via a number of online references.

Note: Although you can use the Windows character map to
confirm a password on download, you cannot enter characters

as a new password or description that are not available in your
chosen input language with this method. If you want to use
different characters you must switch the input language of
your computer. Please refer to the instructions relating to

your specific operating system how to do this.
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= (52 [ [/ |12 |/ /8 |5 | | | % 4% [ @ [ am 22|
EA37 | 8617 | BABE | BACY | BAC2 | 6ABS | 6ABZ | BEAAC | GADE | 6AD1 | BADF | 6286 | EADA | BAEA | BAFE | EBOS
AR R R R
G616 | 6AFA | EB1Z | 6B1E | 983 | BBIF | B33 | EB37 | YEDC | 6B39 | 93EE | 6B47 | 6B43 | 6B43 | 6BE50 | 6B53
AREREREREREREREERE R

6E5%4 | 6B5E | 6ESF | BB | BETS | 6BVY | BETF | BBS0 | B84 | 6E83 | GBS0 | 6E95 | 6B95
AEREEBRREIEREEREEE

EEBAE | 6EAF | BEBZ | EEBE1 | 6BE3 | 6EET | GBEC | BECE | 6BCE | 6EDZ | BEDF | BBEC | 6BEE
HEIBEBRR BRI

9EBE | 6C08 | BC13 | BCM | BOIE | BC24 | BC23 | BCSE | BCSS | BOE2 | BCEA | BC82 | BCED | BCIA | BCH1 | BCIE
% 58 & [52 | Dt e | & [ [om om0 oA e 58 |
BCFE | BCES | KOV | BC92 | BC90 | 6CC4 | BCF1 | BCD3 | GCED | BCOF | BCCE | 6000 | 6CAE | BCE1 | BCEE | BCEA
0z [or 7 (0B | |47 [5a om0 ot % [ | [ [0
GCOE | 6CEF | 6CD9 | BCEA | 6DIF | 84D | 6036 | 602E | 6030 | 6D3% | 6013 | 6035 | 6033

B 3w | [ [ [ [ |8 [0 0w o [ | B

6093 | 6064 | 6D5A | 6OV | 6059 | 60SE | 6035 | BFE4 | 6085 | GDFY | BE1S | BEDA | GDBS

& % o w53 e [ 2 & | D e D

E0CE | 6DEC | 6DDE | 60CC | 6DES | 6D02 | 60OCY | 6OFA | 6009 | GDE4 | 6005 | GDEA | GDEE

= [08 e [ 5z w2 n s o R [ [

EE13 | EEVZ | €EGF | BEZE | BE2} | EEEE | €EZE | BEVE | BE4D | EEIF | EE43 | BEZA | EE4E

w8 02 [ = w2 |08 e e 2 B | ®

EEZ8 | BE%2 | BEAA | BES® | GECH | GEET | BEDZ | BEED | EEAF | EEC4 | BEEZ | BED4 | GEDS

= 5B [ e | R [ 0w | [ | m [ | w

EESF | BFH1 | BFN1 | 74C | BEEC | EEF® | BEFE | BF3F | BEF2 | BF¥ | BEEF | BF32 | BECC

Figure 159: Code page 932, Japanese language, subset 91
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Connecting to LogTag® User Server

To use Digital Signatures, LogTag® Analyzer must be connected to the LogTag® User Server
software. When connected, all users are required to log on to LogTag® Analyzet before they can
use the software. To find out how to connect LogTag® Analyzer software to the LogTag® User
Server software please see User Server on page 169

How users log on

If LogTag® Analyzer is connected to the User Server, the logon screen as shown one on the right
® o o E:

. . . . . m . ..?" You are required to logon before you can continue.
is displayed when LogTag Analyzer is started. You can also click the Logon icon ‘ese" in the 7 Please enter your usernameand password.
toolbar or click Logon from the User Server menu. For users to successfully log on to the bomtactstr dminenatorbs R therass e

software for the first time, they must enter the username and password assigned to them by e |y
the User Server administrator. The password can be changed after the user has logged on (See '
How users change their password on the next page) but not the Username.

Password: |sewsanass

. L. . " o K Gwrﬂ\ 0 Help
Usernames are typically not case sensitive, however passwords are, which means that "Bob =
Smith" is the same username as "BOB SMITH" and "bob smith", however, entering a password Figure 161: Logon request when connected to User Server
of "bob" rather than "Bob", for example, is considered to be different.
Once logged on, you will be able to use all functions to which the User Server administrator has
given you access.
If your logon failed, you will see the Logon Failed message.
Every log on attempt, whether successful or not, will be recorded automatically in the audit
logs. As a security measure, the network administrator may configure LogTag® User Server so
that a user account becomes blocked after a certain number of consecutive failed log on
attempts. Please contact your network administrator if you have problems with the log-on
process.

password are correct. Letters in passwords must be typed using the comect

0 The software could not log you on. Make sure your Username and
case. Make sure that Caps Lock is not accidentally on.

T« Figure 162: Unable to log on to User Server software

To log off, click the Logoff icon on the toolbar t===f | or click Logoff from the User Server menu.
When you exit LogTag® Analyzer you will automatically be logged off.
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How users change their password

The User Server administrator may permit you to change your logon password.To do so click
Change Password from the User Server menu. You will need to supply your current logon
password, then enter the new password and a confirmation.

The User Server administrator may enforce certain password rules. For example, they may
require a minimum number of characters (digits, letters or symbols) or a minimum number of
digits to be included in the password, or both. Please contact your User Server administrator if
you have problems with the password change process.

Passwords should be chosen so they are difficult for someone else to guess. Following are a few
points to remember when changing a password:

1. Do not use something that is personal to the user. Birth dates, license plate numbers,
names of family members, types of vehicles owned, favorite foods and address of
residence are all examples of passwords that should NOT be used.

2. Do not write your password down.
3. Change your password on a regular basis.

If users forget their password, the User Server administrator will be able to change it. However,

administrators will not be able to see and therefore inform users what their current password is.

Username: User

Current Password:
New Password:

Confirm Password:

g OK e Cancel 0 Help

Figure 163: Changing a User Server password
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Connecting to Gmail

LogTag® Analyzer has the ability to connect to Gmail's SMTP server using your Gmail account.

Analyzer now supports the OAuth2 authorisation method, which makes it more secure to
connect but requires a few simple steps extra when you initially set up automated email
sending.
If you already connect to Gmail with an earlier version of Analyzer you will have enabled the
option Allow less secure apps in your Google account settings. You can continue sending
emails this way without changing any of the settings in Analyzer, however, we strongly
recommend to use the more secure OAuth2 authorisation method, as described below.

To use this method, select from the Automation tab in Options. You will see the
Email and SMTP settings dialogue. Click Use Gmail authorisation - the SMTP Server, Port and
SSL/TLS fields will now be set up automatically.

Do not enter anything else in the SMTP Server Settings section of the dialogue. Complete the
remaining entries in the Email Settings, Attach file... and Advanced Settings sections.

Once complete, click . Have your Gmail logon and password details ready.
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SMTP Server Settings
SMTP Server  smtp.gmail.com | Port: |587
(O No authentication B3 ssums
(8) Use Gmail authorization
O Use User Name and Passward

User Name

Password

Email Settings

sender Name | Your name

Emall |yourname@email.com |

Subject Line %PRODUCTID was successfully downloaded 'b w
Recipients | recipient@email.com
Add

Send test email

Attach file in the following formats

LogTag File (itd / ftdx / muitix) [ HmmML
[ ]esv comma gelimited) [ ] Text (Macintoshy
[]POF (Partable Document Format) [ | Text Tab delimited)

Advanced Settings

[¥] Loo uploads, log file in folder [ | Log connection errors

I:‘ Store pending uploads between sessions,
automatically resume uploads on program startup

o oK | Q Cancel 0 Help

Figure 164: Gmail settings selected




Appendix

Your default browser will now open. You will be asked to select which Gmail account you wish
to connect to. Enter the details of your Gmail account address.

Click Next and enter the account password.

LogTag Analyzer User Guide
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Google
Sign in

to continue to LogTag Analyzer

Forgot email?

English (United States) = Help Privacy Terms

Figure 165: Enter your Gmail account details

Google

Hi LogTag
@ logtagrecorders@gmail.com

To continue, first verify it's you

English (United States) = Help Privacy Terms

Figure 166: Confirming the account password
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Click Next and confirm that you agree to giving LogTag® Analyzer permission to send email
from your Gmail account.

Click Allow and your browser will show a message that it has successfully communicated with
LogTag® Analyzer and set up the appropriate permissions. HiLogTag

. loglagrecorders@gmail.com
You can now close the browser window. ®

Google

LogTag Analyzer wants to

®  sendemail on your behalf @

Allow LogTag Analyzer to do this?

CANEE m

English (United States) - Help Privacy oIS

Figure 167: Giving LogTag® Analyzer permission to send
email on your behalf

Received verification code. You mayv now close this window.

Figure 168: Success message
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At the same time LogTag® Analyzer will inform you that the connection to the Gmail SMTP
server was successful. (%]
When you now use the automated email function, the Gmail email will appear as the sender. Successiuy connected o fhe SMITP serverspearied
For security reasons this process needs to be completed within one minute. If you exceed the
allowed time LogTag® Analyzer will display a time-out message. ® =
0 Unless you have other applications that need to connect to your Google account, you Figure 169: Successfully connected to the Gmail SMTP server

can now switch the setting Allow less secure apps to Off. You can check which other
applications access your Google account in the section Apps with access to your
account in the account settings.

%)

SMTP Server srrorn Sending the Test Email Failad Chac your
SMTP and Email Settings: SMTP server authorication timeout

octurred

9 -

Figure 170: Time-out from SMTP server
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Getting more help

If you run into a problem with your logger, you can click Request
help... from the Help Menu to contact the support team at LogTag®
Recorders. When you select this command, LogTag® Analyzer will
collect information from your system, that assists in diagnosing issues.

LogTag® Analyzer generates some or all of the following files:

« diagnostics.txt.gz
This file includes information about your operating system version,
installed languages, temporary folders, LogTag® Analyzer version
numbers and other system related information in a compressed
format

« UserProfile.profile.gz
This file contains the settings for LogTag® Analyzer in a compressed
format and can help identify issues with path names and sharing
settings

« AnalyzerErrorLog.dat
This file contains LogTag® Analyzer's error log

« XXDownloadFilenameXX.ltm
LogTag® Analyzer generates a special download file for any USB
logger and any logger or indicator in an interface attached to the PC.
These file(s) will have a *.1tm file extension (Logger Total Memory),
which can only be viewed with special diagnostic software by
LogTag® Recorders, but not with LogTag® Analyzer software
While the software is collecting this information, a message is
displayed. It is important you do not remove any loggers during this
process.

LogTag Analyzer User Guide

mm\p Topics
A user Guide

oﬂu Analyzer Home Page

O Request Help

@ Check Internet for updates

o About Analyzer

Figure 171: Requesting Help via the Help Menu

Please wait while diagnostic data is collected from your system, Please
do not remove loggers from the interface cradles until this process has
completed.

PP E RIS TP RS AT DI IIAI TS,

Figure 172: Diagnostic Data collection.

page 187



Appendix

LogTag® Analyzer will then open a message window, allowing you to
enter of your details.

Field What to enter

From Your email address, so we can contact you about
the problem

cc Email addresses of anyone you wish to share this
information with.

Message body Include as much detailed information in your
email as possible about the problem, such as what
you were doing at the time, or what application
the LogTag® product is used in.

Add file You can add files that help to describe your problem,
such as a screenshot or a specific LogTag® file that
causes the issue. You can easily generate a screen shot
with Windows' own snipping tool and save it to a file
before attaching it.

Once you have entered all details, click Send to submit the message to
LogTag® Recorders.

Note: When you click Request help... from the Help Menu
again, any existing files in the Diagnostics folder will
automatically be deleted. If you wish to keep a copy of the
files and the report LogTag® we suggest you put your own
email address into the cc field of the message.

LogTag Analyzer User Guide

From \youraddress@email.com
To software@loglagrecarders.com
Cc

Subject Analyzer Diagnostics Email

[ Please enter any additional information about the problem you are experiencing here:

Attachments -ﬁ;\-ﬂéeﬂ\:l-.l.se.lup p IZ-):!.t;’.ql-Rcan:\ir-\.g-\l:né'l’;g.;;h:-:al.ﬁ.e.l-E.l:rori..og,d..;t;ﬁ:-\;.l;el.'s{EJ-l.er-\;\i;)ﬂﬂ-a-ta-\..l.?-om;i-n:]‘

Add File

0 sed | QCamel

Figure 173: Diagnostics email message
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